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Safety

This chapter includes:

O ELECEICAL SAFELY oottt s s ss s s sss s bbb s s s s s st enses
®  OPEIALIONAL SAFELY «..ooveeeeeeeeeee ettt sees e sss s s s s st e s s sasnsesnses
O MAINEENANCE SAFELY ..ottt s s st e s sssnses
©  PLINEEN SYMIDOIS .ottt s st s s e sbsss s s s b s bR s rnee
e  Environmental, Health, and Safety Contact INfOrmation ...

Your printer and the recommended supplies have been designed and tested to meet strict safety
requirements. Attention to the following information ensures the continued safe operation of your
Xerox® printer.
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Safety

Electrical Safety

Please read the following instructions carefully before operating your printer. Refer to these instructions
to ensure the continued safe operation of your printer.

Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. These
include safety agency evaluation and certification, and compliance with electromagnetic regulations and
established environmental standards.

The safety and environment testing and performance of this product have been verified using Xerox®
materials only.

Note: Unauthorized alterations, which can include the addition of new functions or connection of
external devices, can affect the product certification. Please contact your Xerox representative for
more information.

General Guidelines

‘,i\_ WARNINGS:
e Do not push objects into slots or openings on the printer. Touching a voltage point or
shorting out a part could result in fire or electrical shock.

o Do not remove the covers or guards that are fastened with screws unless you are
installing optional equipment and are instructed to do so. Turn off the printer when
performing these installations. Disconnect the power cord when removing covers and
guards for installing optional equipment. Except for user-installable options, there are
no parts that you can maintain or service behind these covers.

The following are hazards to your safety:

e The power cord is damaged or frayed.

e Liquid is spilled into the printer.

e The printer is exposed to water.

e  The printer emits smoke, or the surface is unusually hot.

e The printer causes a circuit breaker, fuse, or other safety device to activate.

If any of these conditions occur, do the following:

1. Turn off the printer immediately.

2. Disconnect the power cord from the electrical outlet.
3. Call an authorized service representative.

12 ColorQube 8700/8900 Color Multifunction Printer
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Safety

Power Cord

Use the power cord supplied with your printer.

Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the
cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check
the outlet.

Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a
ground connection terminal.

WARNING: Avoid the potential of electrical shock by ensuring that the printer is grounded properly.
Electrical products can be hazardous if misused.

Only use an extension cord or power strip designed to handle the electrical current capacity of
the printer.

Verify that the printer is plugged into an outlet that is providing the correct voltage and power.
Review the electrical specification of the printer with an electrician if necessary.

Do not place the printer in an area where people can step on the power cord.

Do not place objects on the power cord.

Do not plug or unplug the power cord while the power switch is in the On position.

If the power cord becomes frayed or worn, replace it.

To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord.

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary to
disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet.

Telephone Line Cord

& WARNING: To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger

telecommunication line cord.
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Safety

Operational Safety

Your printer and supplies were designed and tested to meet strict safety requirements. These include
safety agency examination, approval, and compliance with established environmental standards.

Your attention to the following safety guidelines helps to ensure the continued, safe operation of
your printer.

Ozone Release

This printer produces ozone during normal operation. The amount of ozone produced is dependent on
print volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone.
Install the printer in a well-ventilated room.

For more information in North America, go to:
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/environment
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/environment

In other markets, contact your local Xerox representative or go to:
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/environment_europe
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/environment_europe

Printer Location

e  Place the printer on a level, solid, non-vibrating surface with adequate strength to hold the weight of
the printer. To find the weight for your printer configuration, see Physical Specifications on
page 232.

e Do not block or cover the slots or openings on the printer. These openings are provided for
ventilation and to prevent overheating of the printer.

e  Place the printer in an area where there is adequate space for operation and servicing.

e Place the printer in a dust-free area.

e Do not store or operate the printer in an environment of extreme temperature or humidity.
e Do not place the printer near a heat source.

e Do not place the printer in direct sunlight.

e Do not place the printer where it is exposed directly to the cold air flow from an air
conditioning system.

e Do not place the printer in locations susceptible to vibrations.
e  For optimum performance, use the printer at the elevations specified in Elevation on page 234.

14 ColorQube 8700/8900 Color Multifunction Printer
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Safety

Operational Guidelines

Do not remove the paper source tray that you selected in either the print driver or control panel while
the printer is printing.

Do not open the doors when the printer is printing.

Do not move the printer when it is printing.

Keep hands, hair, neckties, and so on away from the exit and feed rollers.

Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove
the protective covers.

Printer Supplies

Use the supplies designed for your printer. The use of unsuitable materials can cause poor
performance and a possible safety hazard.

Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies.
Store all supplies in accordance with the instructions given on the package or container.

Keep all supplies away from the reach of children.

Never burn supplies.

When handling supplies, avoid skin or eye contact. Eye contact can cause irritation and
inflammation. Do not attempt to disassemble supplies, which can increase the risk of skin or
eye contact.

ColorQube 8700/8900 Color Multifunction Printer 15
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Safety

Maintenance Safety

e Do not attempt any maintenance procedure that is not described in the documentation supplied
with your printer.

e Do not use aerosol cleaners. Clean with a dry lint-free cloth only.
e Do not burn any consumables or routine maintenance items.

For more information on the Xerox® supplies recycling program, go to:
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/gwa
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/gwa

See also:
Cleaning the Printer on page 163
Moving the Printer on page 183
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Safety

Printer Symbols

Symbol Description

Warning or Caution:

Ignoring this warning could cause serious injury or even death.
Ignoring this caution could cause injury or damage to the property.

Oil from the cleaning kit can stain clothing and material. Do not tip the cleaning kit because
oil can drip from the tray. Do not let the cleaning kit contact your clothing.

Do not tip the printer. It can cause ink to spill.

Do not touch the area of the printer marked with this symbol.

After turning it off, wait 30 minutes for the printer to cool before moving or tilting it.

Do not look into the scanner during operation.

\//
N/E
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Safety

Environmental, Health, and Safety Contact
Information

For product safety information in the United States and Canada, go to:
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/environment
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/environment

For product safety information in Europe, go to:
o  ColorQube 8700 Color Multifunction Printer: www.xerox.com/environment_europe
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/environment_europe
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Features

Parts of the Printer

This section includes:

®  LEFE FIONE VWt te sttt ssss bt sas s bbb bbb bbb e bbbt ban st sanen
e Left Front View of the ColorQube 8700XF Color Multifunction Printer ...........eercerecereeeeeeerenreee
®  RIGNT REAT VIBW.ue ettt ssss s s s s ss s et sss bbb s ssnsassssnsaess
®  CONLIOL PUNEL ..ottt st sass s ssss s a s bbb e bbb e s e bbbt ans bbbt bans b sanen

e  Scanner with Document Feeder
) 650-Sheet Finisher

Left Front View

Tray 2 Left Side Door

Tray 1

Top Left Side Door Release
Top Left Side Door
Convenience Stapler

Scanner with Document Feeder
Document Feeder Top Cover
Document Feeder Tray
Document Feeder Output Tray

o NV EWN=
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10.Output Tray Paper Stop
11.Ink Access Door
12.0utput Tray
13.Control Panel

14.Front Door

15.Tray 2

16.Cleaning Unit
17.Waste Tray
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Features

Left Front View of the ColorQube 8700XF Color Multifunction Printer

11213 14

1. 1800-Sheet High-Capacity Feeder 11.Output Tray

2. Left Side Doors 12.0utput Tray Paper Stop
3. Tray1 13.Ink Access Door

4. Top Left Side Door Release 14.650-Sheet Finisher

5. Top Left Side Door 15. Control Panel

6. Convenience Stapler 16.Front Door

7. Scanner with Document Feeder 17.Cleaning Unit

8. Document Feeder Top Cover 18.Waste Tray

9. Document Feeder Tray 19.Trays 2-5
10.Document Feeder Output Tray 20.Locking Wheels
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Features

Right Rear View
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Control Panel

Fax Line Connector
Feature Card Slot
Ethernet Connection
USB Memory Port
USB Port
Foreign Device Interface
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7. Finisher Interface

8. Scanner Port

9. Power Switch

10.Power Connector for Finisher
11.Power Connector for Printer
12.Hard Drive Cover

The control panel consists of the touch screen, USB port, and buttons you press to control the functions
available on the printer. The control panel:

22

Displays the current operating status of the printer.

Provides access to copy, print, scan, and fax features.

Provides access to information pages.

Prompts you to load paper, replace supplies, and clear jams.

Displays errors and warnings.

Connects to a USB Flash drive for scan and print access.
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18 17 1615
Machine Status displays printer status information on the touch screen.

Job Status displays lists of the active or completed jobs on the touch screen.

Services provides access to the options for the selected copy, scan, or fax function on the touch
screen.

Services Home provides access to printer features, such as copy, scan, and fax.
Touch Screen displays information and provides access to printer functions.

Log In/Out provides access to password-protected features.

Help (?) displays information about the current selection.

Language changes the touch screen language and keyboard settings.

Ink Access Door Release turns on the release motor to open the ink access door.
Power Saver enters and exits low-power mode.

USB Memory Port provides USB Flash drive connection for use with Scan to USB and Print from USB
functions.

. Clear All, if pressed once, resets to the default settings and displays the first screen for the current

selection. If pressed twice, Clear All resets all the features to their default settings.

Stop temporarily stops the current job. Follow the onscreen instructions to cancel or resume your job.
Start starts the selected copy, scan, fax, or Print From job, such as Print from USB.

Interrupt Print interrupts or resumes the current print, copy, or fax job.

Alphanumeric Keypad enters alphanumeric information.

C (clear) deletes numeric values or the last digit entered using the alphanumeric keys.

Dial Pause inserts a pause in a telephone number when transmitting a fax.
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Scanner with Document Feeder
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Information Pages

Your printer has a printable set of information pages stored on its internal hard drive. Information pages
include configuration and font information, demonstration pages, and more.

1. At the printer control panel, press the Machine Status button.

2. Onthe Machine Information tab, touch Information Pages, then touch the desired
information page.

3. Touch Print.

Note: Information pages can also be printed from CentreWare Internet Services.

Printing the Configuration Report

1. At the printer control panel, press the Machine Status button.
2. Onthe Machine Information tab, touch Information Pages > Configuration Report > Print.
3. Touch Close after the report prints.
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Administration Features

This section includes:

®  ACCESSING T PrINEOI .ottt ettt bbb s bbb bbbt et sanen 26
0 CeNreWAre INTEIMETL SEIVICES ...ttt sssass et ssssssssssssssasssssssssssssesssssssssssssssasessssssssssssssssees 28
o  Finding the IP Address Of the PrINLEN ...t ssssssssssssssssssssssssssssssssssnnses 28
®  AULOMALIC DALA COWECLION .ottt sss e s sess sttt ss s s saseses 29
o  Billing and UsAge INFOMMALION ...t sssssssssesssassssssssssssssssssssssssssssssssssssssssssssssssssssssnsssnses 29

For details, see the System Administrator Guide for your printer model:
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700docs
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900docs

Accessing the Printer

To ensure that unauthorized users cannot access the printer, the system administrator can configure
authentication and authorization. If the administrator configures authentication and authorization, you
can be required to log in to access some or all of the features of the printer. If the administrator
configures accounting, you must type an accounting code to access tracked features.

Authentication

Authentication is the process of confirming your identity. When the system administrator enables
authentication, the printer compares the information that you provide to another source of information,
such as an LDAP directory. The information can be a user name and password, or the information stored
on a magnetic or proximity ID card. If the information is valid, you are considered an authenticated user.

The system administrator can set permissions so that authentication is required when accessing features
at the control panel, in CentreWare Internet Services, or in the print driver.

If the administrator configures local or network authentication, you identify yourself by typing your user
name and password at the control panel or in CentreWare Internet Services. If the administrator
configures card reader authentication, you identify yourself by swiping a magnetic or proximity card at
the control panel and typing a passcode.

Note: The system administrator can allow you to type your user name and password when Smart
Card authentication is the primary authentication method. If the administrator configures an
alternative authentication method, and you misplace your card, you can still access the printer.
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Authorization

Authorization is the function of specifying the features that you are allowed to access, and the process of
approving or disapproving your access. The system administrator can configure the printer to allow you
to access to the printer, but restrict your access to certain features, tools, and services. For example, the
printer can allow you access to copying but restrict your access to color printing. The system administrator
can also control your access to features at specific times during the day. For example, the system
administrator can restrict a group of users from printing during peak business hours. If you attempt to
print using a restricted method or during a restricted time, the job does not print. Instead, the printer
prints an error page and the job appears with an error message in the Job Status lists.

Where the system administrator stores the authorization information determines the authorization type.
e  Local authorization stores the login information on the printer in the user Information Database.

e Network authorization stores the login information in an external database, such as an
LDAP directory.

The system administrator sets authorization permissions. To set or edit user permissions for access to
printer features, you must log in as the administrator.

Accounting

Accounting monitors the print, copy, scan, and fax impressions produced and who produces them.
Accounting associates your user name and account identification information with each document you
print. Accounting data is collected and stored as jobs are submitted to the printer.

The system administrator must create user accounts and enable the accounting feature. When
accounting is enabled, you must log in to the printer before accessing services. You must also provide your
account details in the print driver before printing documents from a computer. The system administrator
can set limits to restrict the total number of jobs by type that a user can produce. The administrator can
also generate reports listing usage data for individual users and groups.

For details, see the System Administrator Guide for your printer model:
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700docs
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900docs

Logging In

Logging in is the process by which you identify yourself to the printer for authentication. When
authentication is set, you must log in to gain access to the printer features.

Logging In at the Control Panel
1. At the control panel, either press Log In/Out or touch Guest.

2. If an administrator has configured more than one authentication server, select your domain, realm,
or tree.

a. Touch Domain, Realm, or Tree
b. From the list, touch your domain, realm, or tree.
c. Touch Save.
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3. Type your user name, then touch Next.
4. Type your password, then touch Next.

Logging In to CentreWare Internet Services
1. At your computer, open a Web browser, type the IP address of the printer in the address field, then
press Enter or Return.

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on
page 29.

At the top of the page, next to the lock and key icon, click Login.

Type the User ID in the space provided.

Type the password in the space provided.

Click Login.

\miswhN

CentreWare Internet Services

CentreWare Internet Services is the administration and configuration software installed on the
embedded Web server in the printer. It allows you to configure and administer the printer from a
Web browser.

CentreWare Internet Services requires:

e  ATCP/IP connection between the printer and the network in Windows, Macintosh, UNIX; or Linux
environments.

e  TCP/IP and HTTP enabled in the printer.
e A network-connected computer with a Web browser that supports JavaScript.

For details, see the Help in CentreWare Internet Services or the System Administrator Guide.

Accessing CentreWare Internet Services

At your computer, open a Web browser, type the IP address of the printer in the address field, then press
Enter or Return.

Finding the IP Address of the Printer

You can view the IP address of your printer on the control panel or on the Configuration Report.

Finding the IP Address on the Control Panel

If Display Network Settings is set to Show IPv4 Address, the address appears in the top left corner of the

touch screen display. To display the IPv4 Address on the control panel, do one of the following:

e To configure Display Network Settings using CentreWare Internet Services, click Properties >
Security > Display Network Settings > Show IPv4 Address > Apply. For details, see the Help in
CentreWare Internet Services.
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e To configure Display Network Settings at the control panel, press the Machine Status button. Touch
Tools > Network Settings > Display Network Settings > Show IPv4 Address > Save.

To view the IP address of the printer on the control panel:

1. At the printer control panel, press the Machine Status button.

2. Touch Tools > Network Settings > TCP/IP Settings.

3. Record the IP addresses from the IPv4 and IPv6 areas on the display.

Finding the IP Address on the Configuration Report

1. At the printer control panel, press the Machine Status button.

2. Onthe Machine Information tab, touch Information Pages > Configuration Report > Print.
3. Touch Close.

4. IPv4 and IPv6 address information is located in the Connectivity Protocols section of the

Configuration Report under TCP/IPv4 and TCP/IPv6.

Automatic Data Collection

This printer automatically collects data and transmits it to a secure offsite location. Xerox or a
designated servicer uses this data to support and service the printer, or for billing, supplies replenishment,
or product improvement. Automatically transmitted data can include product registration, meter read,
supply level, printer configuration and settings, software version, and problem or fault code data. Xerox
cannot read, view, or download the content of your documents residing on or passing through your
printer or any of your information management systems.

To turn off automatic data collection:

On the Welcome page in CentreWare Internet Services, click the link in the note regarding
automated services.

Billing and Usage Information

Billing and printer usage information appears on the Billing Information screen. The impression counts
shown are used for billing.

For details, see Billing and Usage Information on page 179.
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More Information

Resource Location

Installation Guide

Packaged with the printer.

Quick Use Guide

Packaged with the printer.

System Administrator Guide

e ColorQube 8700 Color Multifunction Printer:
www.xerox.com/office/CQ8700docs

e ColorQube 8900 Color Multifunction Printer:
www.xerox.com/office/CQ8900docs

Recommended Media List

United States:

e ColorQube 8700 Color Multifunction Printer:
www.xerox.com/paper

e ColorQube 8900 Color Multifunction Printer:
www.xerox.com/paper

European Union:

e ColorQube 8700 Color Multifunction Printer:
www.xerox.com/europaper

e ColorQube 8900 Color Multifunction Printer:
www.xerox.com/europaper

Technical support information for your printer;
including online technical support, Online Support
Assistant, and driver downloads.

e ColorQube 8700 Color Multifunction Printer:
www.xerox.com/office/CQ8700support

e ColorQube 8900 Color Multifunction Printer:
www.xerox.com/office/CQ8900support

Information Pages

Print from the control panel.

Information about menus or error messages

Press the control panel Help (?) button.

Order supplies for your printer

e ColorQube 8700 Color Multifunction Printer:
www.xerox.com/office/CQ8700supplies

e ColorQube 8900 Color Multifunction Printer:
www.xerox.com/office/CQ8900supplies

A resource for tools and information, including
interactive tutorials, printing templates, helpful
tips, and customized features to meet your
individual needs.

www.xerox.com/office/businessresourcecenter

Local sales and support center

e ColorQube 8700 Color Multifunction Printer:
www.xerox.com/office/worldcontacts

e ColorQube 8900 Color Multifunction Printer:
www.xerox.com/office/worldcontacts

Printer registration

e ColorQube 8700 Color Multifunction Printer:
www.xerox.com/office/register

e ColorQube 8900 Color Multifunction Printer:
www.xerox.com/office/register

Xerox® Direct online store

www.direct.xerox.com/
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Xerox® Welcome Center

If you need assistance during or after printer installation, visit the Xerox® website for online solutions and
support for your printer model:

e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/worldcontacts
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/worldcontacts

If you require further assistance, contact the Xerox® Welcome Center for the United States and Canada
at 1-800-835-6100.

If a local Xerox representative telephone number was provided during printer installation, record the
telephone number in the following space.

#

If you need additional help using your printer:

1. Refer to this user guide.

2. Contact the system administrator.

3. Visit our customer website for your printer model:
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700support
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900support

To assist you, the Welcome Center needs the following information:
e The nature of the problem.

e  The serial number of the printer.

e The fault code.

e The name and location of your company.

Locating the Serial Number

To contact Xerox for assistance, you need the printer serial number. The serial number is on the left side
of the printer frame behind Tray 2. The serial number also appears on the control panel. Press the
Machine Status button to view the serial number on the control panel.
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Installation and Setup

This chapter includes:
o INStallation ANA SETUP OVEIVIEW ...ttt ssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssess
e  Modifying General Settings

e Managing Jobs

e Installing the Software

See also:
The System Administrator Guide for your printer model:
ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700docs
ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900docs

The Installation Guide is packaged with your printer.
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Installation and Setup

Installation and Setup Overview

Before printing, your computer and the printer must be plugged in, turned on, and connected. Configure
the initial settings of the printer, then install the driver software and utilities on your computer.

You can connect to your printer directly from your computer using USB, or connect over a network using
an Ethernet cable or wireless connection. Hardware and cabling requirements vary for the different
connection methods. Routers, network hubs, network switches, modems, Ethernet cables, and USB cables
are not included with your printer and must be purchased separately. Xerox recommends an Ethernet
connection because it is typically faster than a USB connection, and it provides access to CentreWare
Internet Services. It also provides access to email, workflow scanning, and server fax services.

If the Software and Documentation disc is not available, you can download the latest drivers for your
printer model:

e ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700drivers
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900drivers

Physically Connecting the Printer to the Network

Use a Category 5 or better Ethernet cable to connect the printer to the network. An Ethernet network is
used for one or more computers and supports many printers and systems simultaneously. An Ethernet
connection provides direct access to printer settings using CentreWare Internet Services.

To connect the printer:
1. Connect the power cord to the printer, and plug the cord into an electrical outlet.

2. Connect one end of a Category 5 or better Ethernet cable to the Ethernet port on the printer.
Connect the other end of the Ethernet cable to a correctly configured network port on a hub or
router.

3. Turn on the printer.

Turning On the Printer

The power switch is on the back of the printer above the power cord. Ensure that all of the other cables
are connected, then turn on the printer.

Initial Printer Setup

Ensure that the printer is set up before installing the printer software. Setup includes enabling the
optional features and assigning an IP address for the Ethernet network connection. If the printer has not
been turned on and configured previously, see the System Administrator Guide for your printer model:

e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700docs
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900docs
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Modifying General Settings

You can modify printer settings such as the language, date and time, units of measurement, display
brightness, and startup page from the control panel.

1.
2.

At the printer control panel, press the Machine Status button, then touch the Tools tab.
Touch Device Settings > General, then touch the setting you want to change:

e  Manual Wake-up Setting allows you to turn the Wake-up Sensor on or off. It also allows you to
set the sensitivity to wake the printer. When the sensitivity is high, you can wake the printer by
pressing any button or touching the screen. When the sensitivity is low, you can wake the printer
only by pressing Power Saver.

e Energy Saver specifies when the printer goes into energy-saving mode.
e Date/Time allows you to set the time zone, date, time, and display format.

Note: The date and time are set automatically through Network Time Protocol (NTP). To modify
these settings, go to the Properties tab in CentreWare Internet Services and change the Date and
Time Setup to Manual (NTP Disabled).

¢ Language/Keyboard allows you to set the language and keyboard layout.

e  Custom Keyboard Button allows you to assign text to the custom key on the virtual keyboard.
Change settings as needed, then touch Save.

To return to the main screen, touch Home.

Setting Energy Saver Mode

You can set the time the printer spends idle in ready mode before the printer transitions to a lower

power level.

1. At the printer control panel, press the Machine Status button, then touch the Tools tab.
2. Touch Device Settings > General > Energy Saver.

3. Touch an option:

e Intelligent Ready causes the printer to wake and sleep based on previous usage patterns.
e Job Activated causes the printer to wake when it detects activity.
e Scheduled causes the printer to wake and sleep according to a schedule you specify.

If you selected Intelligent Ready or Job Activated, under Fast Resume, touch On to reduce the wake
time. This option changes the default sleep and low-power timeout periods, and increases
energy usage.

If you selected Scheduled as the Energy Saver Mode, to select the times at which you want the
printer to wake or sleep, touch Scheduled Settings.

a. Touch aday of the week in the list.
b. To wake on activity, under Schedule Based On, touch Activity.
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c¢. To wake the printer at a certain time, touch Time > Wake Up Time, then select the time for the
printer to wake up.

d. To set the printer to sleep at a certain time, touch Time > Energy Saver Time, then select the
time for the printer to sleep.

4.  Touch Save.
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Managing Jobs

Managing Jobs at the Control Panel

From the control panel Job Status, you can view lists of active jobs, secure jobs, or completed jobs. You
can delete, print, or view job progress or job details for a selected job.

From the Print From menu, you can view lists of saved jobs, jobs stored on a USB Flash drive, or jobs
stored in printer folders. You can select and print jobs from any of the lists.

See also:
Held Print Jobs on page 84
Secure Print on page 80
Saved Job on page 82
Sample Set on page 80
Delay Print on page 81
Print From on page 84

Managing Jobs in CentreWare Internet Services

You can view a list of active jobs and delete print jobs from the Active Jobs list in CentreWare Internet
Services. You can also print, copy, move, or delete saved jobs. For details, see the Help in CentreWare
Internet Services.

Managing Held Print Jobs

If the system administrator has configured the Hold All Jobs feature, any job sent to the printer is held
until you release it. To view held jobs, touch the Held Print Jobs or My Held Print Jobs tabs.

Unidentified jobs are jobs that are not associated with a user name. Unidentified jobs originate from a
computer that does not require a user to log in. Examples are a job sent from a DOS or UNIX window
using LPR, Port 9100, or from the Jobs tab in CentreWare Internet Services.

e Toseeallist of the unidentified jobs, touch the Unidentified Print Jobs tab.

e Torelease a held job, touch the job, then touch Release. To release all held jobs, touch Release
All Jobs.
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Managing Secure Print Jobs

When you send a secure print job, the job is held until you release it by typing a passcode at the control
panel. To view a list of secure print jobs, press the Job Status button, then touch Secure Print Jobs. For

details, see Secure Print on page 80.

Note: Only the user that sent the job or the system administrator can delete a secure print job.
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Installing the Software

This section includes:

o Operating SYStemM REQUITEMENTS ......c.ovueevreriririeieeseeeessessessessestsstssssssssssssssssssssssssssssassssssssssssssssssssssssssssssssassans 39
o Installing Drivers and UtilitieS fFOr WINAOWS ... sissssssssssssssssssssssssssssssssssssssssnses 39
e Installing Drivers and Utilities for Macintosh OS X Version 10.5 and Later .........cceeeereenreonnennerenseennens 40
e Installing Drivers and Utilities for UNIX aNd LINUX......cc.cocveernrinrieernsiensensiesisssssissesssssssssssssssesssssssssssssasssanses 41
O OLNEI DIIVETS ..ottt st sss st bbb s e s st s s e s ssnsassssnsaess 42

Before installing driver software, verify that the printer is plugged in, turned on, connected correctly, and
has a valid IP address. The IP address usually appears in the upper left corner of the control panel.

If the Software and Documentation disc is not available, you can download the latest drivers for your
printer model:

e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700drivers
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900drivers

Operating System Requirements

e  Windows XP SP3 and later; Windows Server 2003 and later
e  Macintosh OS X version 10.5 and later
e Novell Netware 5.0 and later

e UNIX and Linux: Your printer supports connection to various UNIX platforms through the
network interface.

Installing Drivers and Utilities for Windows
To access all the features of your printer, install the Xerox® print driver and the Xerox® scan driver.

To install the print and scan driver software:

1. Insert the Software and Documentation disc into the appropriate drive on your computer. The
installer starts automatically.

If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe
installer file.

To change the language, click Language.

Select your language, then click OK.

Click Install Drivers > Install Print and Scan Drivers.
To accept the license agreement, click I Agree.

o s wN

From the list of discovered printers, select your printer, then click Next.
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Installation and Setup

7. If your printer does not appear in the list of discovered printers, click Extended Search.
8. If your printer still does not appear in the list of discovered printers, and you know the IP address:
a. Click the Network Printer icon at the top of the window.
b. Enter the IP address or the DNS name of the printer.
c. Click Search.
d. From the list of discovered printers, select your printer, then click Next.

9. If the printer still does not appear in the list of discovered printers, and you do not know the
IP address:

a. Click Advanced Search.

b. If you know the gateway address and subnet mask, click the top button and enter the addresses
into the Gateway and Subnet Mask fields.

c. If you know the address of another printer on the same subnet, click the middle button and
enter the address in the IP Address field.

Click Search.
From the list of discovered printers, select your printer, then click Next.

Note: When the printer appears in the Discovered Printers window, it displays the IP address. Record
the IP address for future use.

10. Select the desired driver.
11. Click Install.
If the installer prompts you for the IP address, enter the IP address of the printer.

If the installer prompts you to restart your computer, click Restart to complete the installation of
the drivers.

12. To complete the installation, click Finish.

Installing Drivers and Utilities for Macintosh OS X Version 10.5 and Later

To access all the features of your printer, install the Xerox® print driver and the Xerox® scan driver.

To install the print and scan driver software:
1. Insert the Software and Documentation disc into the appropriate drive on your computer.
2. Open the Mac folder, then open the Mac OS 10.5+Universal PS folder.

3. Open Xerox® ColorQube 8700 CD.dmg or Xerox® ColorQube 8900 CD.dmg as needed for
your printer.

To run ColorQube 8700 CD.pkg or ColorQube 8900 CD.pkg, double-click the appropriate file name.
When prompted, click Continue.
To accept the license agreement, click I Agree.

No v e

To accept the current installation location, click Install, or select another location for the installation
files, then click Install.

8. Enter your password, then click OK.
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Installation and Setup

From the list of discovered printers, select your printer, then click Next.

If your printer does not appear in the list of discovered printers:

a. Click the Network Printer Icon.

b. Type the IP address of your printer, then click Continue.

c.  Select your printer in the list of discovered printers, then click Continue.
To accept the print queue message, click OK.

Select or clear the Set Printer as Default and Print a Test Page check boxes.
Click Continue, then click Close.

Note: The printer is automatically added to the printer queue in Macintosh OS X version 10.5
and later.

To verify the installation of printer options with the print driver:

1.

b whN

From the Apple menu, click System Preferences > Print.

Select the printer in the list, then click Options and Supplies.

Click Driver, then confirm that your printer is selected.

Confirm that all of the options installed on the printer appear correct.

If you change settings, click Apply Changes, close the window, and quit System Preferences.

Installing Drivers and Utilities for UNIX and Linux

Xerox® Services for UNIX Systems is a two part installation process. It requires the installation of a Xerox®
Services for UNIX Systems code package and a printer support package. The Xerox® Services for UNIX
Systems code package must be installed before installing the printer support package.

Note: You must have root or superuser privileges to perform the UNIX print driver installation on
your computer.

At the printer, do the following:
a. Verify that both the TCP/IP protocol and the proper connector are enabled.
b.  On the printer control panel, for the IP address, do one of the following:

e Allow the printer to set up a DHCP address.

e  Enter the IP address manually.

c. Printthe Configuration Report and keep it for reference. For details, see Configuration Report on
page 25.

At your computer, do the following:

a. Go to www.xerox.com/office/CQ8700drivers or www.xerox.com/office/CQ8900drivers as
appropriate, and select your printer model.

b.  From the Operating System menu, select UNIX, then click Go.

Select the Xerox® Services for UNIX Systems package for the correct operating system. Installl
this package before installing the printer support package.

d. To begin downloading, click the Start button.

Repeat steps a and b, then click the printer support package for use with the Xerox® Services for
UNIX Systems package that you selected earlier.
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Installation and Setup

f.  To begin downloading, click the Start button.

g. Inthe notes below the driver package that you selected, click the Installation Guide link, then
follow the installation instructions.

Note: To load Linux print drivers, perform the preceding procedures but select Linux as the operating
system. Select Xerox® Services for Linux Systems driver or the Linux CUPS Printing Package. You
can also use the CUPS driver included in the Linux package.

Supported Linux drivers are available for download for your printer model:
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700drivers
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900drivers

For details about UNIX and Linux drivers, see the System Administrator Guide for your printer model:
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700docs
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900docs

Other Drivers

The Xerox® Global Print Driver works with any printer on your network, including printers made by other
manufacturers. It configures itself for your printer upon installation.

The Xerox® Mobile Express Driver works with any printer available to your computer that supports
standard PostScript. It configures itself for the printer you select every time you print. If you travel
frequently to the same sites, you can save your favorite printers in that location and the print driver saves
your settings.

These drivers are available for download for your printer model:
e ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700drivers
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900drivers
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Paper and Media

This chapter includes:

Supported Paper

Loading Paper
Printing on Special Paper
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Paper and Media

Supported Paper

This section includes:

RECOMMENAEA MEAIA .....ueeeveeeieeceeceiceieeiseciieceseeesscesesesssessesesesssesssesssessasessse st ass s sssessese s ssssesssessase 44
OFAEING PUPET .ottt essss s s sssssssssssssssssssssassssssssssssssssssssssassssssssesssssssssssssssssesssssssssssassssessnns 45
General Paper LoAding GUIAELINES ..........overeeerirriecrrisessiseissesseessisssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssessns 45
Paper That Can DAmMOQGE YOUT PIINEEN ... et eesssesseessssssesssessssssssssssssssssasesssessssssssssssssssssnnes 45
PAPEr STOrAGE GUIAELINES ...ttt sesesss s s st st ssssssssssssssssssssssssssssassssssssensssassssssnssnsans 45
Supported Paper TYPes ANA WEIGNTES ...t sssssssssssssssssssssssssssssssssssssssssssssssssssssssssssns 46
SUPPOrted StANAAIA PAPEE SIZES.......eeeeeeeeeeeteeeree sttt s s s sassssssass s sass s s s sss s ssassssssassssssasssnsanns 47
Supported Paper Types and Weights for Automatic 2-Sided Printing .........cocccoeeeomecernecenecenseenseeessecennees 47
Supported Paper Sizes for Automatic 2-Sided Printing .......ooceeeereceneceseceeeeseeesesisecesecessesssssesssessssesssees 48
SUPPOIEEA CUSLOM PUPET SIZES ..ottt essaes s sass s ssassssssass s sassssssass s s s sasssessass s sassansanns 48
SUPPOITEA ENVELOPE SIZES ...ttt ssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnns 48

Your printer is designed to use various paper and other media types. To ensure the best print quality and
to avoid jams, follow the guidelines in this section.

For best results, use Xerox® paper and media recommended for your printer.

Recommended Media

A list of paper and media recommended for your printer is available at:

North America

ColorQube 8700 Color Multifunction Printer: www.xerox.com/paper
ColorQube 8900 Color Multifunction Printer: www.xerox.com/paper

European Union

e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/europaper
o  ColorQube 8900 Color Multifunction Printer: www.xerox.com/europaper
See also:

Paper Tips Page, for details, see Information Pages on page 25.
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Paper and Media

Ordering Paper

Order supplies from your local reseller or go to:
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700supplies
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900supplies

General Paper Loading Guidelines

e Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray.

e  Adjust the paper guides to fit the paper size.

e Fan paper before loading it in the paper tray.

e If excessive jams occur, use paper or other approved media from a new package.

e Use only recommended Xerox® transparencies. Print quality could vary with other transparencies.
e Do not print on label media once a label has been removed from a sheet.

e Use only paper envelopes. Print envelopes 1-sided only.

Paper That Can Damage Your Printer

Some paper and other media types can cause poor output quality, increased paper jams, or damage your
printer. Do not use the following:

e Rough or porous paper

e Inkjet paper

e Non-laser glossy or coated paper

e Paper that has been photocopied

e  Paper that has been folded or wrinkled

e  Paper with cutouts or perforations

e Stapled paper

e Envelopes with windows, metal clasps, side seams, or adhesives with release strips
e Padded envelopes

e  Plastic media

& CAUTION: The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee does
not cover damage caused by using unsupported paper or special media. The Xerox® Total Satisfaction
Guarantee is available in the United States and Canada. Coverage could vary outside these areas.
Contact your Xerox representative for details.

Paper Storage Guidelines

Storing your paper and other media properly contributes to optimum print quality.

e  Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from
ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly
damaging to paper.

e  Reduce the exposure of paper to strong lights for long periods of time.
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Paper and Media

e  Maintain constant temperatures and relative humidity.

e Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to
collect moisture.

e Store paper flat, either on pallets, cartons, shelves, or in cabinets.
e Avoid food or drinks in the area where paper is stored or handled.

e Do not open sealed packages of paper until you are ready to load them into the printer. Leave stored
paper in the original packaging. The paper wrapper protects the paper from moisture loss or gain.

e Some special media is packaged inside resealable plastic bags. Store the media inside the bag until
you are ready to use it. Keep unused media in the bag and reseal it for protection.

Supported Paper Types and Weights

Tray Types and Weights

Tray 1 Plain (67-122 g/m?)

Hole Punched (67-122 g/m?)
Transparency

Letterhead (67-122 g/m?)
Lightweight Cardstock (123-199 g/m?)
Cardstock (200-220 g/m?)
Recycled (67-122 g/m?)
Labels

Pre-Printed (67-122 g/m?)
Lightweight (60-66 g/m?)
Custom

525-Sheet Feeder (Trays 2-5) Plain (67-122 g/m?)

Hole Punched (67-122 g/m?)
Letterhead (67-122 g/m?)
Lightweight Cardstock (123-199 g/m?)
Cardstock (200-220 g/m?)
Recycled (67-122 g/m?)
Labels

Pre-Printed (67-122 g/m?)
Lightweight (60-66 g/m?)
1800-Sheet High-Capacity Feeder Plain (67-122 g/m?)

Hole Punched (67-122 g/m?)
Letterhead (67-122 g/m?)
Recycled (67-122 g/m?)
Pre-Printed (67-122 g/m?)
Lightweight (60-66 g/m?)
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Supported Standard Paper Sizes

European Standard Sizes

Paper and Media

North American Standard Sizes

Tray 1

A4 (210 x 297 mm, 8.3
A5 (148 x 210 mm, 5.8 x 8.3 in.)
A6 (105 x 148 mm, 4.1 x 58 in.)
B5(176 x 250 mm,6.9 x 9.8 in.)
JISB5(182 x 257 mm, 7.2 x 10.1 in.)

x 11.7 in)

Letter (216 x 279 mm,8.5 x 11in.)

Legal (216 x 356 mm, 8.5 x 14in.)
76 x127 mm, 3 x5in.

Executive (184 x 267 mm,
7.25 x 10.5in.)

Statement (140 x 216 mm,
5.5 x 8.5in.)

216 x330 mm, 8.5x13in.

(Trays 2-5)

525-Sheet Feeder

A4(210 x 297 mm, 8.3 x 11.7 in))
A5 (148 x 210 mm, 5.8 x 8.3 in.)
B5(176 x 250 mm, 6.9 x 9.8 in.)
JISB5(182 x 257 mm, 7.2 x 10.1 in.)

Letter (216 x 279 mm, 8.5 x 11in.)
Legal (216 x 356 mm, 8.5 x 14in.)

Executive (184 x 267 mm,
7.25 x 10.5in.)

Statement (140 x 216 mm,
55 x 8.5in))

216 x330 mm, 8.5x13in.

Feeder

1800-Sheet High-Capacity

A4(210 x 297 mm, 8.3 x 11.7 in.)

Letter (216 x 279 mm,8.5 x 11in.)
Legal (216 x 356 mm, 8.5 x 14in.)

Supported Paper Types and Weights for Automatic 2-Sided Printing

Paper Types Weights

Plain

Hole Punched
Letterhead
Recycled
Pre-Printed
Lightweight

67-122 g/m?
67-122 g/m?
67-122 g/m?
67-122 g/m?
67-122 g/m?
60-66 g/m?

Notes:The printer does not support the following paper for automatic 2-sided printing:

Reloaded, which is paper previously printed or copied on laser or solid ink printers.

Envelope

Glossy Cardstock

Paper heavier than 122 g/m?
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Supported Paper Sizes for Automatic 2-Sided Printing

European Standard Sizes North American Standard Sizes
A4 (210 x 297 mm,8.3 x 11.7 in.) Letter (216 x 279 mm,8.5 x 11in.)
A5 (148 x 210 mm, 8.3 x 5.8 in.) Legal (216 x 356 mm, 8.5 x 14in.)
JISB5(182 x 257 mm, 7.2 x 10.1 in.) Executive (184 x 267 mm, 7.25 x 10.5in.)
B5(176 x 250 mm,6.9 x 9.8 in.) 216 x 330 mm, 85x13in.

Statement (140 x 216 mm,5.5 x 8.5in.)

In addition to the standard sizes, you can use the following custom-size paper for automatic
2-sided printing:

e Minimum size 139.7 x 210 mm (5.5 x 8.3 in.)

e  Maximum size 216 x 356 mm (8.5 x 14in.)

Supported Custom Paper Sizes

Paper Sizes

Tray 1 Minimum: 76 x 127 mm, 3 x 5in.
Maximum: 216 x 356 mm, 8.5 x 14 in.

Note: Print custom-size paper from Tray 1 only.

Supported Envelope Sizes

Tray Envelope Sizes

Tray 1 DL envelope (110 x 220 mm, 4.33 x 8.66 in.)
No. 10 envelope (241 x 105 mm, 4.1 x 9.5 in.)
C5 envelope (162 x 229 mm, 6.4 x 9 in.)

No. 5% envelope (111 x 146 mm, 4.4 x 5.75 in.)
Envelope 6 x 9 (152 x 228 mm,6x9 in.)

No. 6% envelope (92 x 165 mm, 3.6 x 6.5 in.)

A7 envelope (133 x 184 mm, 5.25 x 7.25 in.)
Monarch envelope (98 x 190 mm, 3.9 x 7.5 in.)
Choukei 3 envelope (120 x 235 mm, 4.72 x9.25in.)
Choukei 4 envelope (90 x 205 mm, 3.54 x 8.07 in.)
525-Sheet Feeder (Trays 2-5) DL envelope (110 x 220 mm, 4.33 x 8.66 in.)
No. 10 envelope (241 x 105 mm, 4.1 x 9.5 in.)
C5 envelope (162 x 229 mm, 6.4 x 9 in.)
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Loading Paper

This section includes:

®  LOAAING PAPET IN TIAY Tttt s saessasstessass s sass s s s s sass s sass b sessbassssssass s s sssssssssansasssanees 49
o Loading Paper in A 525-Sheet FEEAEN ... sttt ssssssssssssssssessssssssssssssssess 51
e  Configuring the 1800-Sheet High-Capacity FEEAET ...t seessssssessssssssssssssssenees 53
e Loading Paper in the 1800-Sheet High-Capacity FEEAEN .....erereeeseeeesresiessssssisssesssssaessessassenees 56

Loading Paper in Tray 1

Tray 1 supports the widest variety of paper types. It is intended for small quantity jobs and jobs using
special media. The tray extension provides support for larger paper.

1. Open Tray 1 by rotating it outward.
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3. Fan paper before loading it in the paper tray.

4. Insert the paper with the short edge first.

Notes:
e Load the printed sheet into the tray with the printed side face down.
e Load hole punched paper with the holes toward the back.
e Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to
jam.

5. Adjust the width guides until they touch the edges of the paper.
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6. Verify that the paper is the correct size, type, and weight. If not, change the paper settings.
7. On the printer touch screen, touch Confirm.

Loading Paper in a 525-Sheet Feeder
1. Pull out the tray until it stops.

2.  Move the length and width guides out:
a. Pinch the guide lever on each guide.
b. Slide the guides outward until they stop.
c. Release the levers.
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3. Fan the edges of the paper before loading it into the paper trays. This procedure separates any
sheets of paper that are stuck together and reduces the possibility of paper jams.

Note: To avoid paper jams and misfeeds, do not remove paper from its packaging until necessary.

4. Load the paper with the short edge against the left side of the tray.

Notes:

e Load paper into the tray with the print side face up.
e Load hole punched paper with the holes toward the back.
e Do not load paper above the maximum fill line. Overfilling can cause paper jams.

5.
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6. Close the tray. A message appears on the control panel.

7. Verify that the paper is the correct size, type, and weight. If not, change the paper settings.
8. On the printer touch screen, touch Confirm.

Configuring the 1800-Sheet High-Capacity Feeder

The 1800-Sheet High-Capacity Feeder is a dedicated paper tray. It must be configured to support the
paper in use. If the tray has not been used, it must be configured for the desired paper size. If you are
changing the paper size, you must reconfigure the tray for the new paper size. For details on supported
paper sizes, see Supported Paper on page 44.

Before changing the drawer configuration, always compare the paper size to the configuration of the
1800-Sheet High-Capacity Feeder. If the paper size matches, no adjustment is needed.

1. Pull out the tray until it stops.
2.  Remove the paper from the paper tray.
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3. Move the paper length guide to the selected paper size.

a. Toremove the paper length guide, pinch the tab at the top of the guide and lift it out of
the tray.

b. Align the tabs at the top and bottom of the guide with the corresponding slots at the top and in
the bottom of the tray.

o | LG

7

LGL

c. Lower the tabs at the bottom of the guide into the slots in the bottom of the tray. Click the top
tab into the slot at the top of the tray to lock it.

Note: Do not force the guide into place. If properly aligned, the top tab locks into the slot with
light pressure.
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4. Move the front paper width guide to the selected paper size.
a. Toremove the guide, pinch the tabs at each end of the guide plate, then lift it from the tray.

b. Align the tabs at the top and bottom of the guide with the corresponding slots at the top and in
the bottom of the tray.

(—

J
-
[ —

—\ A4
A4
|ll I
o
LTR
LGL

Note: To allow the plate to drop into place when aligning the front guide plate, the middle tab must
be aligned properly.

c. Lower the tabs at the bottom of the guide into the slots at the bottom of the tray. Click the top
tab into the slot at the top of the tray to lock it.
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5. To move the rear paper width guide to the selected paper size, follow steps 4a—c.

- N\

—— | LTR
A4 ——= LGL

N
LTR
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A4

Loading Paper in the 1800-Sheet High-Capacity Feeder

Note: Do not use glossy paper or labels in the 1800-Sheet High-Capacity Feeder.

1. Pull out the tray until it stops.

2. Fan the edges of the paper before loading it into the paper trays. This procedure separates any
sheets of paper that are stuck together and reduces the possibility of paper jams.

Note: To avoid paper jams and misfeeds, do not remove paper from its packaging until necessary.
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Load the paper with the short edge against the left side of the tray.

Notes:

e Load paper into the tray with the print side face down.
e Load hole punched paper with the holes toward the back.

e Do not load paper above the maximum fill line. Overfilling the tray can cause the printer
to jam.

Close the tray.

ColorQube 8700/8900 Color Multifunction Printer 57
User Guide



Paper and Media

Printing on Special Paper

This section includes:

O ENVEIOPES ..ttt st a s e AR bR bR bbb et et saeen 58
O LODIS et AR AR AR bR eeen 63
©  TTONSPATENCIES c..eoverrereererreeseesseassessessssssssssssssssssesssssssssssssssssesssssssssssssessssssssssssssssssssssssssssssssssssssssssssssssnssssessssssssssssssssess 65

A list of paper and media recommended for your printer is available at:

North America
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/paper
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/paper

European Union
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/europaper
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/europaper

See also:
Paper Tips Page, for details, see Information Pages on page 25.

Order supplies from your local reseller or go to:
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700supplies
o  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900supplies

& CAUTION: The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee does
not cover damage caused by using unsupported paper or special media. The Xerox® Total Satisfaction
Guarantee is available in the United States and Canada. Coverage could vary outside these areas.
Contact your Xerox representative for details.

Envelopes

Print envelopes only from Tray 1 or from a 525-Sheet Feeder. For details, see Supported Envelope Sizes on
page 48.

Guidelines for Printing Envelopes

e  Print quality depends on the quality and construction of the envelopes. Try another envelope brand
if you do not get desired results.

e  Maintain constant temperatures and relative humidity.
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Paper and Media

e  Store unused envelopes in their packaging to avoid the excess moisture and dryness which can affect
print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or
during printing.

e  Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book on
top of them.

e Inthe print driver software, select Envelope as the paper type.

e Do not use padded envelopes. Use envelopes that lie flat on a surface.

e Do not use envelopes with heat activated glue.

e Do not use envelopes with press and seal flaps.

e Do not use envelopes with windows, metal clasps, side seams, or adhesives with release strips.

e Use envelopes with diagonal seams, not side seams.

BRYE

Loading Envelopes in Tray 1

1. Open Tray 1 by rotating it outward.
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2. Open the tray extension by rotating it outward.

3. Insert up to 10 envelopes in the tray, align the stack, then adjust the guides until they are touching
the edges of the stack.

e Load s side flap envelopes with the flaps closed, flaps up, and flaps toward the front of
the printer.

e Load end flap envelopes with the flaps closed, flaps up, and flaps on the leading edge, going
into the printer.
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4. At the control panel, select the envelope size from the paper size list.
5. Verify that type is set to Envelope, then touch Confirm.

Loading Envelopes in a 525-Sheet Feeder
1. Pull out the tray until it stops.

2.  Move the length and width guides out:
a. Pinch the guide lever on each guide.
b. Slide the guides outward until they stop.
c. Release the levers.
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3. Load the envelopes into the tray, align the stack, then adjust the guides to touch the edges of the
envelopes.

e Load side flap envelopes with the flaps closed, flaps down, and flaps toward the front of the
tray.

e Load end flap envelopes with the flaps closed, flaps down, and flaps at the left side of the tray.

Note: Do not load envelopes above the bottom fill line. Overfilling the tray can cause the printer
to jam.

4. Close the tray.

5. Verify the size, type, and color settings. Change the selection for any incorrect setting.
6. On the printer touch screen, touch Confirm.

62 ColorQube 8700/8900 Color Multifunction Printer
User Guide



Paper and Media

Labels

Print labels from Tray 1 or from a 525-Sheet Feeder.

Guidelines for Printing Labels

A

Use labels designed for laser printing.
Print only on one side of the sheet of labels.
Use full sheet labels only.

Store unused labels flat in their original packaging. Leave the sheets of labels inside the original
packaging until ready to use. Return any unused sheets of labels to the original packaging and
reseal it.

Do not store labels in conditions of extreme heat or humidity. Storing them in extreme conditions
can cause print-quality problems or cause them to jam in the printer.

Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and
jam in the printer.

Do not use vinyl labels.
Do not feed a sheet of labels through the printer more than once.
Do not use dry gum labels.

CAUTION: Do not use any sheet where labels are missing, curled, or pulled away from the backing
sheet. It could damage the printer.

Loading Labels in Tray 1

1.
2.

Remove all paper from the tray.
Load labels face down with the top of the sheet feeding into the printer.
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3. Adjust the width guides until they touch the edges of the paper.

N

4. On the control panel, change the type to Label.
5. Verify the size, type, and color settings. Change the selection for any incorrect setting.
6. On the printer touch screen, touch Confirm.

| |A|| |A|| |A|I

7. Inthe Printing Preferences of the print driver, on the Paper/Output tab, change the Paper
Type setting.

Loading Labels in a 525-Sheet Feeder

1. Remove all paper from the tray.
2. Load labels face up with the top of the sheet against the left side of the tray.

3.
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4. Close the tray.

5. On the control panel, change the type to Label.
6. Verify the size, type, and color settings. Change the selection for any incorrect setting.
7. On the printer touch screen, touch Confirm.

| |A|| |A|| |A||

8. Inthe Printing Preferences of the print driver, on the Paper/Output tab, change the Paper
Type setting.

Transparencies

Use only Tray 1 for printing transparencies.

Guidelines for Printing Transparencies

e Remove all paper before loading transparencies in the tray.

e Handle transparencies by the edges using both hands. Fingerprints or creases can cause poor
print quality.

e After loading transparencies, change the paper type to Transparency on the printer control panel.

e Inthe print driver software, select Transparency as the paper type.

e Do not load more than 20 transparencies. Overloading the tray can cause the printer to jam.

e Do not use transparencies with stripes on the side.

e Do not fan transparencies.
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This chapter includes:

®  PrINTING OVEIVIEW ...ttt sssssssssssssssssssssasssssssssssssesssssssssssssssssssssssssssssssssesssssssasssssaess 68
o Selecting PriNtiNG OPLIONS ...t sass s ssssessssssssesssessse s ssss s sase s ssss s s sssssasessseses 69
®  PrINEING FOALUMES ..ottt s s sanees 73
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Printing Overview

Before printing, your computer and the printer must be plugged in, turned on, and connected to an active
network. Make sure that you have the correct print driver software installed on your computer. For details,
see [nstalling the Software on page 39.

1. Select the appropriate paper.
2. Load paper in the appropriate tray. On the printer control panel, specify the size, color, and type.
3. Access the print settings in your software application. For most software applications, press CTRL+P
for Windows, or CMD+P for Macintosh.
4. Select your printer from the list.
5. Access the print driver settings by selecting Properties or Preferences for Windows, or Xerox®
Features for Macintosh. The title of the button can vary depending on your application.
6. Modify the print driver settings as necessary, then click OK.
7. Click Print to send the job to the printer.
See also:
Loading Paper on page 49
Selecting Printing Options on page 69
Printing on Both Sides of the Paper on page 73
Printing on Special Paper on page 58
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Selecting Printing Options

This section includes:

©  PLINE DIIVEN HEIP.ouoeeeeeeeeeeeererse ettt sttt s s sees st sass b s s bbb e b s s b s b et b e se b s s ban st sanes 69
®  WiINAOWS PriNtING OPLIONS w....ereeeeereirerrisiessiseisssssisessssssssssssssssssssesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssees 70
o MacintoSh Printing OPLIONS ......oveereerirrisireiseississisissssssssssssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssess 71

Printing options, also called print driver software options, are specified as Printing Preferences in
Windows, and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page
layout, and print quality. Printing options that are set from Printers and Faxes Printing Preferences
become the default setting. Printing options that are set from within the software application are
temporary. The application and the computer do not save the settings after the application is closed.

Print Driver Help

Xerox® print driver software Help information is available from the Printing Preferences window. Click the
Help (?) button in the bottom left corner of the Printing Preferences window to see the Help.
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Information about Printing Preferences appears in the Help window on two tabs:

e Contents provides a list of the tabs at the top and the areas at the bottom of the Printing
Preferences window. Use the Contents tab to find explanations for each of the fields and areas in
Printing Preferences.

e Search provides a field where you can enter the topic or function for which you need information.
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Windows Printing Options

Setting Default Printing Options for Windows

When you print from any software application, the printer uses the print job settings specified in the
Printing Preferences window. You can specify your most common printing options and save them so that
you do not have to change them every time you print.

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in
Printing Preferences.

To select default printing options:
1. Navigate to the list of printers on your computer:
e  For Windows XP SP1 and later, click Start > Settings > Printers and Faxes.
e  For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers.
e  For Windows Server 2003 and later, click Start > Settings > Printers.
e  For Windows 7, click Start > Devices and Printers.
2. Inthe list, right-click the icon for your printer and click Printing Preferences.
3. Inthe Printing Preferences window, click a tab, select the options, then click OK to save.

Note: For more information about Windows print driver options, click the Help button (?) in the
Printing Preferences window.

Selecting Printing Options for an Individual Job for Windows

To use special printing options for a particular job, change the Printing Preferences from the application
before sending the job to the printer. For example, if you want to use the Enhanced print-quality mode
when printing a particular document, select Enhanced in Printing Preferences before printing the job.

1. With the document open in your software application, access the print settings. For most software
applications, click File > Print or press CTRL+P for Windows.

2. Select your printer and click the Properties or Preferences button to open the Printing Preferences
window. The title of the button can vary depending on your application.

3. Click a tab in the Printing Preferences window, then make selections.
4. Click OK to save and close the Printing Preferences window.
5. Click Print to send the job to the printer.

Selecting Finishing Options for Windows

If your printer has a finisher installed, you can select finishing options in the Printing Preferences of the
print driver.

To select finishing options in the PostScript and PCL print drivers:
1. Inthe print driver, click the Paper/Output tab.
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To select stapling options, click the arrow to the right of the Stapling field and select an option:
e None stacks the print job without stapling the sets.
e 1 Staple puts astaple in the top left corner of each set.

To select the output tray, click the arrow to the right of the Output Destination filed and select
an option:

e Automatically Select determines the output destination by the number of sets and the stapling
option selected. Multiple sets or stapled sets are sent to the finisher output tray.

e Top Tray selects the output tray on top of the printer.
e  Stacker Tray selects the finisher output tray.
Do one of the following:

e Tosave the settings, click Saved Settings at the bottom of the Printing Preferences window,
then click Save As.

e Tosend the job to the printer, click Print.

Saving a Set of Commonly Used Printing Options for Windows

You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:

1.
2.

With the document open in your application, click File > Print.

Select the printer, then click Properties. Click the tabs in the Printing Properties window and select
the desired settings.

Click Saved Settings at the bottom of the Printing Properties window, then click Save As.

Type a name for the set of printing options, then click OK to save the set of options in the Saved
Settings list.

Select the name from the list to print using these options.

Macintosh Printing Options

Selecting Printing Options for Macintosh

To use specific printing options, change the settings before sending the job to the printer.

1.

i &N

With the document open in your application, click File > Print.
Select your printer from the list.

Select Xerox® Features from the Copies & Pages menu.
Select the desired printing options from the drop-down lists.
Click Print to send the job to the printer.
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Selecting Finishing Options for Macintosh

If your printer has a finisher installed, select finishing options in the Xerox® Features of the print driver.

To select finishing options in the Macintosh print driver:

1.
2.

In the print driver, click Copies & Pages, then select Xerox® Features.

To select stapling options, click the arrow to the right of the Stapling field and select an option:
e  None stacks the print job without stapling the sets.

e 1 Staple puts astaple in the top left corner of each set.

To select the output tray, click the arrow to the right of the Output Destination filed and select
an option:

e Automatically Select determines the output destination by the number of sets and the stapling
option selected. Multiple sets or stapled sets are sent to the finisher output tray.

e Top Tray selects the output tray on top of the printer.
e  Stacker Tray selects the finisher output tray.
Do one of the following:

e Tosave the settings, click Saved Settings at the bottom of the Printing Preferences window,
then click Save As.

e Tosend the job to the printer, click Print.

Saving a Set of Commonly Used Printing Options for Macintosh

You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:

ot wnN=

72

With the document open in your application, click File > Print.

Select your printer from the Printers list.

Select the desired printing options from the drop-down lists in the Print dialog box.

Click Presets > Save As.

Type a name for the printing options, then click OK to save the set of options in the Presets list.
To print using these options, select the name from the Presets list.
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Printing Features

This section includes:

Printing on Both SideS Of The PAPET ...t ess e s ssss s sss s sasssanes 73
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Printing on Both Sides of the Paper

Paper Types for Automatic 2-Sided Printing

The printer can automatically print a 2-sided document on supported paper. Before printing a 2-sided
document, verify that the paper type and weight are supported.

Paper weights from 60 g/m? through 122 g/m? can be used for automatic 2-sided printing. For details, see
Supported Paper Types and Weights for Automatic 2-Sided Printing on page 47.

Printing a 2-Sided Document

Options for Automatic 2-Sided Printing are specified in the print driver. The print driver uses the settings
for portrait or landscape orientation from the application for printing the document.

ColorQube 8700/8900 Color Multifunction Printer 73
User Guide



Printing

2-Sided Page Layout Options

You can specify the page layout for 2-sided printing, which determines how the printed pages turn. These
settings override the application page orientation settings.

Portrait Landscape

" M
E 1399999495 g
. 1>
Portrait Portrait Landscape Landscape
2-Sided Print 2-Sided Print, Flip on Short | 2-Sided Print 2-Sided Print, Flip on Short
Edge Edge

Selecting Paper Options for Printing

There are two ways to select the paper for your print job. You can let the printer select which paper to use
based on the document size, paper type, and paper color you specify. You can also select a specific tray
loaded with the desired paper.

Printing Multiple Pages to a Single Sheet (N-Up)

When printing a multiple-page document, you can print more than one page on a single sheet of paper.
Print 1, 2, 4, 6,9, or 16 pages per side by selecting Pages Per Sheet (N-Up) on the Layout/Watermark tab.

Printing Booklets

With 2-sided printing, you can print a document in the form of a small booklet. Create booklets from any
paper size that is supported for 2-sided printing. The driver automatically reduces each page image and
prints four page images per sheet of paper, two page images on each side. The pages are printed in the
correct order so that you can fold and staple the pages to create the booklet.
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When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter
and creep.

e  Gutter specifies the horizontal distance in points between the page images. A point is 0.35 mm
(1/72in.).

e  Creep specifies how much the page images are shifted outward, in tenths of a point. Shifting
compensates for the thickness of the folded paper, which would cause the page images to shift
slightly outward when folded. You can select a value from zero to 1 point.

Using Color Options

The Color Options control the way the printer uses color to produce your document. The Windows
PostScript and the Macintosh drivers provide the widest range of color controls and corrections. Each
system has three standard modes of color control for normal use and Custom Color Options for the more
advanced users.

The three standard color modes are:

e Automatic Color applies the best color correction to text, graphics, and images. This setting is
recommended.

e Vivid Color applies automatic color correction to make office colors more saturated.
¢ Black and White converts all color in the document to black and white or shades of gray.

Custom Color Options provide three ways of adjusting the colors for more specific color requirements.
Click the Custom Color Options bar to open the Custom Color Options window:

e Color By Words provides a three step process for defining custom color correction. By making a
selection from each of the three fields, you create a sentence for controlling the color characteristics
of the document. You can create several sentences to more precisely control the color content of the
document.

The sentence structure is made of three parts:

e  What Color to Change? provides a drop-down list to select a color or range of colors to adjust,
such as All Foliage-Green Colors.

e How Much Change? lets you select how much effect to make, such as A Lot More, to the
selected color.
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e  What Type of Change? lets you select the type of change, such as Vivid, from the
drop-down list.

As you create a Color By Words sentence, it appears in the window below the selection fields.

e  Color Correction provides a list of commercial press, spot color, CIE, and gray image simulations
from which you can select to match your document color.

e Color Adjustments provides a set of six sliders for adjusting the individual components of the
selected colors. Use the sliders to adjust the lightness, contrast, saturation, cyan, magenta, and
yellow components of the color.

Printing Cover Pages

A cover page is the first or last page of a document. You can select paper sources for the cover pages that
are different from the source used for the body of a document. For example, you can use your company
letterhead for the first page of a document. You can also use heavyweight paper for the first and last
pages of a report. You can use any applicable paper tray as the source for printing cover pages.

Select one of these options for printing cover pages:

¢ No Covers does not print cover pages. No cover pages are added to the document.

e  Front Only prints the first page on paper from the specified tray.

e  Back Only prints the back page on paper from the specified tray.

¢  Front and Back: Same prints the front and back cover pages from the same tray.

e Front and Back: Different prints the front and back cover pages from different trays.

After making a selection for printing the cover pages, you can select the paper for the front and back
covers by size, color, or type. You can also use blank or pre-printed paper, and you can print side one, side
two, or both sides of the cover pages.

Printing Insert Pages

You can add blank or pre-printed insert pages before page one of each document or after designated

pages within a document. Adding an insert after designated pages within a document separates sections,

or acts as a marker or placeholder. Make sure that you specify the paper to use for the insert pages.

e Insert Options provides the options to place an insert After Page X, where X is the specified page, or
Before Page 1.

e Insert Quantity specifies the number of pages to insert at each location.

e Page(s) specifies a page or a range of pages after which you want an insert added. Separate
individual pages or page ranges with commas. Specify pages within a range with a hyphen. For
example, to add inserts after pages 1, 6,9, 10, and 11, type: 1, 6,9-11.

e  Paper displays the default size, color, and type of paper selected in Use Job Settings for the insert
pages. Use the down arrow to the right of the Paper field to select a different paper by size, color,
or type.

e Job Settings displays the attributes of the paper selected for the print job, without the inserts.
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Printing Exception Pages

Exception pages have different settings from the rest of the pages in the job. You can specify differences
such as page size, page type, and page color. You can also change the side of the paper on which to print
as your job requires. A print job can contain multiple exceptions.

For example, your print job contains 30 pages. You want five pages to print on only one side of a special
paper, and the remainder of the pages printed 2-sided on regular paper. You can use exception pages to
print the job.

In the Add Exceptions window, you can set the characteristics of the exception pages and select the
alternate paper source:

e Page(s) specifies the page or range of pages that use the exception page characteristics. Separate
individual pages or page ranges with commas. Specify pages within a range with a hyphen. For
example, to specify pages 1, 6,9, 10, and 11, type 1,6,9-11.

e  Paper displays the default size, color, and type of paper selected in Use Job Settings. Click the Down
Arrow to the right of the Paper field to select a different paper size, color, or type.

e 2-Sided Printing allows you to select 2-sided printing options. Click the Down Arrow to select
an option:

e 1-Sided Print prints the exception pages on one side only.

e 2-Sided Print prints the exception pages on both sides of the paper and flips the pages on the
long edge. The job then can be bound on the long edge of the pages.

e 2-Sided Print, Flip on Short Edge prints the exception pages on both sides of the paper and
flips the pages on the short edge. The job then can be bound on the short edge of the pages.

e Job Settings displays the attributes of the paper for the remainder of the job.

Notes:Some combinations of 2-sided printing with certain paper types and sizes can produce
unexpected results.

Scaling

You can reduce the image to as little as 25 % of its original size or enlarge it as much as 400 % . The
default setting is 100 %.

50% 100% 200%

XEROX

XEROX

XEROX
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In Windows, the Scale Options are located in the print driver on the Paper/Output tab in the Paper field.
Click the arrow at the right side of the Paper field and select Other Size to access the Scale Options:
e No Scaling does not increase or decrease the size of the image from the original.

e Automatic Scaling changes the print from one standard paper size to another standard paper size.
The Original Document Size is scaled to fit on the selected output paper size shown in the Output
Paper Size field.

e  Manual Scaling changes the output print size by the percentage entered into the field under the
graphic to the right of the Scale Options.

Printing Watermarks
A watermark is special purpose text that can be printed across one or more pages. For example, you can

add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document
before distribution.

Using the watermark options, you can do the following:
e Create a watermark or edit an existing watermark using the Watermark Editor:
e Name allows you to give the new watermark a unique name.
e Options enables you to use text, time stamps, or graphics for the watermark.
e Text provides a field in which you enter the text to be printed as the watermark.
e  Font and Color determine the font, size, style, and color of the watermark.
e Angle sets the degree of rotation applied to the text or graphics used for the watermark.
e Density defines how faint or how prominent the watermark appears on the pages.

e  Position from center determines the position of the watermark on the page. The default
position is in the center of the printed pages.

e  Place a watermark on the first page or on every page in a document.
e  Print a watermark in the foreground or background or blend it with the print job.

Printing Mirror Images

If the PostScript driver is installed, you can print pages as a mirror image. Images mirror left to right
when printed.
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Creating and Saving Custom Paper Sizes

You can print custom-size paper from Tray 1 only. Custom-size paper settings are saved in the print driver
and are available for you to select in all your applications. For paper sizes that are supported for each
tray, see Supported Custom Paper Sizes on page 44.

To create and save custom sizes for Windows:

1. Click the Paper/Output tab of the print driver.

2. Click the arrow at the right of the Paper field, then select Other Size > Output Paper Size > New.
3. Inthe New Custom Size window, enter the height and width of the new size, then select the units.
4. Enter a title for the new size in the Name field, then click OK to save.

To create and save custom sizes for Macintosh:

In the application, click File > Page Setup.

Click Paper Sizes, then select Manage Paper Sizes.

To add a new size, in the Manage Paper Sizes window, click the plus sign (+).

Double-click Untitled at the top of the window and type a name for the new custom size.
Enter the height and width of the new custom size.

okt whN-=

Click the arrow to the right of the Non-Printable Area field and select the printer from the list. Or set
the top, bottom, right, and left margins for User Defined margins.

7. To save the settings, click OK.

Selecting Job Completion Notification for Windows

You can select to be notified when your job finishes printing. A message appears on your computer screen
with the name of the job and the name of the printer where it was printed.

Note: This feature is only available on a Windows computer printing to a network printer.
To select job completion notification:
1. Inthe print driver, click More Status at the bottom of any tab.

2. Inthe Status window, click Notification, then click the desired option.
3. Close the Status window.

Printing Special Job Types

Special job types allow you to send a print job from your computer, then print it from the printer control
panel. Select special job types in the Printing Preferences of the print driver.
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Secure Print

Secure print allows you to associate a 4—10 digit passcode with a print job when sending it to the printer.
The job is held at the printer until you enter the passcode at the control panel.

When printing a series of secure print jobs, you can assign a default passcode in the Printing Preferences
of the print driver. Then you can use the default passcode for all print jobs sent from that computer. If
you must use a different passcode, you can override it in the application print driver.

Sending a Secure Print Job

1.
2.

8.
9.

On the Paper/Output tab, from the Job Type list, select Secure Print.

In the Secure Print window, type a passcode in the Passcode field. You are required to enter this
passcode when you print the job from the control panel.

In the Confirm Passcode field, type the passcode again.
Notes:

e If you do not supply a passcode, the printer assigns a passcode and displays it in the Passcode
Required window. Use this passcode to print the document at the printer, or click Cancel and
type your own passcode to use in the Secure Print window.

e The passcode is associated with your user name. After you set a passcode, it becomes the
default passcode for any print job that requires a passcode on all Xerox® printers. You can reset
the passcode at any time from any window that contains the passcode.

Click OK.
Verify that the paper is the correct size, type, and weight. If not, change the paper settings.

Note: You can select the paper for your print job using Select By Tray.

Select an option for 2-sided printing.

If your printer has a finisher installed, select a stapling option. The image next to Stapling displays
the staple position.

Select a print-quality mode.
Select an output destination.

10. Click Apply and select another tab or click OK.

Releasing a Secure Print

1.

W & WwWN
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At the control panel, press the Job Status button.

Touch the Secure Print tab.

Touch the corresponding print job in the list, then touch Release.

Enter the passcode number that you assigned to the print job using the keypad.
To start printing, touch Release Job.
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Sample Set

The Sample Set job type allows you to print a sample copy of a multiple-copy job and hold the remaining
copies at the printer. After you review the sample copy, you can select the job name from the printer
control panel to print the additional copies.

Sending a Sample Set Print Job
1.  On the Paper/Output tab, from the Job Type list, select Sample Set.
2. Verify that the paper is the correct size, type, and weight. If not, change the paper settings.

Note: You can select the paper for your print job using Select By Tray.

3. Select an option for 2-sided printing.

4. If your printer has a finisher installed, select a stapling option. The image next to Stapling displays
the staple position.

5. Select a print-quality mode.
6. Select an output destination.

7. Tosend the job to the printer, in the Print window, select the number of copies to print and click OK
or Print.

A sample copy prints immediately. The sample copy is not counted as part of the print job.
8. After reviewing the copy, use the printer control panel to print or delete the remaining copies.

Note: You can use Sample Set as a part of the Earth Smart settings. In Earth Smart settings, set
Sample Set as your default Job Type.

9. To print the job, select it from the job list on the printer control panel.
10. Press OK.

Releasing the Remainder of Prints After Printing a Sample Set

1. At the control panel, touch Jobs.
2. Touch the corresponding print job in the list.

Note: The control panel displays Held: Sample Set next to the job name.

3. Touch Release.
The remainder of the job prints, and the job is deleted from the printer hard drive.
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Delay Print

You can delay a print job for up to 24 hours from the original job submission time. Enter the time at which
you would like the job to print. If the time you enter is earlier than the time that you submit the print job,
it prints on the following day. The Delayed Print default time is midnight.

Sending a Delay Print Job

1.  On the Paper/Output tab, from the Job Type list, select Delay Print.

2. Inthe Delay Print window, select the Tab key to move from the hour section to the minutes section.
To select the time to send the print job, click the Arrow buttons.
e  Fora12-hour time format, type the hour (1-12), minutes (00-59), then select A.M. or P.M. To

toggle between A.M. and P.M,, click the Up Arrow or Down Arrow buttons.

e  For a 24-hour time format, type the hour (1-23), and the minutes (00-59).
Note: The regional settings on your computer determine the time format.

3. Click OK.

4. Select other desired printing options and click OK.

5. Click OK or Print.
Note: To print the job after you send it but before the scheduled time, release the job at the printer
control panel.

Saved Job

Saved Job stores a public or private job in the printer and prints the job as requested at the printer control
panel. This option is useful for documents that you print frequently. You can assign a passcode to a
private job to prevent unauthorized printing.

To print saved jobs, see Printing from Saved Jobs on page 85.

Sending a Public Saved Job

1.
2.
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On the Paper/Output tab, from the Job Type list, select Saved Job.

In the Saved Job window, for Job Name, do one of the following:

e  Type aname for the job.

e  Click the arrow to the right of the field and select a name from the list.

e  Click the arrow to the right of the field and select Use Document Name to use the name of the
document.

The print driver retains 10 names. When adding an 11th name, the name used least is automatically
deleted from the list. To remove names from the list other than the selected name, select Clear List.

For Folder, do one of the following:
e Type aname for the folder.
e  Click the arrow to the right of the field and select a name from the list.

e  Click the arrow to the right of the field and select Default Public Folder to use the default
public folder.
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4, Select Public.
5. Click OK.
6. Verify that the paper is the correct size, type, and weight. If not, change the paper settings.

Note: You can select the paper for your print job using Select By Tray.

7. Select an option for 2-sided printing.

8. If your printer has a finisher installed, select a stapling option. The image next to Stapling displays
the staple position.

9. Select a print-quality mode.

10. Click OK or Print.

11. To print the job, select it from the job list on the printer control panel.
12. Press OK.

After the job is saved, you can print it as needed. For details, see Printing from Saved Jobs on
page 85.

Sending a Private Saved Job
1. On the Paper/Output tab, from the Job Type list, select Saved Job.
2. Inthe Saved Job window, for Job Name, do one of the following:
e Type aname for the job.
e  Click the arrow to the right of the field and select a name from the list.

e  Click the arrow to the right of the field and select Use Document Name to use the name of
the document.

Note: The print driver retains 10 names. When adding an 11th name, the name used least is
automatically deleted from the list. To remove names from the list other than the selected name,
select Clear List.

3. For Folder, do one of the following:
e  Type a name for the folder.
e  Click the arrow to the right of the field and select a name from the list.

e  Click the arrow to the right of the field and select Default Public Folder to use the default
public folder.

4, To store your job at the printer, select Private.

5. Inthe Passcode field, type a passcode. The passcode is associated with your user name. After you set
a passcode, it becomes the default passcode for any print job that requires a passcode on all Xerox®
printers. You can reset the passcode at any time from any window that contains the passcode.

Notes:

e If you do not supply a passcode, the printer assigns a passcode and displays it in the Passcode
Required window. Use this passcode to print the document at the printer, or click Cancel and
type your own passcode to use in the Secure Print window.

e The passcode is associated with your user name. After you set a passcode, it becomes the
default passcode for any print job that requires a passcode on all Xerox® printers. You can reset
the passcode at any time from any window that contains the passcode.
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6. Click OK.
7. Verify that the paper is the correct size, type, and weight. If not, change the paper settings.

Note: You can select the paper for your print job using Select By Tray.

8. Select an option for 2-sided printing.

9. If your printer has a finisher installed, select a stapling option. The image next to Stapling displays
the staple position.

10. Select a print-quality mode.

11. Click OK.

12. To print the job, select it from the job list on the printer control panel.
13. Press OK.

After the job is saved, you can print it as needed. For details, see Printing from Saved Jobs on
page 85.

Held Print Jobs

Jobs can be held or paused for various reasons. For example, if the printer is out of paper, the job holds. If
you send a sample job, the first copy of the job prints and the rest of the copies hold until you release
them. If the system administrator has configured the Hold All Jobs feature, any job sent to the printer is
held until you release it.

Releasing Held Print Jobs

1. Atthe control panel, press the Job Status button.
2. Touch Active Jobs.
e To determine why a job was held, touch the job, then touch Job Details.

e Torelease aheld job, touch the job, then touch Release. To release all held jobs, touch Release
All Jobs.

Print From

Print From allows printing of documents stored on the printer, on a computer on a network, or on a USB
Flash drive.

Printing from a USB Flash Drive

You can print .pdf, .tiff, .ps, and .xps files directly from a USB Flash drive. If USB ports are disabled, you
cannot use a USB card reader for authentication, or print or update software from a USB Flash drive.

The system administrator must set up this feature before you can use it. For details, see the System
Administrator Guide for your printer model:

e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700docs
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900docs
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To print from a USB Flash drive:

1.

Insert the USB Flash drive into the control panel USB port. The Print from USB window appears.
The list at the bottom of the window displays the contents of the USB Flash drive.

Note: If the USB Flash drive is already in the USB memory port, touch Print From > USB Drive.

Use the arrows to the right of the list to scroll through the list and locate the printable file.
If the print file is in a folder, touch the name to open the folder.

Touch the name of the printable file.

Select the number of copies and the paper size, color, and type for the print job.

Press the green Start button.

To go back to the last screen, touch Back.

To look for other folders and printable files, touch Browse.

Printing from Saved Jobs

For details about sending saved jobs, see Saved Jobs on page 82.

To print from saved jobs:

1.
2.
3.

At the control panel, touch Print From.

Select Saved Jobs, then touch the name of the folder containing the saved job.

Touch the name of the saved job you want to print, then select paper size, 2-sided printing, and
finishing options.

Note: To print a private saved job, touch the name of the job, then enter the passcode.

Press the green Start button.
After the job prints, to return to the list of saved jobs, touch Browse.
To return to the list of folders, touch Back.

Printing from Mailbox

Print from mailbox allows you to print a file that is stored in a folder on the printer hard drive.

To print from a mailbox:

1.
2.
3.

At the control panel, touch Print From.

Select Mailbox, then touch the name the folder containing the document.

Touch the name of the document you want to print, then select the paper size, 2-sided printing, and
finishing options.

Press the green Start button.

After the job prints, to return to the list of documents in the mailbox, touch Browse.

To return to the list of folders, touch Back.
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Printing from CentreWare Internet Services

You can print .pdf, .ps, .pcl, and .xps files directly from CentreWare Internet Services without having to
open another application or the print driver. The files can be stored on a local computer hard drive, mass
storage device, or network drive.

To print from CentreWare Internet Services:

1. At your computer, open a Web browser, type the IP address of the printer in the address field, then
press Enter or Return.

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on
page 29.

2. In CentreWare Internet Services, click Print.
The Job Submission page appears.

3. Type the name of the file in the File Name field, or click Browse to select the file from a local network
or remote location.

4. Under Printing, select the desired options for the job.
5. Click Submit Job to print the document.

Note: To ensure that the job was sent to the queue, wait for the job submission confirmation
message to appear before you close this page.
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This chapter includes:
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Basic Copying

1. To clear previous settings, press the yellow Clear All button on the control panel.
2. Load your original documents:

e Use the document glass for single pages or paper that cannot be fed using the document
feeder. Place the first page of the document face down, in the top left corner of the document
glass.

e Use the document feeder for multiple or single pages. Remove any staples and paper clips from
the pages and place them face up in the document feeder.

3. Press the Services Home button, then touch Copy.

4. Use the alphanumeric keypad on the control panel to enter the number of copies. The number of
copies appears in the upper right corner of the touch screen.

Note: To correct the number of copies entered using the alphanumeric keypad, press the C button,
then re-enter the number.

5. Change the copy settings as needed. For details, see Selecting Copy Settings on page 90.
6. Press the green Start button.

Notes:

e To pause or cancel a copy job, press the red Stop button on the control panel.
e Tointerrupt a copy job, press the Interrupt button on the control panel.

e On the touch screen, touch Resume Scanning to continue the job, or Cancel Scanning to
cancel the job completely.

Document Glass

e  Lift the document feeder
cover and place the first
page face down in the upper
left corner of the
document glass.

e  The original must be aligned
to the matching paper size
printed on the edge of the
glass.

e The document glass
automatically detects
standard paper sizes.

e The document glass accepts
paper sizes up to 210 x
297 mm (8.3 x11.7 in.).
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Insert originals face up, with page one
on top.

Adjust the paper guides so they fit
against the originals.

The document feeder automatically
detects standard paper sizes.

The document feeder accepts paper
sizes from A5 (148 x 210 mm,

5.8 x 8.3 in.) through Legal

(216 x 356 mm, 8.5 x 14in.).

The document feeder accepts paper
weights from 60-150 g/m?.

The maximum document feeder
capacity is approximately 50 sheets of
80 g/m? paper.

For Legal (216 x 356 mm, 8.5 x 141in.)
documents, raise the output tray
paper stop.
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Selecting Copy Settings

This section includes:

O BOSIC SEULINGS oottt s s s st es s 91
0 IMAGE-QUALILY SELLINGS..... et ss s sssssssssssssssssesssss s s s sss s s s s s s s s s ssssasssnses 95
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o OUtpUL FOrMAL SELLINGS. ...t sse s 101
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Basic Settings

This section includes:

Selecting Color or Black and White COPIES........cvwerrereenreenierenreisiessssesssessssssssssssssssssssssssssssssssssssssssssssssssssssssns 91
Reducing or ENlArging the IMOQE ...t sesssss st sasssssass s sssssesssssssssssssssssesssssssssssansens 92
SElECtING TN PAPET TTAY ettt ssssass s sssssssssssass s s e ssassssssass s sess s sssss s ssssssssessassssssansssnsanns 92
Selecting 2-Sided COPY OPLIONS ...t cssiseessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssns 92
Selecting COlALEA COPIES ...ttt ssesass s sssssss s sass s sssss s s e sass s s s b s s s sassssssassbsnsassansanns 93
Selecting UNCOUALEA COPIES ...t sessssssass s ssssssssssssss s ssssssssssssasssssssssssssasssssssssssssssssassassssssssssanns 93
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Selecting Color or Black and White Copies

If the original document contains color, you can create copies in full color, a single color, or in black
and white.

To select the output color:

1.
2.

3.

4,

Press the Services Home button, then touch Copy.
Under Output Color, select one of the following:

e  Auto Detect detects the color content in the original document. If the original is a color
document, the printer makes copies in full color. If the original is a black and white document,
the printer makes copies in black only.

e Black & White copies in black and white only. Colors in the original are converted to shades
of gray.
For additional options, touch More, then select one of the following:

e  Auto Detect detects the color content in the original document. If the original is a color
document, the printer makes copies in full color. If the original is a black and white document,
the printer makes copies in black only.

e Black & White copies in black and white only. Colors in the original are converted to shades
of gray.
e  Color copies in full color output using all four printing colors (cyan, magenta, yellow, and black).

¢ Single Color copies in shades of a single color. Under Colors, select a color. The sample page
shows your color selection.

Touch Save.
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Reducing or Enlarging the Image
You can reduce the image to as little as 25 % of its original size or enlarge it as much as 400 %.

To reduce or enlarge the image:
1. Press the Services Home button, then touch Copy.
2. Under Reduce/Enlarge, touch an option:

e Toreduce or enlarge the percentage incrementally, touch the arrows. You are ready to
make copies.

e To use the alphanumeric keypad to type a specific value, touch the current displayed value. You
are ready to make copies.

3. Touch More for additional options.
a. Toreduce or enlarge, touch an option:
e Proportional % reduces or enlarges the image proportionally.

¢ Independent % allows you to reduce or enlarge the width and length of the image by
different percentages.

b. To select custom or preset values, touch an option:

e Proportional % or Independent % allows you to specify exact values. Touch the arrows or
touch the % field, then use the alphanumeric keypad to enter the value.

e  Presets (X-Y%) or Presets (Y/X) allows you to select from a list of preset values.
c¢. To center the image on the page, select the Auto Center check box.
4. Touch Save.

Selecting the Paper Tray

Select a paper tray loaded with the desired paper to make copies on letterhead, colored paper,
transparencies, or different paper sizes.

To select the tray to use for copies:
1. Press the Services Home button, then touch Copy.
2. Under Paper Supply, touch the desired tray.
3. If the desired tray is not listed, select another tray:
a. Touch More for additional options.
b. Touch the desired tray.
c. Touch Save.

Selecting 2-Sided Copy Options
Use the document feeder or the document glass to copy one or both sides of a 2-sided original.

To select 2-sided copy options:
1. Press the Services Home button, then touch Copy.

92 ColorQube 8700/8900 Color Multifunction Printer
User Guide



Copying

2. Under 2-Sided Copying, select one of the following:
e 1->1 Sided scans only one side of the originals and produces 1-sided copies.

e 1->2 Sided scans only one side of the originals and produces 2-sided copies. To rotate the
second sides, touch Rotate Side 2.

e 2->2 Sided scans both sides of the originals and produces 2-sided copies. To rotate the second
sides, touch Rotate Side 2.

e 2->1 Sided scans both sides of the originals and produces 1-sided copies.
3. Press the green Start button.
e The document feeder automatically copies both sides of the 2-sided original.

e A message appears on the control panel when it is time to place the next original on the
document glass.

Selecting Collated Copies

You can automatically collate multi-page copy jobs. For example, when making three 1-sided copies of a
six-page document, the copies are printed in this order:

1,2,3,4,56;1,2,3,4,5,6;1,2,3,4,5,6

To select collated copies:
1. Press the Services Home button, then touch Copy.
2. Under Copy Output, touch Collated if it is not already selected.

Selecting Uncollated Copies

Uncollated copies print in the following order:
1,1,1,2,2,2,3,3,3,4,4,4,5,5,5,6,6,6

To select uncollated copies:
1.  Press the Services Home button, then touch Copy.
If your printer has a finisher, under Copy Output, touch More.
2.  Under Collation, touch Uncollated.
3. Touch Save.

Stapling Copies
If your printer has a finisher, it can staple your copies.

To select stapling:

1. Press the Services Home button, then touch Copy.
2. Under Copy Output, select an option.

3. For additional stapling options, touch More.

4.  Under Staple, select an option.
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5. To change the orientation of the page, touch Original Orientation, then select an option.
6. Touch Save.
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Image-Quality Settings

This section includes:

o SpeCifying the OMGINGL TYPE ..t ssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnssnns
e Adjusting Brightness, Sharpness, and SAtUIALION .........cc.coveeververesieseesesiesies s sssesssssess s sessesssesssenses
e Automatically Suppressing Background VARQEION..........c.eeverveeierresiensnsiesiss s sssesssssesssssesssassssssasssssses

e Adjusting the Contrast

®  SElECtING COlON EffECLS ..uuiertereerieeserestesse sttt st es s s sass s sss st sass b ass s s s e b s s s sennen
o Adjusting the COlOr BAIANCE ...ttt sesssss s s ssss s sssssass s sssssssssass s st ssasssessansssnses

Specifying the Original Type

The printer optimizes the image quality of the copies based on the type of images in the original
document and how the original was created.

To specify the original type:

1. Press the Services Home button, then touch Copy.

2. Touch the Image Quality tab, then touch Original Type.

3. Onthe Original Type screen, select the appropriate settings:
e On the left side of the screen, touch the content type of the original document.
e If known, select how the original was produced.

4. Touch Save.

Adjusting Brightness, Sharpness, and Saturation
You can lighten or darken copies and adjust the sharpness and saturation.

To adjust the image:

1.  Press the Services Home button, then touch Copy.

2. Touch the Image Quality tab, then touch Image Options.

3. Onthe Image Options screen, adjust the sliders up or down as necessary:
e Lighten/Darken lightens or darkens the image.
e Sharpness sharpens or softens the image.
e  Saturation makes the image colors more vivid or pastel.

4. Touch Save.
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Automatically Suppressing Background Variation

When scanning originals printed on thin paper, text or images printed on one side of the paper can
sometimes be seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the
printer to variations in light background colors.

To change this setting:

1. Press the Services Home button, then touch Copy.

2. Touch the Image Quality tab, then touch Image Enhancement.
3. Under Background Suppression, touch Auto Suppression.

4.  Touch Save.

Adjusting the Contrast
Contrast is the relative difference between light and dark areas in an image.

To increase or reduce the contrast of the copies:
1. Press the Services Home button, then touch Copy.
2. Touch the Image Quality tab, then touch Image Enhancement.
3. On the Image Enhancement screen, adjust the contrast:
e Auto Contrast allows the printer to set the contrast automatically.

¢  Manual Contrast allows you to adjust the contrast manually. Move the Manual Contrast slider
up or down to increase or decrease the contrast. The middle position on the slider, Normal, does
not change the contrast.

4.  Touch Save.

Selecting Color Effects

If you have a color original, you can adjust the color of the copy using preset color effects. For example,
you can adjust colors to be brighter or cooler.

To select a preset color effect:
1. Press the Services Home button, then touch Copy.
2. Touch the Image Quality tab, then touch Color Presets.

3. Onthe Color Presets screen, touch the desired preset color effect. The sample images show how the
colors are adjusted.

4.  Touch Save.
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If you have a color original, you can adjust the balance of the printing colors between cyan, magenta,
yellow, and black before printing your copy.

To adjust the color balance:

1.
2.
3.

Press the Services Home button, then touch Copy.
Touch the Image Quality tab, then touch Color Balance.

To adjust the density levels of all four colors:

a.
b.

On the Color Balance screen, touch Basic Color.
Move the sliders to adjust the level for each color.

To adjust the highlight, midtone, and shadow density levels by color:

a. On the Color Balance screen, touch Advanced Color.

b. Touch the color you want to adjust.

¢. Move the sliders to adjust the levels for highlights, midtones, and shadows.
d. Repeat the previous two steps for additional colors.

Touch Save.
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Layout Settings

This section includes:
Specifying the Orientation of the OFigiNGAl ...t ssssssssssss s sssssssnses 98
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Specifying the Orientation of the Original

If you plan to have the copies automatically stapled, specify the orientation of the original:

1.
2.
3.

Press the Services Home button, then touch Copy.
Touch the Layout Adjustment tab, then touch Original Orientation.
On the Original Orientation screen, touch the desired orientation:

e Upright Images and Sideways Images refer to the direction the originals are loaded in the
document feeder.

e  Portrait Originals and Landscape Originals refer to the images on the originals.

Note: If you are using the document glass, the orientation of the original is as seen before turning
it over.

Touch Save.

Specifying the Size of the Original

To scan the correct area of the original, specify the original size:

1.
2.
3.
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Press the Services Home button, then touch Copy.

Touch the Layout Adjustment tab, then touch Original Size.

On the Original Size screen, select one of the following:

e Auto Detect allows the printer to determine the size of the original.

e Preset Scan Areas specifies the area to scan when it matches a standard paper size. In the
scrolling list, touch the desired paper size.

e  Custom Scan Area allows you to specify the height and width of the area to scan. Touch the
Height-Y and Width-X arrows to specify the area.

e Mixed Size Originals allows you to scan standard-size originals of varying sizes. Use the
diagram on the screen to determine which original sizes can be mixed in the same job.

Touch Save.
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Selecting Book Copying

When copying a book, magazine, or other bound document, you can copy either the left or right page
onto a single sheet of paper. You can copy both the left and right pages onto two sheets of paper, or as a
single image on one sheet of paper.

Note: You must use the document glass to make copies from books, magazines, or other bound
documents. Do not place bound originals in the document feeder.

To set up book copying:
1. Press the Services Home button, then touch Copy.
2. Touch the Layout Adjustment tab, then touch Book Copying.
3. Onthe Book Copying screen, select one of the following:
e  Off copies both pages of an open book as one image on a single sheet of paper.

e Both Pages copies the left and the right pages of an open book onto two sheets of paper. If
Binding Edge Erase is required, touch the arrows to erase up to 2 in.

e Left Page Only copies only the left page of an open book on a single sheet of paper. If Binding
Edge Erase is required, touch the arrows to erase up to 1 in.

e Right Page Only to copy only the right page of an open book on a single sheet of paper. If
Binding Edge Erase is required, touch the arrows to erase up to 1 in.

4. Touch Save.

Shifting the Image

You can change the placement of an image on the copy page. This is useful if the image is smaller than
the page size. Originals must be positioned as follows for image shift to work correctly:

e Document Feeder: Position originals face up, long edge entering the feeder first.

e Document Glass: Position originals face down, in the back-left corner of the document glass, long
edge to the left.

To change the placement of the image:
1. Press the Services Home button, then touch Copy.
2. Touch the Layout Adjustment tab, then touch Image Shift.
3. On the Image Shift screen, select one of the following:
e Auto Center centers the image on the page.

e  Margin Shift allows you to specify the position of the image. Touch the Up or Down and Left or
Right arrows to specify the amount of shift for Side 1. Touch the Up or Down and Left or Right
arrows to specify the amount of shift for Side 2, or select Mirror Side 1.

Note: You can use preset values that were previously saved by the system administrator. Touch
Presets in the lower left corner of the screen, and select a preset from the drop-down menu.

4. Touch Save.
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Erasing the Edges of Copies

You can erase content from the edges of your copies by specifying the amount to erase on the right, left,
top, and bottom edges.

To erase edges on copies:

1. Press the Services Home button, then touch Copy.

2. Touch the Layout Adjustment tab, then touch Edge Erase.
3. Onthe Edge Erase screen, select one of the following:

e All Edges erases all four edges by the same amount. Touch the All Edges arrows to specify the
amount to erase from the edges.

e Individual Edges specifies different amounts for the edges. Touch Side 1, then touch the Left,
Right, Top, and Bottom arrows to specify the amount to erase from each edge. Touch Side 2,
then touch the Left, Right, Top, and Bottom arrows to specify the amount to erase from each
edge, or touch Mirror Side 1.

Note: You can use preset values that were previously saved by the system administrator. Touch
Presets in the lower left corner of the screen, and select a preset from the drop-down menu.

4.  Touch Save.

Inverting the Image

You can invert your original, as a mirror image or as a negative image. You can use one or both of
these options.

To invert the image:

1. Press the Services Home button, then touch Copy.

2. Touch the Layout Adjustment tab, then touch Invert Image.
3. Onthe Invert Image screen, select the desired options:

e  Mirror Image reflects each image left to right on the page. The default setting is Normal
Image.

e Negative Image reverses the black and white values. The default setting is Positive Image.
4. Touch Save.
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Output Format Settings

This section includes:

O CreatiNg G BOOKIET ...ttt sss st ssss s sssssssssss s sssesssssssssssssssssassessssssnsasesssssns 101
®  INCIUAING COVENS...oueieterreetsrstesess et sass s sass s ssssssss s sas e ss s s s e a s st et ass b bes s s st sass s sassbansens 102
o Specifying Chapter STArt PAGINGLION ...t issesssses s s sssssssssssssssssssssssssssssssssssssssssssanns 103
O AING INSEIES ..ottt st sss st s s st s s s s s s s s s et e ssssssnsasessnsans 103
®  SPECifYING EXCEPLION PAGES ..ottt ssss st e ssss st sass s sassssssass s ssssssssssssansssssansssssanns 104
®  AAAING ANNOTALIONS ...ttt sessssss s sass e sass s ssssss st sssssbssbass s sass s s s bess s s sasstsssassssnsessbansanns 105
o Adding TraNSPArENCY SEPATALOLS ......ovvrvereerrerierreseereessssssssssssssssesssssssssssssssssssssssssssssssessssssssssssssssssssssssssssssesssssens 107
o Printing MULLIPLE PAGES POI SIA ...ttt sessse s s ssse s ssssasasssasssannes 107
®  REPEALING AN IMOGE ..ttt sttt s ntaes 108

Creating a Booklet

You can print copies in the form of a booklet. The original page images are reduced to print two images
per side of each printed page. You can then fold and staple the pages manually, or automatically using
the appropriate finisher.

Note: In this mode, the printer scans all of the originals before printing the copies.

To create a booklet:

Press the Services Home button, then touch Copy.
Touch the Output Format tab, then touch Booklet Creation.
On the Booklet Creation screen, touch On.

£ whN S

To select a paper tray:
a. Touch Paper Supply.
b. Touch the desired tray.
c. Touch Save.
5. To specify 2-sided originals:
a. Touch Original Input.
b. Touch 2 Sided Originals.
6. Touch Save.
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Including Covers

You can print the first and last pages of your copy job on different paper, such as colored or heavyweight
paper. The printer selects the paper from a different tray. The covers can be blank or printed.

Note: The paper used for the covers must be the same size as the paper used for the rest of
the document.

To select the type of covers and the tray to use for the cover paper:
1. Press the Services Home button, then touch Copy.
2. Under Paper Supply, touch the tray containing the paper for the body pages of the job.

Note: If the paper supply is set to Auto Select, covers are unavailable.

3. Touch the Output Format tab, then touch Special Pages.
4. On the Special Pages screen, touch Covers.
5. Under Covers Options, select an option:
e  Front & Back Same includes front and back covers from the same tray.
e Front & Back Different includes a front and a back cover from different trays.
e  Front Cover Only includes only a front cover.
e Back Cover Only includes only a back cover.

Note: The Front & Back Different option includes two Printing Options menus.

6. Touch Printing Options.

7. From the drop-down menu that appears, select an option:
e Blank Cover inserts a blank cover.
e  Print on Side 1 prints on the front side of the cover.

e  Print on Side 2 prints on the back side of the cover. To rotate the image on side 2 by
180 degrees, touch Rotate Side 2.

e  Print on Both Sides prints on both sides of the cover. To rotate the image on Side 2 by
180 degrees, touch Rotate Side 2.

8. Touch the tray containing cover paper.
9. Touch Save.

10. On the Covers screen, touch Save.

11. On the Special Pages screen, touch Save.
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Specifying Chapter Start Pagination

If you select 2-sided copies, you can set each chapter to start on the front or back of the page. If
necessary, the printer leaves one side of the paper blank so that the chapter starts on the specified side of
the paper.

To set the start side of particular pages:
1. Press the Services Home button, then touch Copy.
2. Under Paper Supply, touch the tray containing the paper for the body pages of the job.

Note: If the paper supply is set to Auto Select, Chapter Starts is unavailable.

3. Touch the Output Format tab, then touch Special Pages > Chapter Starts.

4. Onthe Chapter Starts screen, touch the Page Number field, then use the alphanumeric keypad to
enter the page number.

5. Under Start Chapter, select the appropriate page:

e On Right Page specifies the front side of the paper.

e  On Left Page specifies the back side of the paper.

Touch Add. That page is added to the list on the right side of the screen.
Repeat the three previous steps to set other pages.

Touch Close. The page settings appear in the list on the right side of the screen.

L N

Touch Save.

Adding Inserts

You can insert blank pages or pre-printed sheets in specific locations in your copy job. You must specify
the tray containing the inserts.

Note: The paper used for the inserts must have the same width as the paper used for the rest of the
document. Inserts cannot be added if Booklet Creation is selected.

To add inserts:
1. Press the Services Home button, then touch Copy.
2. Under Paper Supply, touch the tray containing the paper for the body pages of the job.

Note: If the paper supply is set to Auto Select, inserts cannot be added.

3. Touch the Output Format tab, then touch Special Pages > Inserts.

4. On the Inserts screen, touch the After Page Number field, then use the alphanumeric keypad to
enter the page number.

5. Touch the Insert Quantity arrows to specify the number of sheets to insert at that location.
6. To specify the paper tray to use for the insert:

a. Touch Paper Supply.

b. Touch the desired tray.

c. Touch Save.
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10.

Touch Add. The insert appears in the list on the right side of the screen.
Repeat the three previous steps to add additional inserts.
Touch Close. The inserts appear in the list on the right side of the screen.

Note: To edit or delete an insert, touch the insert in the list, then touch an action in the
drop-down menu.

Touch Save.

Specifying Exception Pages

You can print exception pages in a copy job using paper from a different tray. The paper used for the
exception pages must be the same size as the paper used for the rest of the document.

Note: You cannot add exception pages if the paper supply is set to Auto Select, or if Booklet Creation
is selected.

To specify the exception pages:

1.

10.

104

Press the Services Home button, then touch Copy.

Note: If the paper supply is set to Auto Select, exception pages are unavailable.

Under Paper Supply, touch the tray containing the paper for the body pages of the job.
Touch the Output Format tab, then touch Special Pages > Exceptions.

On the Exceptions screen, touch the beginning Page Number field, then use the alphanumeric
keypad to enter the starting value for the range of the exception pages.

Touch the ending Page Number field, then use the alphanumeric keypad to enter the ending value
for the range of exception pages.

Note: To specify a single page as an exception, enter its number as the start and end of the range.

To specify the paper used for the exception pages:

a. Touch Paper Supply.

b. Touch the tray containing paper for the exception pages.

c. Touch Save.

Touch Add. The exception pages are added to the list on the right side of the screen.
Repeat the four previous steps to add additional exception pages.

Touch Close. The exception pages appear in the list on the right side of the screen.

Note: To edit or delete an exception page, touch the page in the list, then touch the desired operation
in the drop-down menu.

Touch Save.
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Adding Annotations

You can automatically add annotations such as page numbers and the date to your copies.

Notes:

e Annotations are not added to covers, tabs, inserts, or blank chapter start pages.
e Annotations cannot be added if Booklet Creation is selected.

To add annotations:
Press the Services Home button, then touch Copy.

1.
2.
3.

Touch the Output Format tab, then touch Annotations.

To insert page numbers:

a.
b.

On the Annotation screen, touch Page Numbers > On.
Touch Apply To, and select one of the following:

e AllPages

e All Pages Except First

Touch the Starting Page Number field, then use the alphanumeric keypad to enter the page
number.

Under Position, touch an arrow to position the page number in the header or footer. The sample
page shows the location of the page number.

Touch Save.

To change the text formatting, touch Format & Style, choose the desired settings, then
touch Save.

To insert a comment:

a.
b.

C.

Touch Comment > On.

Touch Apply To, and select one of the following:
e AllPages

e  All Pages Except First

e  First Page Only

Touch an existing comment in the list.

Note: To create a new comment, touch a blank row, use the touch screen keyboard to type the text,
then touch Save.

d.

Under Position, touch an arrow to position the selected comment in the header or footer. The
sample page shows the location of the comment.

Touch Save.

To change the text formatting, touch Format & Style, choose the desired settings, then
touch Save.
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5. Toinsert the current date:
a. Touch Date > On.
b. Touch Apply To, and select one of the following:
e All Pages
e All Pages Except First
e  First Page Only
c¢. Under Format, select a format for the date.

d. Under Position, touch an arrow to position the date in the header or footer. The sample page
shows the location of the date.

Touch Save.

f.  To change the text formatting, touch Format & Style, choose the desired settings, then
touch Save.

6. Toinsert a Bates Stamp:
a. Touch Bates Stamp > On.

b. Touch the Starting Page Number field, then use the alphanumeric keypad to enter the starting
page number. Leading zeros can be included.

c. Touch Apply To, and select one of the following:
e AllPages
e All Pages Except First

d. Touch an existing prefix in the list.

Note: To create a new prefix, touch a blank row, use the touch screen keyboard to type up to eight
characters, then touch Save.

e. Under Position, touch an arrow to position the Bates Stamp in the header or footer. The sample
page shows the location of the Bates Stamp.

f.  Touch Save.

g. Tochange the text formatting, touch Format & Style, choose the desired settings, then
touch Save.

7. Touch Save.
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Adding Transparency Separators

You can add blank sheets of paper between each printed transparency. The size and orientation of the
separators must be the same as the transparencies.

Note: Transparency separators cannot be added if the paper supply is set to Auto Select.

To add transparency separators:

1.
2.
3.

Press the Services Home button, then touch Copy.
Touch the Output Format tab, then touch Transparency Separators > On.

Under Separator Supply, touch the tray containing the paper to use for the separators. If the tray
containing the separator paper is not displayed, touch More, touch the desired tray, then

touch Save.

Under Transparency Supply, touch the tray containing the transparencies. If the tray containing the
transparencies is not displayed, touch More, touch the desired tray, then touch Save.

Touch Save.

Printing Multiple Pages per Side

You can copy a single page and have it print multiple times onto one or both sides of the paper. The
printer reduces the pages proportionally to fit.

To print multiple original pages on a side:

1.
2.
3.

Press the Services Home button, then touch Copy.

Touch the Output Format tab, then touch Page Layout > Pages per Side.

Touch the number of original pages for each side of the paper. To specify a different number:
a. Touch Specify Rows & Columns.

b. Touch the Rows arrows to change the number of rows.

¢. Touch the Columns arrows to change the number of columns.

d. Select the Rotate check box to rotate the page.

Note: The right side of the screen contains a diagram of the image layout.

Touch Original Orientation, then touch one of the following:
e  Portrait Originals

e Landscape Originals

Touch Save.
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Repeating an Image

You can make multiple copies of an original image on one or both sides of the paper. This is useful for
duplicating a small image.

To repeat an image on a sheet of paper:
1. Press the Services Home button, then touch Copy.
2. Touch the Output Format tab, then touch Page Layout > Repeat Image.
3. Specify the number of images to print on the page:
e Preset buttons repeat the image two, four, six, or nine times on each side of the paper.

e  Specify Rows & Columns allows you to determine the number of images. Touch the Rows or
Columns field, then use the alphanumeric keypad to enter the number of rows and columns, or
touch the arrows. Select the Rotate check box to rotate the paper.

e  Auto Repeat allows the printer to determine the maximum number of images that can fit on
the currently selected paper size. Touch Original Orientation, and select Upright Images or
Sideways Images from the drop-down menu. The sample page shows the image layout.

4.  Touch Save.
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ID Card Copying

This section includes:

COPYING AN ID CAT.eririerrirrireirriseereesreississsesesssssssssssssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssssssssssssasess 109
Selecting Color or Black and WhiIte COPIES........ceeverierirerensissensiesisssessissessssssssssssssssssssssssssssssessssssssssassessanses 110
Reducing or ENlArging the IMOQE ...ttt sassssssss st sssssssssssssssessssssssssassassssssssssanns 110
SeleCting The PAPET TTAY ..t ssssass et ssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasssssssssssssssssasess 111
SPECIfYING the OFGINAL TYPE ettt s s s s sas s sas s sass s sass s esssass s e s s sanses 111
Lightening or Darkening ID Card COPIES .....iniererinsiesensiesies s iessesssssssssssssssssssssssssssssssessssssssssassssssassssssanns 111
Automatically Suppressing Background VAriQtioN..............ceninsinensensinsissisesssssssssssssssssssssssssssssssens 112

Copying an ID Card

You can copy both sides of an ID card or small document onto one side of paper. Each side is copied using
the same location on the document glass. The printer stores both sides and prints them side by side on
the paper.

To copy an ID card:

1.

vt whN

N o

10.
11.

12.
13.

Press the Services Home button, then touch ID Card Copy.

Touch the ID Card Copy tab.

Verify the output color, paper supply, and reduce/enlarge settings. Change the settings as needed.
Touch the Image Quality tab.

Verify the original type, lighten/darken, and background suppression settings for side 1. Change the
settings as needed.

Lift the document cover.

Place the ID card, or a document smaller than half the selected paper supply size, in the upper left
corner of the document glass.

Press the green Start button.
Lift the document cover.
Turn over the document and position it in the upper left corner of the document glass.

Verify the original type, lighten/darken, and background suppression settings for side 2. Change the
settings as needed.

Press the green Start button.
Lift the document cover and remove the ID card or document.
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Selecting Color or Black and White Copies

If the original document contains color, you can create color or black and white copies.

To select the output color:

1.
2.
3.

Press the Services Home button, then touch ID Card Copy.
Touch the ID Card Copy tab.
Under Output Color, select an option:

e  Auto Detect detects the color content in the original document. If the original is a color
document, the printer makes copies in full color. If the original is a black and white document,
the printer makes copies in black only.

e Black & White copies in black and white only. Colors in the original are converted to shades
of gray.

Reducing or Enlarging the Image

You can reduce the image to as little as 25 % of its original size or enlarge it as much as 400 % .

To reduce or enlarge the image:

1.
2.
3.
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Press the Services Home button, then touch ID Card Copy.

Touch the ID Card Copy tab.

Under Reduce/Enlarge, touch an option:

e Toreduce or enlarge the percentage incrementally, touch the arrows. You are ready to make
copies.

e To use the alphanumeric keypad to type a specific value, touch the current displayed value. Use
the alphanumeric keypad on the control panel to enter the percentage. You are ready to make
copies.

Touch More for additional options.

a. Toreduce or enlarge, touch an option:

e Proportional % reduces or enlarges the image proportionally.

¢ Independent % allows you to reduce or enlarge the width and length of the image by
different percentages.

b. To select custom or preset values, touch an option:

e Proportional % or Independent % allows you to specify exact values. Touch the arrows or
touch the % field, then use the alphanumeric keypad to enter the value.

e  Presets (X-Y%) or Presets (Y/X) allows you to select from a list of preset values.
c. Touch Save.
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Selecting the Paper Tray

Select a paper tray loaded with the desired paper to make copies on letterhead, colored paper,
transparencies, or different paper sizes.

To select the tray to use for ID card copies:
1. Press the Services Home button, then touch ID Card Copy.
2. Touch the ID Card Copy tab.
3. Under Paper Supply, touch the desired tray.
4. If the desired tray is not listed, select another tray:
a. Touch More for additional options.
b. Touch the desired tray.
c. Touch Save.

Specifying the Original Type

The printer optimizes the image quality of the copies based on the type of images in the original
document and how the original was created.

To specify the original type:
1. Press the Services Home button, then touch ID Card Copy.
2. Touch the Image Quality tab.
3. Under Original Type, select the appropriate settings:
e  Touch the content type of the original document.
e If known, select how the original was produced.

Lightening or Darkening ID Card Copies

You can lighten or darken the copy for each side. Use the slider to lighten or darken the output for the
first side. After the first side is complete, use the slider again to lighten or darken the second side. Both
sides of the original are printed side by side, each using different lighten or darken settings.

To adjust the image:

1. Press the Services Home button, then touch ID Card Copy.

Touch the Image Quality tab.

To lighten or darken the image for side 1, under Lighten/Darken, adjust the slider up or down.
Lift the document cover.

W & WwN

Place the ID card, or a document smaller than half the selected paper supply size, in the upper left
corner of the document glass.

Press the green Start button.
Lift the document cover.
Turn over the document and position it in the upper left corner of the document glass.

L RN

To lighten or darken the image for side 2, adjust the slider up or down.
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10. Press the green Start button.
11. Lift the document cover and remove the ID card or document.

Automatically Suppressing Background Variation

When scanning originals printed on thin paper, text or images printed on one side of the paper can
sometimes be seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the
printer to variations in light background colors.

To change this setting:
1. Press the Services Home button, then touch ID Card Copy.

2. Touch the Image Quality tab.
3. Under Background Suppression, touch Auto Suppression.
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Advanced Copying

This section includes:
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Building a Copy Job

Use this feature to produce complex copy jobs that include a variety of originals requiring different copy
settings. Each segment of the job can have different copy settings. Once all the segments are
programmed, scanned, and temporarily stored in the printer, the copy job prints.

To build a copy job with multiple segments:

1.
2.

Press the Services Home button, then touch Copy.

Program and scan the first segment:

Load the originals for the first segment.

Select the required settings, such as layout adjustments, image quality, and so on.
Touch the Job Assembly tab, then touch Build Job > On.

Select or clear the Display this window between segments check box.

Select or clear the Turn Build Job Off after Job is Submitted check box.

Press the green Start button on the control panel.

o anoTe

Program and scan additional segments:

a. Load the originals for the next segment.

b. When the Build Job screen appears, touch Program Next Segment.

c. Using the appropriate tabs, select the required settings.

d. Press the green Start button to scan the originals for that segment.

Repeat the previous step for each remaining segment.

Touch the Quantity for Final Job field, and use the alphanumeric keypad to enter the number of
copies.

In the upper right corner of the Build Job screen, touch Print the Job.

Note: If necessary, touch Delete > Delete Job to cancel the job.
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Printing a Sample Copy

You can print a test copy of a complex copy job, before printing multiple copies. This feature prints a
single copy and holds the remaining copies. After you inspect the sample, you can print or cancel the
remaining copies.

Note: The sample copy is not counted as part of the quantity selected. For example, if you select
three copies, one sample copy prints, and three other copies are held until they are released for
printing. The result is a total of four copies.

To print a sample copy of your copy job:

Press the Services Home button, then touch Copy.

Touch the desired copy settings.

Touch the Job Assembly tab, then touch Sample Job > On.

Touch Save.

On the control panel, press the green Start button. The sample copy is printed.
Print the remaining copies or delete the job:

ot whN-=

e Torelease and print the remaining copies of the job, touch Release.
e If the sample copy is unsatisfactory, touch Delete > Delete Job.

Saving Copy Settings

To use a particular combination of copy settings for future copy jobs, you can save the settings with a
name and retrieve them for later use.

To save the current copy settings:

1. Press the Services Home button, then touch Copy.

2. Touch the Job Assembly tab, then touch Save Current Settings.

3. Using the touch screen keyboard, type a name for the saved settings.
4. Touch Save.

Retrieving Saved Copy Settings
You can retrieve and use any previously saved copy settings for current jobs.

Note: To save the copy settings with a name, see Saving Copy Settings on page 114.

To retrieve saved settings:

1. Press the Services Home button, then touch Copy.

2. Touch the Job Assembly tab, then touch Retrieve Saved Settings.
3. Touch the desired saved setting.

Note: To delete a saved setting, touch the setting, then touch Delete Settings.

4. Touch Load Settings. The saved settings are loaded for the current copy job.
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This chapter includes:
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The system administrator must set up this feature before you can use it. For details, see the System
Administrator Guide for your printer model:

ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700docs
ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900docs
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Scanning

Basic Scanning

The Scanning feature provides several methods for scanning and storing an original document. The
scanning procedure using your printer differs from that of desktop scanners. The printer is connected
typically to a network rather than a single computer, so you select a destination for the scanned image at
the printer.

The printer supports the following scanning functions:

e Scan documents and store images on the printer hard drive.

e  Scan original documents to a document repository on a network server.
e Scan original documents to an email address.

e  Scan original documents to your home directory.

e  Scan original documents to a USB Flash drive.

e Import scanned images into applications using TWAIN and WIA.

To scan an image:

1.
2.

o v b w
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On the control panel, press the yellow Clear All button to clear previous settings.
Load your original documents:

e Use the document glass for single pages or paper that cannot be fed using the document
feeder. Place the first page of the document face down, in the top left corner of the
document glass.

e  Use the document feeder for multiple or single pages. Remove any staples and paper clips from
the pages and place them face up in the document feeder.

Press the Services Home button, then touch Workflow Scanning.

Touch the Down Arrow, then select the template group from the menu.

Select a template from the list.

To change any of the scan settings, use the options at the bottom of the touch screen:
e  Output Color

e 2-Sided Scanning

e Original Type

e Scan Presets

For details, see Changing the Basic Scan Settings on page 124.

Press the green Start button.

Notes:

e  The printer must be connected to a network to retrieve a scan file remotely.
e  For detdils, see the Help in CentreWare Internet Services.

e  Print, copy, and fax jobs can print while you are scanning original documents or downloading
files from the printer hard drive.
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Document Glass

e  Lift the document feeder
cover and place the first
page face down in the upper
left corner of the document
glass.

e The original must be aligned
to the matching paper size
printed on the edge of
the glass.

e The document glass
automatically detects
standard paper sizes.

e The document glass accepts
paper sizes up to 210 x
297 mm (8.3 x11.7 in.).

Document Feeder

e Insert originals face up, with page one
on top.

e Adjust the paper guides so they fit
against the originals.

e  The document feeder automatically
detects standard paper sizes.

e The document feeder accepts paper
sizes from A5 (148 x 210 mm,
5.8 x 8.3 in.) through Legal
(216 x 356 mm, 8.5 x 14in.).

e  The document feeder accepts paper
weights from 60-150 g/m?2

e  The maximum document feeder
capacity is approximately 50 sheets of
80 g/m? paper.

e Forlegal (216 x 356 mm, 8.5x 14in.)
documents, raise the output tray
paper stop.
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Scanning to a Folder

This section includes:
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Scanning to a folder is the simplest scanning method. When you scan an image at the printer, the scan
file is stored in a folder on the internal hard drive. You then use CentreWare Internet Services to retrieve
the stored scan file to your computer.

The default settings create a 1-sided color portable document format (.pdf) file. You can change these
settings using the printer control panel, or using CentreWare Internet Services at your computer. Control
panel selections override the settings in CentreWare Internet Services.

Scanning to the Public Folder

The printer provides a public folder to store scanned images. You do not need a password to scan images
to the public folder, or to retrieve them. All users can view scanned documents in the public folder. You
can also create a password-protected private folder. For details, see Creating a Private Folder on

page 119.

To scan an image to the public folder:

1. Load the original on the document glass or in the document feeder.

Press the Services Home button, then touch Workflow Scanning.

Touch the Down arrow, then select All Templates from the menu.

Select the PUBLIC folder from the list.

To change any of the scan settings, use the options at the bottom of the touch screen:
e  Output Color

s whN

e 2-Sided Scanning

e Original Type

e Scan Presets

For details, see Changing the Basic Scan Settings on page 124.

6. For more options, touch the Advanced Settings tab. For details, see Selecting Advanced Settings on
page 125.

7. Press the green Start button. The Job Progress screen appears, and the original is scanned. The file is
stored on the printer hard drive.

8. Use CentreWare Internet Services to move the file to your computer. For details, see Retrieving Scan
Files on page 120.
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Scanning to a Private Folder

The system administrator creates private folders on the printer. Private folders can require a password.
You can use CentreWare Internet Services to create your own private folders. For details, see Creating a
Private Folder on page 119.

To scan to a private folder:

1.

s whN

o

Load the original on the document glass or in the document feeder.
Press the Services Home button, then touch Workflow Scanning.
Touch the Down arrow, then select All Templates from the menu.
From the list, select the private folder.

If required, enter the password. On the Document Management screen, touch Enter Password for
Folder, then use the touch screen keyboard.

Touch Done.
Touch Save.
Press the green Start button.

Creating a Private Folder

For you to create a private folder, the scan policy to allow additional folders to be created must be
enabled. The system administrator can create a private folder at any time.

To create a private folder with a password:

1.
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At your computer, open a Web browser, type the IP address of the printer in the address field, then
press Enter or Return.

Note: If you do not know the IP address for your printer, see Finding the IP Address of the Printer on
page 29.

Click the Scan tab.

In the Display section, select Mailboxes.

In the Scan to Mailbox section, click Create Folder.

Click the Folder Name: field, and type a name for the folder.

In the Folder Password field, type a password that adheres to the password rules.
In the Confirm Folder Password field, type the password again.

Click Apply.

Your private folder appears in the folder list in CentreWare Internet Services and on the printer touch
screen under Local Templates. The contents are stored on the printer hard drive.
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Retrieving Scan Files

To retrieve your scanned images, use CentreWare Internet Services to copy the scan files from the printer
to your computer.

To retrieve your scan files:

1.

120

At your computer, open a Web browser, type the IP address of the printer in the address field, then
press Enter or Return.

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on
page 29.

Click the Scan tab.

In the Display section, select Mailboxes.

In the Scan to Mailbox section, click the folder containing the scan.
Your scan file appears in the Folder Contents window.

Notes:
e  For apassword protected private folder, click the Folder Password field, type the password,
then click OK.
e If your image file does not appear, click Update View.

Under Action, select an option, then click Go.

e Download saves a copy of the file to your computer. When prompted, click Save, then navigate
to the location on your computer to save the file. Open the file or close the dialog box.

e  Reprint prints the file without saving a copy of the file to your computer.

o Delete removes the file from the mailbox. When prompted, click OK to delete the file or Cancel
to cancel the operation.
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Scanning to Network File Repositories

This section includes:
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When using this feature, the images you scan are sent to a file repository on a network server. The system
administrator configures the file repository settings.

Using CentreWare Internet Services, you can add your own scan destinations to templates.

Scanning to a Predefined Network File Repository

To scan an image and send it to a predefined network file repository:

1. Load the original on the document glass or in the document feeder.

2. Press the Services Home button, then touch Workflow Scanning.

3.  Touch the Down arrow, then select All Templates from the drop-down menu.
4

Select the template created by the system administrator from the list. The template defines the scan
settings as well as the destination of the image.

5.  To change any of the scan settings, use the options at the bottom of the touch screen:
e  Output Color
e 2-Sided Scanning
e Original Type
e Scan Presets
For details, see Changing the Basic Scan Settings on page 124.
6. Press the green Start button.
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Adding a Scan Destination

1. At your computer, open a Web browser, type the IP address of the printer in the address field, then
press Enter or Return.

Click the Scan tab.

In the Display areaq, select Templates.

Under Template Operations, click Create New Template.

In the New Distribution Template area, under Add Destination to Template, click Enter a Scan
Destination.
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Click the Friendly Name: field, and create a name for the template.
Under Protocol, select an option.

8. Configure the destination IP address, port, document path, filing policy, and login credentials
as needed.

9. Click Add. The template is stored on the printer hard drive.
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Scanning to Your Home Directory

The Scan to Home feature allows you to scan an image to your home directory.

Note: To use the Scan to Home function, you must log in with a valid user name and passcode. For details,
see Logging In on page 27.

To scan an image to your home directory:

1. Load the original on the document glass or in the document feeder.

Press the Services Home button, then touch Workflow Scanning.

Touch the Down arrow, then select Scan to Home Templates from the menu.

Select the template created by the system administrator from the list.

To change any of the scan settings, use the options at the bottom of the touch screen:
e  Output Color

e wnN

e 2-Sided Scanning

e Original Type

e Scan Presets

For details, see Changing the Basic Scan Settings on page 124.

6. For more options, touch the Advanced Settings tab. For details, see Selecting Advanced Settings on
page 125.

7. Press the green Start button.
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Setting Scan Options

This section includes:
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The scanning features in your printer use templates that define the scan settings and the destination for
an image.

Changing the Basic Scan Settings

To change the basic scan settings:

1.
2.
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Press the Services Home button, then touch Workflow Scanning.
Touch Output Color and select one of the following options:

e  Auto Detect detects the color content in the original image. If the original image is color, the
printer scans in full color. If the original is a black and white document, the printer scans in black
only.

e Black & White scans in black and while only.

e Grayscale detects and scans various shades of gray.

e  Color scansin full color.

Touch 2-Sided Scanning and select one of the following options:

e 1-Sided scans only one side of the original image and produces 1-sided output files.

e  2-Sided scans both sides of the original image.

e 2-Sided, Rotate Side 2 scans both sides of the original image, rotating the second side.
Touch Original Type and select one of the following options:

e Photo & Text

e Photo
e Text
e Map

¢ Newspaper/Magazine

Note: The photo and text options allow you to specify the type of original, such as printed,
photocopied, photograph, inkjet, or solid ink.

ColorQube 8700/8900 Color Multifunction Printer
User Guide



Scanning

Touch Scan Presets and select one of the following options:

e Sharing & Printing produces small file size and normal image quality.

e  Archival - Small File Size produces smallest file size and normal image quality.

e  OCR Optical Character Recognition (OCR) produces large file size and highest image quality.
¢ High Quality Printing produces large file size and highest image quality.

e Simple Scan produces large file size with minimal image processing and compression.

Selecting Advanced Settings

Advanced settings allow you to control image options, image enhancements, scan resolution, file size,
and updating of templates.

To select advanced settings:

1.
2.
3.

Press the Services Home button, then touch Workflow Scanning.
Touch the Advanced Settings tab.
To adjust brightness, sharpness, and saturation:
a. Touch Image Options.
b. Onthe Image Options screen, adjust the sliders up or down as necessary:
e Lighten/Darken lightens or darkens the image.
e  Sharpness sharpens or softens the image.
e Saturation makes the image colors more vivid or pastel.
c. Touch Save.
To suppress background variation:
a. Touch Image Enhancement.
b. Under Background Suppression, touch Auto Suppression.
c. Touch Save.
To adjust the contrast:
a. Touch Image Enhancement.
b. Onthe Image Enhancement screen, select one of the following:
e Auto Contrast allows the printer to set the contrast automatically.

e  Manual Contrast allows you to adjust the contrast manually. Move the Manual Contrast
slider up or down to increase or decrease the contrast. The middle position on the slider,
Normal, does not change the contrast.

c. Touch Save.

To set the resolution:

a. Touch Resolution.

b.  On the Resolution screen, select a resolution from 72 dpi through 600 dpi.
c. Touch Save.
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7. Toset the quality and file size:
a. Touch Quality/File Size.

b.  On the Quality/File Size screen, use the slider to select a setting. The settings range from Normal
Quality and Small File Size to Highest Quality and Largest File Size.

c. Touch Save.

8. Toretrieve new templates and remove outdated ones:
a. Touch Update Templates > Update Now.
b. Touch Confirm.

Selecting Layout Adjustments

Layout adjustments provide additional settings for the size and orientation of the original, and erasing
the edges.

To select layout adjustments:
1. Press the Services Home button, then touch Workflow Scanning.
2. Touch the Layout Adjustment tab.
3. To specify the orientation of the original image:
a. Touch Original Orientation.
b.  On the Original Orientation screen, select one of the following options:

¢ Upright Images and Sideways Images refer to the direction the originals are loaded in the
document feeder.

e  Portrait Originals and Landscape Originals refer to the images on the originals.
c. Touch Save.
4. To scan the correct area of the original image:
a. Touch Original Size.
b.  On the Original Size screen, select one of the following options:
e  Auto Detect allows the printer to determine the size of the original.

e Preset Scan Areas specifies the area to scan when it matches a standard paper size. In the
scrolling list, touch the desired paper size.

e  Custom Scan Area allows you to specify the height and width of the area to scan. Touch
the Height-Y and Width-X arrows to specify the area.

e Mixed Size Originals allows you to scan standard-size originals of varying sizes. Use the
diagram on the screen to determine which original sizes can be mixed in the same job.

c. Touch Save.
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To specify the amount to erase from the edges of your image:

a.
b.

Touch Edge Erase.
On the Edge Erase screen, select one of the following options:

e All Edges erases all four edges by the same amount. Touch the All Edges arrows to specify
the amount to erase from the edges.

e Individual Edges specifies different amounts for the edges. Touch Side 1, then touch the
Left, Right, Top, and Bottom arrows to specify the amount to erase from each edge. Touch
Side 2,then touch the Left, Right, Top, and Bottom arrows to specify the amount to erase
from each edge, or touch Mirror Side 1.

Touch Save.

Selecting Filing Options

Filing Options provide additional settings for naming images, selecting image formats, and selecting
behavior when a file name exists.

To select filing options:

1.
2.
3.

Press the Services Home button, then touch Workflow Scanning.
Touch the Filing Options tab.

To define a file name prefix:

a.
b.
C.

Touch File Name.
Type a name for your image file using the touch screen keyboard.
Touch Save.

To select a file format:

a.
b.

€.

Touch File Format.
On the File Format screen, select one of the following options:

e PDF
e PDF/A
e XPS

e  Multi-Page TIFF

e TIFF (1 File per Page)

e JPEG (1 File per Page)

For PDF, PDF/A, or XPS, select one of the following options:
e Image Only

e Searchable

For the searchable option, touch Document Language, then select a language from the
drop-down menu.

Touch Save.

To select the action to take if a file already exists:

a.
b.

C.

Touch If File Already Exists.
On the If File Already Exists screen, select an option.
Touch Save.
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6. To define additional network locations as destinations for scanned documents:
a. Touch Add File Destinations.
b. On the Add File Destinations screen, touch the desired destinations.
c. Touch Save.

Note: Document Management and Add File Destinations can be modified only after scanning to network
file repositories or scanning to home are set up. For details, see the System Administrator Guide for your
printer model:

e ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700docs
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900docs

Building a Scan Job
Use this feature to combine an assorted group of originals for assembly into a single scan job.

To build a scan job:

1. Press the Services Home button, then touch Workflow Scanning.
Touch the Job Assembly tab, then touch Build Job > On.

Select or clear the Display this window between segments check box.
Select or clear the Turn Build Job Off after Job is Submitted check box.
Program and scan the first segment:

it whN

a. Load the originals for the first segment.
b. Press the green Start button on the control panel.

Note: If a password is required, contact the system administrator.

6. Program and scan additional segments:
a. Load the originals for the next segment.
b. When the Build Job screen appears, touch Program Next Segment.
c. Pressthe green Start button to scan the originals for that segment.
7. Repeat the previous step for each remaining segment.

Note: At any time, you can touch Delete Last Segment or Delete All Segments to modify the job.

8. When all of the segments have been programmed and scanned, touch Submit the Job. The Job
Progress screen appears, and the individual segments are scanned as a single job.

9. On the Job Progress screen, touch Job Details to view a summary of the job.

Note: If necessary, touch Delete > Delete Job to cancel the job.
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Scanning to a USB Flash Drive

1. Load the original on the document glass or in the document feeder.
2. Insert your USB Flash Drive in the USB port on the printer control panel.

Note: If the USB Flash drive is already in the USB memory port, press Services Home, then touch
Workflow Scanning > Scan to USB.

3. Onthe USB Drive Detected screen, touch Scan to USB.
4. To change any of the scan settings, use the options at the bottom of the touch screen:
e  Output Color
e 2-Sided Scanning
e Original Type
e Scan Presets
For details, see Changing the Basic Scan Settings on page 124.
5. Press the green Start button.

The Job Progress screen appears, and the original is scanned. The file is stored on your USB Flash
drive.

6. Remove your USB Flash drive from the printer.
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Scanning to an Email Address

This section includes:
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When using this feature, the images you scan are sent as email attachments.

Sending a Scanned Image to an Email Address

To scan an image and send it to an email address:
1. Load the original on the document glass or in the document feeder.
2. Press the Services Home button, then touch E-mail.
3. To enter an email address:
a. Touch New Recipient.
b. Touch the Down arrow, then select To: or Cc: or Bcc: from the menu.

¢. Touch the Enter email address and select Add field, then use the touch screen keyboard to
type the email address.

d. Touch Add.
e. Use the touch screen keyboard to type additional email addresses.
f.  When you are finished, touch Close.
4. To enter an email address from the network address book:
a. Touch Address Book.
b. Use the touch screen keyboard to type part of the name, then touch Search.
c. Select the desired name from the list, then touch Add.
5. Toadd asubject line:
a. Touch Subject, then use the touch screen keyboard to type the desired text.

Note: To modify the default subject that appears, touch Clear Text to clear the field, or use the Left
and Right arrows to edit the text.

b. Touch Save.
6. Tochange any of the scan settings, use the options at the bottom of the touch screen:
Output Color
2-Sided Scanning

Original Type

e Scan Presets

For details, see Changing the Basic Scan Settings on page 124.
7. Press the green Start button.
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Setting Email Options

You can change the following email settings:

File Name
File Format
Message
Reply To

To change the email options:

1.
2.
3.

Load the original on the document glass or in the document feeder.

Press the Services Home button, then touch E-mail.

To change any of the scan settings, use the options at the bottom of the touch screen:
e  Output Color

e 2-Sided Scanning

e  Original Type

e Scan Presets

For details, see Changing the Basic Scan Settings on page 124.

Touch the E-mail Options tab.

Change the file name:

a. Touch File Name.

b.  On the File Name screen, use the touch screen keyboard to delete or modify the default text.
c. Touch Save.

Change the file format:

a. Touch File Format.

b.  On the File Format screen, select one of the following options:

e PDF
e PDF/A
e XPS

e  Multi-Page TIFF
e TIFF (1 File per Page)
e JPEG (1 File per Page)
c. For PDF, PDF/A, or XPS, select one of the following options:
e Image Only
e Searchable

d. For the searchable option, touch Document Language, then select a language from the
drop-down menu.

e. Touch Save.
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7. Change the message:
a. Touch Message.
b. Onthe Message screen, use the touch screen keyboard to type a message to appear with the
images.
c. Touch Save.
8. Change the Reply To address:
a. Touch Reply To.
b. On the Reply To screen, use the touch screen keyboard to type an email address.
c. Touch Save.
9. Press the green Start button.
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This chapter includes:
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The system administrator must set up this feature before you can use it. For details, see the System
Administrator Guide for your printer model:

ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700docs
ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900docs
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Basic Faxing

You can send a fax in one of four ways:

Embedded Fax scans the document and sends it directly to a fax machine.

Server Fax scans the document and sends it to a fax server, which transmits the document to a fax
machine.

Internet Fax scans the document and emails it to a recipient.
LAN Fax sends the current print job as a fax. For detdils, see the print driver software.

To send a fax:

1.

134

Load your original documents:

e Use the document glass for single pages or paper that cannot be fed using the document
feeder. Place the first page of the document face down, in the top left corner of the document
glass.

e  Use the document feeder for multiple or single pages. Remove any staples and paper clips from
the pages and place them face up in the document feeder.

Press the Services Home button, then touch the appropriate fax.
Address the fax using one or more of the available options:

e  The Enter Number and Press Add field allows you to enter a fax number manually. Use the
alphanumeric keypad to enter the number, then touch Add.

e Dialing Characters allows you to insert characters such as a Dial Pause in a fax number. Use the
touch screen keypad to enter the numerals and characters, then touch Save.

Note: One or more dialing pauses can be required between the access number for an outside line and
the fax number. When inserted, the dial pauses appear as commas in the fax number.

e  Address Book allows you to access the printer address book.
e Speed Dial allows you to access directories of group or individual fax telephone numbers.
On the Fax tab, adjust the available fax options as needed.

Adjust additional fax options as needed. For details, see Selecting Fax Options on page 138,
Selecting Server Fax Options on page 148, or Selecting Internet Fax Options on page 153.
Press the green Start button. The printer scans the pages and transmits the document when all
pages have been scanned.
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Document Feeder

Lift the document feeder
cover and place the first
page face down in the upper
left corner of the document
glass.

The original must be aligned
to the matching paper size
printed on the edge of

the glass.

The document glass
automatically detects
standard paper sizes.

The document glass accepts
paper sizes up to 210 x
297 mm (8.3 x11.7 in.).

Insert originals face up, with page one
on top.

Adjust the paper guides so they fit
against the originals.

The document feeder automatically
detects standard paper sizes.

The document feeder accepts paper
sizes from A5 (148 x 210 mm,

5.8 x 8.3 in.) through Legal

(216 x 356 mm, 8.5 x 14in.).

The document feeder accepts paper
weights from 60-150 g/m?2

The maximum document feeder
capacity is approximately 50 sheets of
80 g/m? paper.

For Legal (216 x 356 mm, 8.5 x 141in.)
documents, raise the output tray
paper stop.
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Sending an Embedded Fax

136

Load the original document in the document feeder or on the document glass.
Press the Services Home button, then touch Fax.
To address the fax, touch one or more of the following:

e  The Enter Number and Press Add field allows you to enter a fax number manually. Use the
alphanumeric keypad to enter the number, then touch Add.

e Dialing Characters allows you to insert characters such as a dial pause in a fax number. Use the
touch screen keypad to enter the numerals and characters, then touch Add. Add more numbers,
or touch Close.

Note: One or more dialing pauses can be required between the access number for an outside line and
the fax number. When inserted, the dial pauses appear as commas in the fax number.

e Address Book allows you to select fax numbers from your Address Book. Touch the Down arrow,
then select Individual or Group from the drop-down menu. Touch the Up or Down arrows to
scroll through the list, touch the desired contact, then select Add to Recipients from the
drop-down menu. Select and add more contacts, or touch Close.

e The Speed Dial check box allows you to select recipients from your address book. Touch the
Enter Number and Press Add field, then use the alphanumeric keypad to enter the three-digit
speed dial number. Touch Add.

To include a cover sheet:
da. Touch Cover Sheet > On.

b. Touch the To field, use the touch screen keyboard to type the name of the recipient, then
touch Save.

c. Touch the From field, use the touch screen keyboard to type the name of the sender, then
touch Save.

d. Toadd a comment, do one of the following:
e Touch an existing comment, then touch Save.

e  Touch an <Available> comment, touch Edit, use the touch screen keyboard to type the
text, then touch Save.

Notes:
e Todelete an existing comment, touch the comment, then touch Clear. Touch Clear to confirm
the action.

e To edit an existing comment, touch the comment, then touch Edit. Use the touch screen
keyboard to change the comment, then touch Save.

Adjust the fax scanning options if necessary:

a. Touch 2-sided Scanning and select from the drop-down menu:
e 1-Sided
e 2-Sided
e 2-Sided, Rotate Side 2
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b. Touch Original Type and select from the drop-down menu:
e Photo & Text
e Photo
o Text
¢.  Touch Resolution and select from the drop-down menu:
e Standard (200x100 dpi)
e Fine (200 dpi)
e  Super Fine (600 dpi)
If desired, select more options. For details, see Selecting Fax Options on page 138.

Press the green Start button. The printer scans the pages and transmits the document when all
pages have been scanned.
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Selecting Fax Options

This section includes:

o Adjusting Brightness and SNAMPNESS ... sesseesssessssessssesssessssssssesssssesssssssssessasessssessssssses
e Automatically Suppressing Background Variation..........ocoeorreneeneeeseeseeseceeeessesssessesssesssesssessssssssssnes
®  AJUSEING the CONEIASE...ceureeeeee ettt ees st ess e s s s s s st s s sssesssesasasasnsanes
o Specifying the Size Of the OrigiNal ...ttt ess s sssesssessssessaseens
o Selecting REAUCING OF SPUTEING c.ucuureeeeeecee ettt sssessesss st s s s ss e sssesssesasesasesannes
0 Setting UP BOOK FOXING iuuiiurieriieeeeeeeeceecee e ese st ees et esss s sssss s esssessse s sssssasessse s ssssesasesassssnnes
o Printing a CONfirMQLION REPOIT c....couuceeeeeeeeecee et eesseessssesssse s ssssesssssessssessssessssessssessssessssssens
o Selecting the STAMING ROLE ...ttt sss s s e ss st s et s sssssasasasnssenes
0 SeNAING A DELAYEA FOX w.ourriurieriereeeeeeeeceeeie et sessesssessss s sssss s ssssssssssssessse s s s ssssssasasssessssssssesssssasnssnnes
®  SENAING HEAAET TEXE .ot sasssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnns
o Sending a FOX tO @ REMOLE MAIIDOX.......u it sesssessss e ssssss s ssss s ssssesssssassssnnes
o Storing a FAX iN @ LOCAL MAIIDOX w.ccneeriee ettt ss s s s s ssssssss s ssse s ssssssasssasnsannes
o Printing LOCAl MQIIDOX DOCUMENTS......c.oververeeerierrineersisssessisssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnns
o Deleting LOCAl MilDOX DOCUMENLS .....oueueieerierreereeeeeseeeseiee e sesssssesssssssssesssesssssssssssssssssssessssssssssssssssssssssnnes
e Storing a Fax for Local or R@MOLE POIlING ... ees s sssssssssssssssssssssssssssssssnnes
o  Printing Or Deleting SLOr@A FAXES ......ovovverrvreeererriseereesessissesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnns
®  POllING 0 REMIOLE FOX iuririurieriiriineceereeesecescae et ssssessse s s sesas s s s s ssssessse bbb asesssesssssssasasssasnssnes
®  POllING 0 REMOLE MAIDOX ...ttt cesesss s sssss s sssessse s sssssasess s ssssasasssasnssnes
®  BUILAING O FOX JOD ettt ssssssss s sssssssssssssss s s sssssssssssssssssssssssssssssssssssssssssssssssssnsssnssns

Adjusting Brightness and Sharpness
You can lighten or darken the image, and adjust the sharpness.

To adjust the image:

1.  Press the Services Home button, then touch Fax.

2. Touch the Image Quality tab, then touch Image Options.

3. Onthe Image Options screen, adjust the sliders up or down as necessary:
e Lighten/Darken lightens or darkens the image.
e Sharpness sharpens or softens the image.

4. Touch Save.
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Automatically Suppressing Background Variation

When scanning originals printed on thin paper, text or images printed on one side of the paper can
sometimes be seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the
printer to variations in light background colors.

To select Auto Suppression:

1. Press the Services Home button, then touch Fax.

2. Touch the Image Quality tab, then touch Image Enhancement.
3. Under Background Suppression, touch Auto Suppression.

4.  Touch Save.

Adjusting the Contrast
Contrast is the relative difference between light and dark areas in an image.

To adjust the contrast:

1.  Press the Services Home button, then touch Fax.

2. Touch the Image Quality tab, then touch Image Enhancement.
3. On the Image Enhancement screen, adjust the contrast:

e  Manual Contrast allows you to adjust the contrast manually. Under Manual Contrast, move the
slider up or down to increase or decrease the contrast. The middle position on the slider, Normal,
does not change the contrast.

e Auto Contrast allows the printer to set the contrast automatically.
4.  Touch Save.

Specifying the Size of the Original
To ensure that you are scanning the correct area of the documents, specify the original size.

To specify the original size:
1. Press the Services Home button, then touch Fax.
2. Touch the Layout Adjustment tab, then touch Original Size.
3. On the Original Size screen, select one of the following:
e  Auto Detect allows the printer to determine the size of the original.

e Preset Scan Areas specifies the area to scan when it matches a standard paper size. In the
scrolling list, touch the desired paper size.

e  Custom Scan Area allows you to specify the height and width of the area to scan. Touch the
Height-Y and Width-X arrows to specify the area.

e Mixed Size Originals allows you to scan standard-size originals of varying sizes. Use the
diagram on the screen to determine which original sizes can be mixed in the same job.

4. Touch Save.
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Selecting Reducing or Splitting
You can determine the method to use for handling images that are too large.

To select reducing or splitting:
1. Press the Services Home button, then touch Fax.
2. Touch the Layout Adjustment tab, then touch Reduce/Split.
3. Touch an option:
e Reduce to Fit shrinks large documents to fit on smaller paper.
e Split Across Pages continues a single image across several pages.
4. Touch Save.

Setting Up Book Faxing
You can determine the method used for scanning images in a book.

To select book faxing:
1.  Press the Services Home button, then touch Fax.
2. Touch the Layout Adjustment tab, then touch Book Faxing.
3. Touch an option:
o  Offis the default setting.

o Both Pages scans both pages of the book. If necessary, touch the Binding Edge Erase arrows to
set the amount to erase from the binding edge.

o Left Page Only scans the left page of the book. If necessary, touch the Binding Edge Erase
arrows to set the amount to erase from the binding edge.

¢ Right Page Only scans the right page of the book. If necessary, touch the Binding Edge Erase
arrows to set the amount to erase from the binding edge.

4. Touch Save.

Printing a Confirmation Report

You can print a report that confirms when your faxes are sent or received. The report contains
information on timeouts, busy signals, and retry failures.

To set up a confirmation report printing:
1. Press the Services Home button, then touch Fax.
2. Touch the Fax Options tab, then touch Confirmation Report.
3. Touch an option:
e Always Print generates a report for all fax jobs.
e  Print on Error Only only generates a report for fax jobs that fail to send.
4.  Touch Save.
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Selecting the Starting Rate

Select the highest starting rate unless the destination for the fax you are sending has
special requirements.

To select the transmission speed for a fax:
1.  Press the Services Home button, then touch Fax.
2. Touch the Fax Options tab, then touch Starting Rate.
3. Touch an option:
e  Super G3 (33.6 Kbps)
e G3 (14.4 Kbps)
e Forced (4800 bps)
4. Touch Save.

Note: Some telephone networks can require the fax starting rate to be set to Forced (4800 bps). The
slow data rate ensures more reliable transmission of data.

Sending a Delayed Fax

You can set a time in the future for the printer to send your fax job. The time delay can be from 15
minutes to 24 hours from the current time.

Note: The printer must be set to the current time before you can use this feature.

To specify the time to send your fax:

1. Press the Services Home button, then touch Fax.

2. Touch the Fax Options tab, then touch Delay Send.

3. Touch Specified Time and set the time:
a. Touch the Hour field and use the keypad or touch the arrows to set a number.
b. Touch the Minute field and use the keypad or touch the arrows to set a number.
c. If your printer is set to display the 12-hour clock, touch AM or PM.

4. Touch Save. The fax is sent at the specified time.

Sending Header Text

The system administrator must set up this feature before you can use it. For details, see the System
Administrator Guide for your printer model:

e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700docs
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900docs

To include the fax header text:
1. Press the Services Home button, then touch Fax.
2. Touch the Fax Options tab, then touch Send Header Text.
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3. Touch an option:

e  Offis the default setting.

e  On sends the header text with the fax.
4, Touch Save.

Sending a Fax to a Remote Mailbox

1. Press the Services Home button, then touch Server Fax.
2. Touch the Fax Options tab, then touch Mailboxes.

3. Touch Send to Remote Mailbox.

4. To address the fax, select an option:

e The Fax Number field allows you to enter a fax number. Use the alphanumeric keypad to enter
the number, then touch Add.

e Dialing Characters allows you to insert characters such as a Dial Pause in a fax number. Use the
touch screen keypad to enter the numerals and characters, then touch Save.

e  Address Book allows you to select fax numbers from your Fax Address Book. Touch the Up or
Down arrows to scroll through the list, touch the desired contact, then select Add to Recipients
from the drop-down menu. Select and add more contacts, or touch Close.

5. Touch the Mailbox Number field, then use the alphanumeric keypad to enter the mailbox number.

6. Touch the Mailbox Passcode field, then use the alphanumeric keypad to enter the four-digit
mailbox passcode.

7. Touch Save.

Storing a Fax in a Local Mailbox

The system administrator must create a mailbox before you can use this feature. For details, see the
System Administrator Guide for your printer model:

e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700docs
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900docs

To store a fax in a local mailbox:

1.  Press the Services Home button, then touch Fax.

Touch the Fax Options tab, then touch Mailboxes.

Touch Store to Local Mailbox.

Touch the Mailbox Number field, then use the alphanumeric keypad to enter the mailbox number.

i &N

Touch the Mailbox Passcode field, then use the alphanumeric keypad to enter the four-digit
mailbox passcode.

6. Touch Save.
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Printing Local Mailbox Documents

To use this feature, you must have documents stored in a mailbox. For details, see Storing a Fax in a Local
Mailbox on page 142.

To print local mailbox documents:

1.

- whN

Press the Services Home button, then touch Fax.

Touch the Fax Options tab, then touch Mailboxes.

Touch Print Local Mailbox Documents.

Touch the Mailbox Number field, then use the alphanumeric keypad to enter the mailbox number.

Touch the Mailbox Passcode field, then use the alphanumeric keypad to enter the four-digit
mailbox passcode.

Touch Print All Documents. The documents in the mailbox are printed.

Deleting Local Mailbox Documents

1.

b whN

N o

Press the Services Home button, then touch Fax.

Touch the Fax Options tab, then touch Mailboxes.

Touch Delete Local Mailbox Documents.

Touch the Mailbox Number field, then use the alphanumeric keypad to enter the mailbox nhumber.

Touch the Mailbox Passcode field, then use the alphanumeric keypad to enter the four-digit
mailbox passcode.

Touch Delete All Documents.
To confirm, touch Delete All. All documents in the mailbox are deleted.

Storing a Fax for Local or Remote Polling

Turn on Secure or Non-Secure Local Polling to make fax documents stored on one printer available for
remote polling by other printers. When Secure Local Polling is on, you create a list of fax numbers that are
allowed to access the stored faxes on the printer.

To store a fax:

1.
2.
3.

Press the Services Home button, then touch Fax.
Touch the Fax Options tab, then touch Local Polling.
Under Store for Local Polling, touch one of the following options:

¢ Non-Secure Polling scans your originals and stores them as documents. Anyone with this fax
number can access the documents.

e Secure Polling scans your originals and stores them as documents. You specify the fax numbers
that can access the documents.

For secure polling, touch one or more of the following to add fax numbers to the access list:

e  Fax Number field allows you to enter a fax number manually. Use the alphanumeric keyboard
to enter the number, and touch Add.

e Address Book allows you to add individual stored fax numbers to the list. Select a fax number,
and select Add to Recipients from the drop-down menu. Touch Close.
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e The Allow all Address Book fax numbers access check box adds all stored fax numbers to
the list.

Note: To modify existing entries in the access list, touch the entry, then select Edit, Remove, or
Remove All from the drop-down menu.

5. Touch Save.

Printing or Deleting Stored Faxes

1.  Press the Services Home button, then touch Fax.
2. Touch the Fax Options tab, then touch Local Polling.
3. Under Stored Local Documents, touch an option:
e  Print All prints all stored fax documents.
o Delete All deletes all stored fax documents. Touch Delete All to confirm the action.

Polling a Remote Fax

If remote polling is turned on, you can retrieve documents that were stored using local polling on another
fax machine.

Note: If Local Polling is turned on, Remote Polling is not available. To turn off Local Polling, touch
Local Polling > Off > Save.

To poll a remote fax:

1. Press the Services Home button, then touch Fax.

2. Touch the Fax Options tab, then touch Remote Polling.
3. Touch Poll a Remote Fax.

4. Select one or more options for addressing the fax:

e  The Enter Number and Press Add field allows you to enter a fax number manually. Use the
alphanumeric keypad to enter the number, then touch Add.

e The Speed Dial check box allows you to select recipients from your address book. Touch the
Enter Number and Press Add field, then use the alphanumeric keypad to enter the three-digit
speed dial number. Touch Add.

e Dialing Characters allows you to insert characters such as a Dial Pause in a fax number. Use the
touch screen keypad to enter the numerals and characters, then touch Save.

e Address Book allows you to select fax numbers from your Fax Address Book. Touch the Up or
Down arrows to scroll through the list, touch the desired contact, then select Add to Recipients
from the drop-down menu. Select and add more contacts, or touch Close.

5. Toset alater time when you want your printer to retrieve faxes from other fax machines:
a. Touch Delay Send.
b. Touch Specified Time to set the time.
c. Touch Save.
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6. Touch Poll Now to retrieve and print the faxes.

Note: Touch Close to cancel the operation.

Polling a Remote Mailbox

If remote polling is turned on, you can retrieve documents that are stored in a fax mailbox on another
fax machine.

Note: If Local Polling is turned on, Remote Polling is not available. To turn off Local Polling, touch
Local Polling > Off > Save.

To poll a remote mailbox:
1.  Press the Services Home button, then touch Fax.
2. Touch the Fax Options tab, then touch Remote Polling.
3. Touch Poll a Remote Mailbox.
4. To specify the fax number you want to access, do one of the following:
e  The Fax Number field allows you to use the alphanumeric keypad to enter the number.

e Dialing Characters allows you to insert characters such as a Dial Pause in a fax number. Use the
touch screen keypad to enter the numerals and characters, then touch Save.

e  Address Book allows you to select fax numbers from your Fax Address Book. Touch the Up or
Down arrows to scroll through the list, touch the desired contact, then select Add to Recipients
from the drop-down menu. Select and add more contacts, or touch Close.

5.  Touch the Mailbox Number field, then use the alphanumeric keypad to enter the mailbox number.

6. Touch the Mailbox Passcode field, then use the alphanumeric keypad to enter the four-digit
mailbox passcode.

7. Touch Poll Now to retrieve and print the faxes in the mailbox.

Note: Touch Close to cancel the operation.

Building a Fax Job

Use this feature to fax an assorted group of originals, each with different settings. Each segment is
programmed and scanned, and the images are stored temporarily in the printer. Once all segments have
been stored, the individual segments are faxed as a single job.

To build a fax job:
1. Press the Services Home button, then touch the appropriate fax.
2. Address the fax using one or more of the available options:

e The Enter Number and Press Add field allows you to enter a fax number manually. Use the
alphanumeric keypad to enter the number, then touch Add.

e Dialing Characters allows you to insert characters such as a Dial Pause in a fax number. Use the
touch screen keypad to enter the numerals and characters, then touch Save.

e Address Book allows you to access the printer address book.
e Speed Dial allows you to access directories of group or individual fax telephone numbers.
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Touch the Job Assembly tab, then touch Build Job > On.

Select or clear the Display this window between segments check box.
Select or clear the Turn Build Job Off after Job is Submitted check box.
Program and scan the first segment:

a. Load the originals for the first segment.

o vt w

b. Select the required settings, such as layout adjustments, image quality, and so on.
c. Press the green Start button on the control panel.
7. Program and scan additional segments:
a. Load the originals for the next segment.
b.  When the Build Job screen appears, touch Program Next Segment.
¢. Using the appropriate tabs, select the required settings.
d. Press the green Start button to scan the originals for that segment.
8. Repeat the previous step for each remaining segment.

Note: At any time, you can touch Delete Last Segment or Delete All Segments to modify the job.

9. When all of the segments have been programmed and scanned, touch Submit the Job. The Job
Progress screen appears, and the individual segments are faxed as a single job.

10. On the Job Progress screen, touch Job Details to view a summary of the job.

Note: If necessary, touch Delete > Delete Job to cancel the job.
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Sending a Server Fax

If a fax server is connected to the network, you can send a document to a fax machine without requiring
a dedicated telephone line.

When using the Server Fax, a document is scanned and sent to a fax repository located on the network.
The fax server then sends the fax over a telephone line to a fax machine.

The system administrator must enable the Server Fax service and configure a fax repository, or filing
location, before you can use this feature.

To send a server fax:

1.
2.
3.

Load the original document in the document feeder or on the document glass.
Press the Services Home button, then touch Server Fax.
To address the fax, touch one or more options:

e  The Enter Number and Press Add field allows you to enter a fax number manually. Use the
alphanumeric keypad to enter the number, then touch Add.

¢ Dialing Characters allows you to insert characters such as a dial pause in a fax number. Use the
touch screen keypad to enter the numerals and characters, then touch Add. Add more numbers,
or touch Close.

e Fax Directory allows you to select fax numbers from your Fax Directory. Touch the Up or Down
arrows to scroll through the list, touch the desired contact, then select Add to Recipients from
the drop-down menu. Select and add more contacts, or touch Close.

Adjust the fax scanning options if necessary:
a. Touch 2-sided Scanning and select from the drop-down menu:
e 1-Sided
e 2-Sided
e 2-Sided, Rotate Side 2
b. Touch Original Type and select from the drop-down menu:
e Photo & Text
e Photo
o Text
c.  Touch Resolution and select from the drop-down menu:
e Standard (200x100 dpi)
e Fine (200 dpi)
If desired, select more options. For details, see Selecting Server Fax Options on page 148.

Press the green Start button. The printer scans the pages and transmits the document when all
pages have been scanned.
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Selecting Server Fax Options

This section includes:

®  AQJUSEING BIIGNENESS ...ttt ssssssse s sass st s ssss s s ssssssssssssssssssesssssssssssssssssssssssssssssasesssssns 148
e  Automatically Suppressing Background VARQLION..........cc.eeveeeerreriessesiesiessesisssessssseessessesssssssssssssssssesssssenns 148
®  AdJUSEING the CONLIAST ...ttt as st sass s bas st sas s s e s s s s e sa st sass b sassbansens 149
o  Specifying the Orientation Of the OTiGINGAl ...t ssssssssssssssssssssssssssnsssnes 149
o Specifying the Size of the OFiGINGL ...ttt s bssss s sssssass s sass b nsens 149
®  SENAING U DEIAYEA FOX currruirtrirerrirrereiesiesississiesisssae st sessssssassssssasssssssssssssssssessssssssssassassssssssssasssssssssssssssssssssssssssssnsenns 150
©  BUILAING O FOX JOD ittt sas st ss s e s ssssss s s sssesssssassssssssssasssssssssssasesssssns 150

Adjusting Brightness
You can lighten or darken the image.

To adjust the image:

1. Press the Services Home button, then touch Server Fax.

2. Touch the Image Quality tab, then touch Image Options.

3. On the Image Options screen, adjust the Lighten/Darken slider up or down as necessary.
4. Touch Save.

Automatically Suppressing Background Variation

When scanning originals printed on thin paper, text or images printed on one side of the paper can
sometimes be seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the
printer to variations in light background colors.

To select Auto Suppression:

1. Press the Services Home button, then touch Server Fax.

2. Touch the Image Quality tab, then touch Image Enhancement.
3. Under Background Suppression, touch Auto Suppression.

4. Touch Save.

148 ColorQube 8700/8900 Color Multifunction Printer
User Guide



Faxing

Adjusting the Contrast
Contrast is the relative difference between light and dark areas in an image.

To adjust the contrast:

1. Press the Services Home button, then touch Server Fax.

2. Touch the Image Quality tab, then touch Image Enhancement.
3. On the Image Enhancement screen, adjust the contrast:

¢  Manual Contrast allows you to adjust the contrast manually. Under Manual Contrast, move the
slider up or down to increase or decrease the contrast. The middle position on the slider, Normal,
does not change the contrast.

e Auto Contrast allows the printer to set the contrast automatically.
4. Touch Save.

Specifying the Orientation of the Original

1. Press the Services Home button, then touch Server Fax.
2. Touch the Layout Adjustment tab, then touch Original Orientation.
3. On the Original Orientation screen, touch the desired orientation:

e Upright Images and Sideways Images refer to the direction the originals are loaded in the
document feeder.

e  Portrait Originals and Landscape Originals refer to the images on the originals.

Note: If you are using the document glass, the orientation of the original is as seen before turning
it over.

4.  Touch Save.

Specifying the Size of the Original
To ensure that you are scanning the correct area of the documents, specify the original size.

To specify the original size:
1.  Press the Services Home button, then touch Server Fax.
2. Touch the Layout Adjustment tab, then touch Original Size.
3. On the Original Size screen, select one of the following:
e  Auto Detect allows the printer to determine the size of the original.

e Preset Scan Areas specifies the area to scan when it matches a standard paper size. In the
scrolling list, touch the desired paper size.

e  Custom Scan Area allows you to specify the height and width of the area to scan. Touch the
Height-Y and Width-X arrows to specify the area.

e Mixed Size Originals allows you to scan standard-size originals of varying sizes. Use the
diagram on the screen to determine which original sizes can be mixed in the same job.

4. Touch Save.
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Sending a Delayed Fax

You can set a time in the future for the printer to send your fax job. The time delay can be from 15
minutes to 24 hours from the current time.

Note: The printer must be set to the current time before you can use this feature.

To specify the time to send your fax:

1. Press the Services Home button, then touch Server Fax.

2. Touch the Fax Options tab, then touch Delay Send.

3. Touch Specified Time and set the time:
a. Touch the Hour field and use the keypad or touch the arrows to set a number.
b. Touch the Minute field and use the keypad or touch the arrows to set a number.
c. If your printer is set to display the 12-hour clock, touch AM or PM.

4. Touch Save. The fax is sent at the specified time.

Building a Fax Job

For details, see Building a Fax Job on page 145.
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Sending an Internet Fax

If an SMTP (email) server is connected to the network, a document can be sent to an email address. This
feature eliminates the need for a dedicated telephone line and the associated service costs. When
sending an Internet Fax, the document is scanned and sent to an email address.

To send an Internet fax:

1.
2.
3.

Load the original on the document glass or in the document feeder.
Touch the Services Home button, then touch Internet Fax.
Address the fax:

a. Touch New Recipient.

b. Touch the Down arrow, then select To: or Cc: from the menu.

c. Touch the Enter email address and select Add field, then use the touch screen keyboard to
type the email address.

d. Touch Add.

e. Use the touch screen keyboard to type additional email addresses.

f.  When you are finished, touch Close.

To add a subject line:

a. Touch Subject, then use the touch screen keyboard to type the desired text.

Note: To modify the default subject that appears, touch Clear Text to clear the field, or use the Left
and Right arrows to edit the text.

b. Touch Save.

Adjust the Internet fax options if necessary:

a. Touch Output Color and select from the drop-down menu:
e  Auto Detect
o Black & White
e Grayscale
e Color

b. Touch 2-sided Scanning and select from the drop-down menu:
e 1-Sided
e 2-Sided
e 2-Sided, Rotate Side 2

¢. Touch Original Type and select from the drop-down menu:
e Photo & Text

e Photo
e Text
e Map

e Newspaper/Magazine
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6. Adjust fax options if necessary.

7. Press the green Start button. The printer scans the pages and sends the document as an emaiil
attachment in .pdf or tiff file format, when all pages have been scanned.
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Selecting Internet Fax Options

This section includes:
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Adjusting Brightness and Sharpness
You can lighten or darken the image, and adjust the sharpness.

To adjust the image:

1.  Touch the Services Home button, then touch Internet Fax.

2. Touch the Advanced Settings tab, then touch Image Options.

3. Onthe Image Options screen, adjust the sliders up or down as necessary:
e Lighten/Darken lightens or darkens the image.
e  Sharpness sharpens or softens the image.

4.  Touch Save.

Automatically Suppressing Background Variation

When scanning originals printed on thin paper, text or images printed on one side of the paper can
sometimes be seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the
printer to variations in light background colors.

To select Auto Suppression:

Touch the Services Home button, then touch Internet Fax.

2. Touch the Advanced Settings tab, then touch Image Enhancement.
3. Under Background Suppression, touch Auto Suppression.

4. Touch Save.

—
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Adjusting the Contrast
Contrast is the relative difference between light and dark areas in an image.

To adjust the contrast:

1. Touch the Services Home button, then touch Internet Fax.

2. Touch the Advanced Settings tab, then touch Image Enhancement.
3. On the Image Enhancement screen, adjust the contrast:

¢  Manual Contrast allows you to adjust the contrast manually. Move the slider up or down to
increase or decrease the contrast. The middle position on the slider, Normal, does not change
the contrast.

e  Auto Contrast allows the printer to set the contrast automatically.
4. Touch Save.

Specifying the Orientation of the Original

1. Touch the Services Home button, then touch Internet Fax.
2. Touch the Layout Adjustment tab, then touch Original Orientation.
3. On the Original Orientation screen, touch the desired orientation:

¢ Upright Images and Sideways Images refer to the direction the originals are loaded in the
document feeder.

e  Portrait Originals and Landscape Originals refer to the images on the originals.

Note: If you are using the document glass, the orientation of the original is as seen before turning
it over.

4.  Touch Save.

Specifying the Size of the Original
To ensure that you are scanning the correct area of the documents, specify the original size.

To specify the original size:
1. Touch the Services Home button, then touch Internet Fax.
2. Touch the Layout Adjustment tab, then touch Original Size.
3. On the Original Size screen, select one of the following:
e  Auto Detect allows the printer to determine the size of the original.

e Preset Scan Areas specifies the area to scan when it matches a standard paper size. In the
scrolling list, touch the desired paper size.

e  Custom Scan Area allows you to specify the height and width of the area to scan. Touch the
Height-Y and Width-X arrows to specify the area.

e Mixed Size Originals allows you to scan standard-size originals of varying sizes. Use the
diagram on the screen to determine which original sizes can be mixed in the same job.

4. Touch Save.
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Setting the Resolution

1.  Touch the Services Home button, then touch Internet Fax.
2. Touch the Advanced Settings tab, then touch Resolution.
3. On the Resolution screen, touch the desired resolution.
e 72 dpi produces acceptable image quality for onscreen viewing, and the smallest file size.
e 100 dpi produces good image quality for onscreen viewing, and small file size.
e 150 dpi produces good image quality for onscreen viewing, and small file size.
e  200x100 dpi produces good image quality, and moderate file size.
e 200 dpi produces good image quality, and moderate file size. This setting is the default.
e 300 dpi produces high image quality, and large file size.
e 400 dpi produces higher image quality, and larger file size.
e 600 dpi produces the highest image quality, and the largest file size.
4. Touch Save.

Note: Check with the system administrator to determine the largest file size that the email
system allows.

Setting the Quality and File Size

The Quality/File Size option lets you choose from three settings that balance the quality of the image and
the size of the file. Higher quality images result in larger file sizes, which are not ideal for sharing and
transmitting over the network.

To set the Internet fax quality and file size:
1. Touch the Services Home button, then touch Internet Fax.

2. Touch the Advanced Settings tab, then touch Quality/File Size.

3. On the Quality/File Size screen, use the slider to select a setting. The settings range from Normal
Quality and Small File Size to Highest Quality and Largest File Size.

4.  Touch Save.

Specifying a File Format

1. Touch the Services Home button, then touch Internet Fax.
2. Touch the Internet Fax Options tab, then touch File Format.
3. On the File Format screen, select an option:
e  Multi-Page TIFF produces a multi-page Tagged Image File Format (.tiff).
e  PDF produces a Portable Document Format (.pdf).
e PDF/A produces a Portable Document Format (.pdf) with embedded fonts.
4. Touch Save.

ColorQube 8700/8900 Color Multifunction Printer 155
User Guide



Faxing

Adding a Message

1. Touch the Services Home button, then touch Internet Fax.
2. Touch the Internet Fax Options tab, then touch Message.
3. Type a message using the touch screen keyboard.

4. Touch Save.

Specifying a Reply To Address

1. Touch the Services Home button, then touch Internet Fax.
2. Touch the Internet Fax Options tab, then touch Reply To.
3. Type an email address using the touch screen keyboard.

4. Touch Save.

Printing an Acknowledgment Report

If the status of each recipient is known, you can print a delivery status report. The printer waits for a
delivery receipt from each recipient, then prints the report.

Note: The report could be delayed depending on the response time of the recipients.
To print an acknowledgment report:
1. Touch the Services Home button, then touch Internet Fax.

Touch the Internet Fax Options tab, then touch Acknowledgment Report.

2.
3. Touch Print Report.
4. Touch Save.

Building a Fax Job

For details, see Building a Fax Job on page 145.
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Sending a LAN Fax

Local Area Network (LAN) Fax allows you to send faxes from the print driver on your computer to a fax
machine over a telephone line. The Fax window allows you to enter recipients, create a cover page with
notes, and set options. Using the options you can select confirmation sheets, send speed, fax resolution,
send time, and fax dialing options.

Notes:
e When the Fax job type is selected, some features, such as Edge Enhancement, Thin Line
Enhancement, and Black Enhancement, are turned off.
e Not all printer models support this feature.

To send a LAN fax:

1. With the desired document or graphic open in your application, open the Print dialog box. For most
software applications, click File > Print or press CTRL+P.

Select your printer, then click Properties to open the print driver dialog box.
On the Paper/Output tab, from the Job Type list, select Fax.

Click Recipients.

Do one or more of the following:

b whN

e  Click the Phonebook button, select a phone book from the list, select a name from the upper list,
then add it to the Fax Recipients. Repeat the procedure to add more names. Click OK.

e  Click the Add Recipients button, type the recipient name and fax number, add other
information, then click OK. Add new recipients as needed.

6. Toinclude a cover sheet, click Cover Sheet, then from the Cover Sheet Options list, select Print a
Cover Sheet.

7. Inthe Cover Sheet Notes field, type notes that you want to appear on the cover sheet.
8. On the Options tab, select the options for this fax.

9. Click OK.

10. In the Printer Properties window, click OK.

11. Inthe Print window, click OK.
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Using the Address Book

This section includes:
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Adding an Individual Entry

A total of 1000 speed dial entries can be stored in the printer.

To store multiple recipients in one speed dial entry, store the recipients as a group entry. For details, see
Adding a Group on page 159.

To add an individual speed dial entry:

1.

wmswhN

158

Press the Services Home button, then touch Fax.

Touch Address Book.

Touch the Down arrow, then touch Individuals.

Touch an available Speed Dial entry, using the scroll arrows if necessary.

Assign a name to the entry:

a. Touch the Entry Name field, then use the touch screen keyboard to type the name.
b. Touch Save.

Assign a fax number to the entry:

a. Touch the Fax Number field.

b. Use the alphanumeric keypad to enter the number:

Note: If the fax number requires characters such as a Dial Pause, touch Dialing Characters to enter
the characters, then touch Save.

Set the starting rate:
a. Under Starting Rate, touch one of the following:

e  SuperG3
e G3
e Forced

b. Touch the corresponding speed at the bottom of the screen.
Select a rate from the drop-down menu, using the Up and Down arrows to scroll if necessary.
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8. Toinclude a cover sheet:
a. Touch Cover Sheet > On.

b. Touch the To field, use the touch screen keyboard to type the name of the recipient, then
touch Save.

¢. Touch the From field, use the touch screen keyboard to type the name of the sender, then
touch Save.

d. Toadd a comment, do one of the following:
e  Touch an existing comment, then touch Save.

e Touch an <Available> comment, touch Edit, use the touch screen keyboard to type the
text, then touch Save.

Notes:
e To delete an existing comment, touch the comment, then touch Clear. Touch Clear to confirm
the action.

e To edit an existing comment, touch the comment, then touch Edit. Use the touch screen
keyboard to change the comment, then touch Save.

9. Touch Save.

Adding a Group Entry

To send a fax to multiple individuals, create a group speed dial entry. Groups can include both previously
stored individual and group entries.

Note: Individual entries must be set up before groups can be defined. For details, see Adding an
Individual Entry on page 158.

To add a group speed dial entry:

1. Press the Services Home button, then touch Fax.

Touch Address Book.

Touch the Down arrow, then touch Groups.

Touch an available Speed Dial entry, using the scroll arrows if necessary.

&~ W

Assign a name to the entry:

a. Touch the Group Name field, then use the touch screen keyboard to type the name.
b. Touch Save.

6. Touch Add Recipients.

7. Touch the Down arrow, then touch Individuals to add individual speed dial entries, or touch Groups
to add speed dial groups.

8. Touch the desired speed dial entry, then touch Add to Group.
9. When all entries have been added, touch Save.
10. Touch Close.
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Editing or Deleting Speed Dial Entries

To modify or delete existing speed dial entries:

1. Press the Services Home button, then touch Fax.

Touch Address Book.

Touch the Down arrow, then touch Individuals or Groups.

Touch the desired Speed Dial entry, using the scroll arrows if necessary.
Touch one of the following:

Lt whN

e Edit Details allows you to modify the properties of the speed dial entry. For details, see Adding
an Individual on page 158 or Adding a Group on page 159. Touch Save.

e  Clear Entry removes the entry from the address book. Touch Clear Entry to confirm the action.
6. Touch Close.

Using Chain Dial

Chain dial creates a single fax recipient telephone number by adding two or more numbers together. For
example, an area code or extension number can be stored separately from the rest of the telephone
number. Access chain dialing from the Address Book.

To create a chain dial number:

1.  Press the Services Home button, then touch Fax.

Touch Address Book.

Touch the Down arrow, then touch Individuals.

Touch Chain Dial.

To combine numbers with an existing speed dial entry, use any combination of the following:

s whN

a. Touch the Recipient field, then use the touch screen keypad to enter numbers.

b. Touch the desired speed dial entry from the list, using the scroll arrows if necessary. Touch Add
to Recipient. The numbers are added together in the Recipient field.

6. Touch Save. The combined number appears as a single recipient in the Recipients list.
7. Touch Close. You can now send the fax.
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General Precautions

A

A

WARNING: Parts of the printer are hot and need time to cool down before moving or packing the
printer. To avoid personal injury or printer damage, wait 30 minutes for the ink to solidify and the
printhead to cool down.

CAUTION: When cleaning your printer do not use organic or strong chemical solvents or aerosol
cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials only as directed
in this documentation.

WARNING: Keep all cleaning materials out of the reach of children.

WARNING: Do not use pressurized spray cleaning aids on or in the printer. Some pressurized sprays
contain explosive mixtures and are not suitable for use in electrical applications. Use of such cleaners
increase the risk of fire and explosion.

WARNING: Do not remove the covers or guards that are fastened with screws. You cannot maintain
or service any parts that are behind these covers and guards. Do not attempt any maintenance
procedure that is not described in the documentation supplied with your printer.

WARNING: Internal parts of the printer can be hot. Use caution when doors and covers are open.

To avoid damaging the printer, follow these guidelines:

162

Do not place anything on top of the printer.
Do not open covers and doors during printing.
Do not tilt the printer while it is hot.

Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print
quality to deteriorate.

Ensure any parts removed during cleaning are replaced before you plug in the printer.
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Cleaning the Printer

This section includes:
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Cleaning the Printer Exterior

Regular cleaning keeps the touch screen and control panel free from dust and dirt.

To clean the printer exterior:

1.

To remove fingerprints and smudges, clean the touch screen and control panel with a soft,
lint-free cloth.

Use a lightly dampened cloth to clean the outside of the document feeder, output trays, paper trays,
and outside areas of your printer.
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Cleaning the Document Glass and Document Cover

To ensure optimum scan and copy quality, clean the document glass regularly. Cleaning helps avoid
output with streaks, smears, and other marks that transfer from the glass while scanning documents.

To clean the document glass and document cover:

1. Use a lint-free cloth lightly dampened with Xerox® Anti-Static or another suitable non-abrasive glass
cleaner. Clean the document glass and the constant velocity transport (CVT) glass to its left.

2. Use alint-free cloth and Xerox® Cleaning Fluid or Xerox® Film Remover to clean the underside of the
document cover and the document feeder.
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Cleaning the Paper Release Blade

Cleaning the paper release blade removes ink residue, which can cause streaks, smears, and other marks
on the printed page.

To clean the paper release blade:
1. Open the top left side door.

4, Release the exit guide.
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5. Locate the clear plastic strip on the paper guide. Wipe the entire length of the lower half, especially
the side facing you, with a cloth pre-moistened in 90 % isopropyl alcohol.

\////,

7. Close the door.

Cleaning Tray 1 Rollers

Periodically inspect the feed rollers in each of the installed trays, and clean them if paper dust or other
residue is visible. Dirt on the feed rollers can cause paper jams or deteriorate print quality.

To clean Tray 1 rollers:
1. OpenTray 1.
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2. Clean the gray pick roller using a clean, soft cloth.

3. Close the tray.

Cleaning Trays 2-5 Rollers

Periodically inspect the feed rollers in each of the installed trays, and clean them if paper dust or other
residue is visible. Dirt on the feed rollers can cause paper jams or deteriorate print quality.

To clean Trays 2-5 rollers:
1. Open the paper tray, lift the front of the paper tray, and pull it completely out of the printer.

Note: Do not remove the high-capacity feeder tray because it extends far enough to provide the
necessary access.
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2.  Remove the pick roller assembly.
a. Open the Tray 2 left side door.

b. Remove the separator roller assembly by squeezing in the two outer tabs (1) and pulling it
straight out (2).

C.
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d. Raise the release lever, which allows the roller assembly to swing down.

Note: Remember the position of the roller assembly for reinstallation.

e.

3. Toclean the pick roller, lay a strip of clear packing tape on a table, sticky side up. Run the pick roller
assembly along the length of the tape.

Note: Do not use masking tape or duct tape because they can leave residue on the roller.
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4. Reinstall the pick roller assembly.

a. Hold the pick roller assembly vertically so that it aligns with the spaces into which it fits.

b. Gently snap the assembly into the slots. The assembly hangs down in the same position it was in
when you pulled it out of the printer in step 2d.

C.

[ ) | Ty N |
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5. Reinstall the separator roller assembly. Squeeze in the two outer tabs and push the assembly straight
into the opening until both ends click in place.

6. Close the door.
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7. Reinstall Tray 2.

8. Repeat this procedure for any installed optional paper trays.

Cleaning the Exit Rollers

Ink on the exit rollers can leave marks on pages. When roller marks are visible on prints, clean the
exit rollers.

To clean the exit rollers:
1. Clean one roller at a time by holding a soft, clean cloth against its gray surface.

3. Repeat this procedure for the remaining three exit rollers.
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Routine Maintenance

This section includes:
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Adding ColorQube Ink

When the ink is low, a warning message appears on the control panel. When the ink must be replaced, an
error message appears on the control panel. You can add ink any time the printer is idle.

Notes:

e Keep inkin its packaging until you are ready to use it.

e Identify the ink by number, color, and shape.

e Do not force the solid ink when inserting it into the printer.
e To avoid jams, never insert broken solid ink into the printer.

Order supplies from your channel partner, Xerox representative, or go to the Xerox Supplies website for
your printer model:

e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700supplies
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900supplies

To add ColorQube ink:
1.  Press the Ink Access Door Release button.

172 ColorQube 8700/8900 Color Multifunction Printer
User Guide


http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=ColorQube+CQ8700&PgName=order&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=ColorQube+CQ8900&PgName=order&Language=English

Maintenance

2. Open the ink access door.

3. Place the solid ink into the opening of the appropriate ink loading bin. Do not force the solid ink into
the bin. Each color is shaped uniquely to fit into the correct bin.

& CAUTION: Use of ink other than Genuine Xerox® ColorQube solid ink can affect print quality and
printer reliability. It is the only ink designed and manufactured under strict quality controls by Xerox
for specific use with this printer.

4.  Close the ink access door.
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Emptying the Waste Tray
When the waste tray is full, the control panel displays an Empty Waste Tray message.

To empty the waste tray:
1. Open the front door.

2. Remove the waste tray from the printer.

/I WARNING: The waste tray can be hot; handle it carefully.

.

3. Empty the waste tray in a waste container. Twist the waste tray slightly to dislodge the waste ink.
The ink is non-toxic and can be discarded as normal office waste.

‘,i\_ CAUTION: Do not attempt to reuse the waste ink in the printer; it can damage the printer. This
damage is not covered under the printer warranty.
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Insert the waste tray completely into the printer.

Note: The waste tray must be out of the printer for more than five seconds to clear the Empty Waste
Tray message on the control panel.

Close the door.
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Replacing Staple Cartridges

This section includes:
e  Replacing Staples in the CONVENIENCE SLAPLEN ...t sssesseseesssssssesssssssssssssssssssessssanns 176
o  Replacing Staples in the 650-ShEEt FINISNET ...t sasssessasssesssnsenns 177

A message appears on the control panel when a staple cartridge is empty.

Replacing Staples in the Convenience Stapler

1. Open the convenience stapler door as shown.

2. Grip the staple cartridge by the orange handle and remove it by pulling it to the left.

3.  Onthe new staple cartridge, ensure that the staple strips on top of the stack are complete and flat.
Remove any partial strips and any strips that are bent.

4. Grip the new staple cartridge by the orange handle and insert the cartridge into the stapler until
it clicks.
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5. Close the door.

Replacing Staples in the 650-Sheet Finisher

A staple cartridge has two parts: the orange handle cartridge and the staple refill in a case. Both parts are
customer replaceable.

To replace the staples:

& WARNING: Do not perform this procedure while the printer is copying or printing.

1. Open the finisher stapler door at the rear of the finisher as shown.

2.

i,

=,
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3. Pinch both sides of the staple case (1) and remove the staple case from the cartridge (2).

4. Insert the front side of the new staple case into the staple cartridge (1), then push the rear side into
the cartridge (2).

5. Grip the new staple cartridge by the orange handle and insert the cartridge into the stapler until
it clicks.

i,

=

6. Close the door.
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Billing and Usage Information

Billing and printer usage information appears on the Billing Information screen. The impression counts
shown are used for billing.

To view Billing and Usage information:
1. At the printer control panel, press the Machine Status button.
2. To view basic impression counts, touch the Billing Information tab:

e Black + Color Level 1 Impressions shows the total number of pages with only black color, or up
to 1.3% combined coverage of cyan, magenta, or yellow. Xerox refers to this coverage as
Useful Color.

e Color Level 2 Impressions shows the total number of pages with greater than 1.3 % and up to
6% combined coverage of cyan, magenta, and yellow. Xerox refers to this coverage as
Everyday Color.

e Color Level 3 Impressions shows the total number of pages with greater than 6 % combined
coverage of cyan, magenta, and yellow. Xerox refers to this coverage as Expressive Color.

e Total Impressions shows the total number of pages for all coverages and colors.

Note: A page is one side of a sheet of paper that can be printed on one or two sides. A sheet printed
on two sides counts as two impressions.

3. Toview detailed usage information, touch Usage Counters.
4. Touch Impression Counters, then select an option.
5. Touch Close.
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Ordering Supplies

This section includes:

o LoCAtiNg the SOl NUMDET ...ttt sas st sass s sass s sass s s e sassbsssass s sassbssens 180
O CONSUMADIES ..ottt ssse s sas s st s s s st s sss s s s ssassssssesssassessssssnsasessnsses 180
®  RoOULINE MAINTENANCE TEEMIS ...ttt ssssssssss st sss s sssesssssssssssssssssesssssssssssssesssssns 180
®  CUSLOMET REPIACEADIE UNILS.....ouveeeieriericrenreesissiesiessessissess s sasssasssssssssssssesssssssessasssssssssssssssssssssssssssssssssssssssssssssenns 181
®  WHEN 10 OTAEr SUPPLIES ...t sssssssesssssssssssssesssssssssssssssssssssssssssssssesssssssssssssssssssssssssssssssessssssns 181
®  RECYCING SUPPLES ...ttt sessss s sas st sss s s s s s ssses s ssassssssesasassessssssnsasesssssns 182

Locating the Serial Number

To contact Xerox for assistance, you need the printer serial number. The serial number is on the left side
of the printer frame behind Tray 2. The serial number also appears on the control panel. Press the
Machine Status button to view the serial number on the control panel.

Consumables

Consumables are printer supplies that get depleted during the operation of the printer. Consumable
supplies for this printer are the Genuine Xerox® ColorQube solid ink in cyan, magenta, yellow, and black.

The ink shapes can vary by printer model. Ensure that you order the correct ink for your specific
printer model.

_,i\ CAUTION: Use of ink other than Genuine Xerox® ColorQube solid ink can affect print quality and
printer reliability. It is the only ink designed and manufactured under strict quality controls by Xerox
for specific use with this printer.

For details on adding ink, see Adding ColorQube Ink on page 172.

To save ink, leave the printer turned on at all times. For details, see Minimizing Ink Usage on page 190.

Routine Maintenance Items

Routine maintenance items are printer parts that have a limited life and require periodic replacement.
Replacements can be parts or kits. Routine maintenance items are typically customer replaceable.

Routine maintenance items for this printer include the following:
e  Convenience Staple Cartridge

e  Finisher Staple Refill

e  Finisher Staple Cartridge
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e  Cleaning Unit

Note: Standard and extended-capacity Cleaning Units include installation instructions.

See also:
Replacing Staples in the Convenience Stapler on page 176
Replacing Staples in the Finisher on page 177

Customer Replaceable Units

Customer replaceable units (CRUs) are printer parts that can be replaced without need for technical
service intervention. These parts have longer rated lives than routine maintenance items.

Note: Each customer replaceable unit includes installation instructions.

Customer Replaceable Units for this printer include the following:

e Feed Roller Kit includes the pick and separator roller for any paper tray, including the 1800-sheet
high-capacity feeder.

e Tray 1 Separator Pad

e  Document Feeder Roller and Separator Roller Kit

e  Scanner with Document Feeder

e  650-Sheet Finisher

When to Order Supplies

A warning appears on the control panel when supplies near their replacement time. Verify that you have
replacements on hand. It is important to order supplies when the messages first appear to avoid
interruptions to your printing. An error message appears on the control panel when supplies must

be replaced.

To view information about the remaining life of supplies:
1. At the printer control panel, press the Machine Status button.
2. Touch the Supplies tab.

To print supplies information:

1. At the printer control panel, press the Machine Status button.
2. Touch the Information Pages tab.

3. Touch Supplies Usage Page.

4.  Touch Print.

Order supplies from your channel partner, Xerox representative, or go to the Xerox® Supplies website for
your printer model:

e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700supplies
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900supplies
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/i CAUTION: Use of non-Xerox® supplies is not recommended. The Xerox® Warranty, Service
Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of
performance caused by use of non-Xerox® supplies, or the use of Xerox® supplies not specified for this
printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage
could vary outside these areas. Please contact your Xerox representative for details.

Recycling Supplies

For information on Xerox® supplies recycling programs, go to:
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/gwa
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/gwa
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Moving the Printer

This section includes:

Precautions fOr MOVING the PHNEET ...ttt sses s sassssssass s sasssassssssassssssassssnsanns 183
Moving the Printer Within the OffiCe ... sesssssssssssssssssssssssssssssssssssssssssens 184
Preparing the Printer fOr SHIPMENt ...ttt sssssssssssssssssssssss s s sssssssssssssssssssssssens 186

Precautions for Moving the Printer

To avoid injuring yourself or damaging the printer, follow these guidelines:

A

A

WARNING: Parts of the printer are hot and need time to cool down before moving or packing the
printer. To avoid personal injury or printer damage, wait 30 minutes for the ink to solidify and the
printhead to cool down. The Power Off to Move procedure requires that you remove the cleaning unit
and waste tray.

CAUTIONS:

o  Keep the printer level. Tilting the printer can cause the ink to spill inside.

e Always allow the printer to cool before it is moved to avoid ink spills that can damage
the printer.

Always turn off the printer using the power switch and wait for the power off sequence to finish.
Then unplug all cables and cords. Never turn off the printer by pulling the power cord or using a
power strip with a power switch.

For best results, use the Power Off to Move procedure on the printer control panel. For details, see
Moving the Printer Within the Office on page 184.

Always use at least two people to lift the printer.
When lifting the printer, grasp the areas as shown.

46.5 kg
1023 lb.
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Moving the Printer Within the Office

1. Close the printer doors.
2. Turn off the printer using the power switch on the back of the printer.

3. Within 60 seconds after turning off the printer, on the printer control panel select either Standard
Power Off or Power Off to Move.

4.  Wait for the printer to complete the cool-down period for the ink to solidify. The printer fans shut
down when the printer is cool enough to move.

/1 CAUTION: If you do not select Standard Power Off or Power Off to Move, the ink takes longer to
solidify because the fans do not spin. Wait at least 30 minutes for the printer to cool down
completely before moving or packing it.

5. After the cool-down cycle is complete, unplug the printer.

‘,i\_ CAUTION: Do not unplug the printer until the cooling sequence completes and the printer turns off.
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Use the hand holds on each side of the printer to lift it. Move the printer separately from any
optional trays. Always use at least two people to lift the printer.

46.5kg
102.3 b.
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Preparing the Printer for Shipment

This section includes:

e Removing the Cleaning Unit anNd WASEE TTAY ....ccvvrerrirrnrireerninsinessissessssssessessessssssssssessssssssssssssssssssesssssnns 186
®  TUMING Off TNE PrINTE ettt st as s s s st bss st sas st s e s s e b s s sas s sass s s s b nnens 188
o Packing the Printer fOr SNIPMENT ...ttt sae st sas s sass s s sassssssass s sass b nsens 188

Removing the Cleaning Unit and Waste Tray
Before turning off the printer, remove the cleaning unit and waste tray.
To remove the cleaning unit and waste tray:

/1 CAUTION: Shipping the printer with the cleaning unit and waste tray installed can damage
the printer.

1. Open the front door.

2. Remove the cleaning unit and place it in a plastic bag for storage.
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Remove the waste tray from the printer.

N

/I WARNING: The waste tray can be hot; handle it carefully.

4,

Empty the waste tray in a waste container. Twist the waste tray slightly to dislodge the waste ink.
The ink is non-toxic and can be discarded as normal office waste. Place the tray in a plastic bag
for storage.

Close the front door.
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Turning Off the Printer

1. Turn off the printer using the power switch on the back of the printer.

2. Within 60 seconds after turning off the printer, on the printer control panel select Power Off
to Move.

3. Wait for the printer to complete the cool-down period for the ink to solidify. The printer fans shut
down when the printer is cool enough to move.

4. After the cool-down cycle is complete, unplug the printer.

_,i\_ CAUTION: Do not unplug the printer until the cooling sequence completes and the printer turns off.

Packing the Printer for Shipment

Repack the printer and its options using the original packing material and boxes or a Xerox® Repackaging
Kit. Additional instructions for repacking the printer are provided in the Repackaging Kit. To uninstall
options, reverse the steps in the installation instructions. If you do not have all the original packaging, or
are unable to repackage the printer, contact your local Xerox reseller, or go to:

e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700support
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900support

& CAUTION: Failure to repackage the printer properly for shipment can result in damage not covered by
the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The Xerox® Warranty,
Service Agreement, or Total Satisfaction Guarantee do not cover damage to the printer caused by

improper moving.

188 ColorQube 8700/8900 Color Multifunction Printer
User Guide


http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=ColorQube+CQ8700&PgName=tech&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=ColorQube+CQ8900&PgName=tech&Language=English

Troubleshooting

This chapter includes:

o General TroubleShOOtING.........ovreereereeee e sssssssssssssssseses 190
O JOMS ottt ettt 196
o Print-Quality ProblemS ...t ss s seens 216
o Copy and SCAN Problems........inrinneissssissessssstssssssassssssssssssssssssssssssssssssssssees 221
O FOX PrODIEMIS ..ottt s s s s sesssaenes 222
O GOLEING HELP oottt s s s s s snsaenes 225
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General Troubleshooting

This section includes:

®  MINIMIZING INK USOQE..cm et sa e sessse e ca s s s s s s s s ss e tssesssasasesansannes 190
®  RESTAMING TNE PIINTET ettt sas st s ss st s s sasss s sssssss s sssssssssssssssasesssssns 190
®  Printer DOES NOT TUIM Ottt sttt bbb bbb s sassanen 191
o  Printer Resets or TUINS Off FIEQUENTLY ..ottt s s sasssssssesssssssssassssssssssssessssnsenns 192
®  Printing TAKES TOO LONG ...ttt ssssssssssssssssssssssssssssssssssssssssssessssssssssssssssssssssssssssssesssssns 192
o Document Prints FrOmM WIONG TIAY ...o.covrrvreeerirriseesriseessissesessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnns 193
®  DOCUMENT FAILS 1O PrINT oottt a s s s st ss s sssssasssanssnnes 193
®  Printer MAKES UNUSUGI NOISES ... et ceseessetsse e seess e sssesssssssesssessss s s sssessss s sesssesasesssesanes 193
o Automatic 2-Sided Printing ProODLEMS .........ririreeneesisissiretsssssisssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnns 194
o Date aNd TimMe ArE INCOIMECL c..cuu et eeesse e sssss s sssssssss s s s s st sssesssesssasasesasnsannes 194
®  SCONNET EITOTS ettt sttt bbbt baseeaetaees 195

This section contains procedures to help you locate and resolve problems. Resolve some problems by
simply restarting the printer.

Minimizing Ink Usage

To save ink, leave the printer turned on at all times. For more information about minimizing ink usage, go
to the Xerox Support website for your printer model:

e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700support

e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900support

Restarting the Printer

You can use Quick Restart or the power switch to restart the printer. Quick Restart is faster because it
reinitializes the printer without turning it off.

To restart the printer using Quick Restart:
1. Close the printer doors.

2. If menus are visible on the control panel, press the Power Saver button. If the control panel is dark,
press the Power Saver button twice.

3. Touch Quick Restart > Restart.
4. If the restart process does not begin within 30 seconds, restart the printer using the power switch.
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To restart the printer using the power switch:
1. Close the printer doors.
2. Turn off the printer using the power switch on the back of the printer.

3. Onthe touch screen, touch Standard Power Off.
e  Wait 30 seconds after the printer turns off before proceeding to the next step.

e If the printer does not turn off after two minutes, it is not able to complete a standard power off
sequence. Disconnect the power cord, wait 30 seconds, and reconnect it.

4,  Turn on the power switch.

i

el

If restarting the printer does not resolve the problem, see the table in this chapter that best describes
the problem.

Printer Does Not Turn On

Probable Causes Solutions

The power switch is not turned on. Turn on the switch.

The power cord is not correctly plugged into | Turn off the printer power switch, and plug the power cord securely
the outlet. into the outlet.

Something is wrong with the outlet connected | ¢  Plug another electrical appliance into the outlet and see if it
to the printer. operates properly.

e Try adifferent outlet.

The printer is connected to an outlet with a Use a power source with the specifications listed in the Electrical
voltage or frequency that does not match the | Specifications on page 235.
printer specifications.
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Printer Resets or Turns Off Frequently

Probable Causes Solutions

The printer is connected to an outlet with a Use a power source with the specifications listed in the Electrical
voltage or frequency that does not match the | Specifications on page 235.
printer specifications.

The printer is plugged into an Uninterruptible e Do not use a UPS. Only use an extension cord, power strip, or

Power Supply (UPS) or shared power strip. surge protector designed to handle the electrical current capacity
of the printer.

e If you plug the printer into a 20 amp surge protector, do not plug
any other device into the surge protector.

¢ Do not plug the printer into the same outlet with other
high-power devices, such as kitchen appliances.

A network configuration problem exists. Unplug the network cable. If the problem is resolved, contact your
network administrator to reconfigure your network installation.

A system error occurred. Contact your Xerox representative with the error code and message.
Check the control panel fault history. For details, see Viewing Error
Messages on the Control Panel on page 226.

Printing Takes Too Long

Probable Causes Solutions

The printer is set to print on a paper type that | Certain paper types, like heavyweight paper and transparencies,
requires slower printing. take more time to print. Ensure that the print driver and control
panel are set to the proper paper type.

The printer is in Energy Saver mode. Wait. It takes time for printing to start when the printer is coming
out of Energy Saver mode.

The way the printer was installed on the e Determine if a print spooler or a computer sharing the printer is

network could be an issue. buffering all print jobs and then spooling them to the printer.

Spooling can slow print speeds.

e To test the speed of the printer, print some information pages
such as the Office Demo Page. If the page prints at the rated
speed of the printer, you could have a network or printer
installation issue. For additional help, contact the
system administrator.

The print-quality mode in the driver is set e Change the print-quality mode in the print driver to Standard.
to Photo. e No action needed. Photo print-quality mode takes longer to print.
The job is complex. Wait. No action needed.
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Document Prints From Wrong Tray

Probable Causes Solutions

Application and print driver have conflicting | 1. Check the tray selected in the print driver.

tray selections. 2. Go to the page setup or printer settings of the application from
which you are printing.

3. Set the paper source to match the tray selected in the print driver
or set the paper source to Automatically Select.

Note: Set the paper source tray selection to Automatic to have the
print driver select the tray.

Document Fails to Print

Probable Causes Solutions

Selected tray has wrong paper size loaded. To view the Job Status for a failed print on the touch screen:
1. Press the Job Status button, then touch the Active Jobs tab.
2. Find the failed print job in the list.

3. Note the status of the failed print job, such as Held: Resources
Required.

4. Touch to select the print job for more details, then touch
Job Details.

5. Note the Tray number listed under Resources and the Status of
the selected tray.

6. Load the proper size paper in the tray or select another tray.

The way the printer was installed on the e Determine if a print spooler or a computer sharing the printer is

network could be an issue. buffering all print jobs and then spooling them to the printer.
Spooling can slow print speeds.

e To test the printer, print some information pages such as the
Office Demo Page. If the page prints, you could have a network
or printer installation issue. For additional help, contact the
system administrator.

Application and print driver have conflicting | For details, see Document Prints from Wrong Tray on page 193.
tray selections.

Printer Makes Unusual Noises

Probable Causes Solutions

One of the paper trays is not Open and close the paper tray from which you are printing.
installed correctly.

Tray 1 roller is out of position. To reset the roller position, open and close the top left side door.
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Probable Causes Solutions
There is an obstruction or debris inside Turn off the printer and remove the obstruction or debris. If you
the printer. cannot remove it, contact your Xerox representative.

Automatic 2-Sided Printing Problems

Probable Causes Solutions

Unsupported or incorrect paper. Ensure that you are using the correct paper. For details, see
Supported Paper on page 44. Do not use envelopes, labels, reloaded
paper, or paper heavier than 122 g/m? for automatic 2-sided
printing.

Note: Reloaded paper is paper previously printed or copied on laser
or solid ink printers.

Incorrect setting. In the print driver Properties, select 2-Sided Print on the
Paper/Output tab.

Date and Time are Incorrect

The date and time are set automatically when the printer is connected to a network that has a Network
Time Protocol (NTP) server. NTP is used to synchronize the internal clocks of computers over a network
connection at system startup and every subsequent 24-hour period thereafter. This feature ensures that
the internal clock of the printer stays synchronized with the NTP server you specify.

Note: To access this feature at the control panel, log in as an administrator.

Probable Causes Solutions

The time zone, date, or time is set incorrectly. |1. At the printer control panel, press the Machine Status button,
then touch the Tools tab.

2. Touch Device Settings > General > Date & Time.

3. Toset the time zone, touch Time Zone and touch the arrows to
adjust the time zone.

4, To set the date, touch Date, select a format and set the date.

5. To set the time, touch Time and set the time. Select Display 24
hour clock to use 24 hour format.

6. Touch Save.
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Scanner Errors

Probable Causes Solutions

Scanner is not communicating. 1. Turn off the printer using the power switch on the back of
the printer.

2. On the touch screen, touch Standard Power Off.
3. Wait for the printer to complete its power off sequence.

4, On the back of the printer, squeeze the two latches on the
connector of the scanner cable, then remove the cable.

5. Reinsert the cable by pushing the connector until both latches
click into place.

6. Turn on the power switch.

If the error persists, contact your Xerox representative.
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Jams

This section includes:
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Clearing Paper Jams

This section includes:

Clearing Jams at the TOP LEft SIA@ DOOT ...t sssssssssssssssssssssssssssssssssssssssssssssssssssssssssens 197
Clearing JAMS A TIAY T oot es s esssessse s s s ss et s s s s esa st s sssneenns 199
Clearing 525-Sheet Feeder JAmMS At TIAYS 2=5 .. sssssesesssessssssssssssssesssessssssssesnns 201
Clearing 1800-Sheet High-Capacity FEeder JAMS........rrrerrnesireesssssssessessssssssssssssssssssssssssssssssees 202
Clearing Jams in the DOCUMENT FEEAET ...t essesssesass s sasesssssssesnes 203
Clearing JAMS At ThE EXIt ATEQ ...t eaasessse s s se s ess s s s sasessessssesnns 204
Clearing Jams in the 650-Sheet FINISNET ...t sassssss s sssssssssssssssssssasees 205

To avoid damage, always remove jammed paper carefully without tearing it. Try to remove the paper in
the same direction it normally moves through the printer. Even a small piece of paper left in the printer
can cause a jam. Do not reload paper that has jammed.

Clearing Jams at the Top Left Side Door

1.

2.

Remove any paper from Tray 1.

Open the top left side door.
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3. Remove the jammed paper.

Note: To avoid damage, always remove jammed paper carefully without tearing it. Try to remove the
paper in the same direction it normally moves through the printer. Even a small piece of paper left in
the printer can cause a jam. Do not reload paper that has jammed.

4. Close the top left side door.

5. Replace the paper in the tray.
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Clearing Jams at Tray 1

1. Remove any paper from Tray 1.

2. If youdid not find jammed paper, push up the latch on the left side of the printer to open the top left
side door.

3. Remove any remaining pieces of paper.
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4. Close the door.

5. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface.
This procedure separates any sheets that are stuck together and reduces the possibility of jams.

6. Replace the paper in the tray.

7. Verify that the paper is the correct size, type, and weight. If not, change the paper settings.
8. On the printer touch screen, touch Confirm.
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Clearing 525-Sheet Feeder Jams at Trays 2-5

1. Before removing the paper tray from the printer, look at the jam message on the control panel. If
another jam is shown, clear that jam first.
2. Pull out the tray until it stops.
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3. Ensure that the paper is an approved type, weight, and size for the tray. Print custom size paper only
from Tray 1.

g

4. Remove any crumpled paper from the tray.

Note: If the paper is torn, remove all torn pieces from the printer.
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5. Push the tray completely back into the printer.
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6. Verify that the paper is the correct size, type, and weight. If not, change the paper settings.
7. On the printer touch screen, touch Confirm.

Clearing 1800-Sheet High-Capacity Feeder Jams

1. Before removing the paper tray from the printer, look at the jam message on the control panel. If
another jam is shown, clear that jam first.

2. Pull out the tray until it stops.

3. Ensure that the paper is an approved type, weight, and size for the tray. Print custom size paper only
from Tray 1.

4. Remove any crumpled paper from the tray.

Note: If the paper is torn, remove all torn pieces from the printer.
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5. Push the tray completely back into the printer.

Clearing Jams in the Document Feeder

1. Lift the lever (1), then open the document feeder top cover (2).

2.
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3. Close the cover.

4. If the original is not visible when the document feeder top cover is opened, lift the document cover
and remove the original.

5. If the original is not wrinkled or torn, reload it into the document feeder, then follow the instructions
on the touch screen.

Note: After clearing a document feeder jam, reload the entire document, including the pages already
scanned. The printer automatically skips the scanned pages and scans the remaining pages.

& CAUTION: Torn, wrinkled, or folded originals can cause jams and damage the printer. To copy torn,

wrinkled, or folded originals, use the document glass.

Clearing Jams at the Exit Area

1. If the paper is visible at the output tray exit, remove the paper by pulling it in the direction shown.

<~ T~ l“ m’
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2. If another jam appears on the control panel, clear that jam.
3. If the jam at exit message has not cleared, open and close the top left side door to clear the error.

Clearing Jams in the 650-Sheet Finisher

Clearing Jams Under the Finisher Top Cover
1. Open the finisher top cover.

2. Remove the jammed paper.

Note: If the paper is torn, remove all torn pieces from the finisher.
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3. Close the finisher top cover.

Clearing Jams in the Finisher Transport
1. Grasp the handle and open the finisher transport cover.

3. Close the finisher transport cover.
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Clearing Jams in the Finisher Transport Left Door
1. To open the finisher transport left door, pull out the handle.

2.

3. Close the finisher transport left door.

ColorQube 8700/8900 Color Multifunction Printer 207
User Guide



Troubleshooting

Clearing Jams in the Finisher Output Tray
1.  Remove the jammed paper.

2. If another jam appears on the control panel, clear that jam.
3. If the jam message has not cleared, open and close the top left side door to clear the error.

Minimizing Paper Jams

The printer is designed to function with minimal paper jams using Xerox® supported paper. Other paper
types can cause jams. If supported paper is jamming frequently in one areq, clean that area of the paper
path. To avoid damage, always remove jammed paper carefully without tearing it. Try to remove the
paper in the same direction it normally moves through the printer. Even a small piece of paper left in the
printer can cause a jam. Do not reload paper that has jammed.

The following can cause paper jams:

e Selecting the incorrect paper type in the print driver.
e Using damaged paper.

e  Using unsupported paper.

e Loading paper incorrectly.

e  Overfilling the tray.

e  Adjusting the paper guides improperly.

Most jams can be prevented by following a simple set of rules:
e Use only supported paper. For details, see Supported Paper on page 44.
e Follow proper paper handling and loading techniques.
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e Always use clean, undamaged paper.

e Avoid paper that is curled, torn, moist, creased, or folded.

e Toseparate the sheets before loading into the tray, fan the paper.

e  Observe the paper tray fill line; never overfill the tray.

e Remove transparencies from the output tray immediately after printing.

e Adjust the paper guides in all trays after inserting the paper. A guide that is not properly adjusted
can cause poor print quality, misfeeds, skewed prints, and printer damage.

e After loading the trays, select the correct paper type and size on the control panel.
e  When printing, select the correct type and size in the print driver.

e  Store paper in a dry location.

e Use only Xerox® paper and transparencies designed for the printer.

Avoid the following:

e Polyester coated paper that is designed specially for inkjet printers.

e Highly glossy or coated paper.

e Paper that is folded, wrinkled, or excessively curled.

e Fanning transparencies before loading in the paper tray.

e Loading more than one type, size, or weight of paper in a tray at the same time.

e Loading hole punched paper or paper with folded corners or staples in the document feeder.
e  Overfilling the paper trays.

¢ Allowing the output tray to overfill.

e Allowing the output tray to fill with more than a few transparencies.

Refer to the control panel Paper and Media Information Pages for information on supported paper, or see
Supported Paper on page 44.
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Troubleshooting Paper Jams

This section includes:

o Multiple Sheets PUlled TOGELNET ...t esssss st s s sssesssssssssssssssssasssssssssssssesssssns 210
O PUPET MISTEEAS.....oeeerterestsi sttt a s sas bbb st bas bbb e a s bbb s st bans s ansbansens 210
®  JAMS N The DOCUMENT FEEAET ..ottt ess s s et ss e ss s sesasesasnsanes 211
o Paper Jam MeSSAGE STAYS O ...crererrireereirrinesneisesssessesssssssssssssssssssssssssssssssssssssssssssssessssssssssssssssssssssssssssssssssssssns 211
®  2-SiAEA PrINTING JAMS ..ottt e ssss s sasssasssssssss st ssss st bas s sass s s s e s s sasssessass s sassbensenns 211

Multiple Sheets Pulled Together

Probable Causes Solutions

The paper tray is too full. Remove some of the paper. Do not load paper past the fill line.
The edges of the paper are not even. Remove the paper, align the edges, and then reload it.

The paper is moist from humidity. Remove the moist paper and replace it with new, dry paper.
Too much static electricity is present. e Try a new ream of paper.

e Do not fan transparencies before loading them in the paper tray.

Unsupported or incorrect paper. Use only Xerox® approved paper. For details, see Supported Paper
on page 44.

The relative humidity of the room is too high. | Feed paper one sheet at a time.

Paper Misfeeds

Probable Causes Solutions

The paper is not correctly positioned in e Remove the misfed sheet and reposition the remaining paper
the tray. properly in the tray.

e Adjust the paper guides to fit the paper size.

The paper tray is too full. Remove some of the paper. Do not load paper past the fill line.

The paper guides are not correctly adjusted to | Adjust the paper guides in the tray to match the size of the paper.
the paper size.

The tray contains warped or wrinkled paper. | Remove the paper, smooth it out, and reload it. If it still misfeeds, do
not use that paper.

The paper is moist from humidity. Remove the moist paper and replace it with new, dry paper.
Using paper of the wrong size, thickness, Use only Xerox® approved paper. For details, see Supported Paper on
or type. page 44.
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Troubleshooting

Solutions

the tray or labels have been removed from
the sheet.

The label sheet is facing the wrong way in

e Load label sheets according to the instructions from

the manufacturer.
e Print only on one side of the sheet of labels.
e Use full sheet labels only.
e Load labels face down in Tray 1.
e Load labels face up in any 525-sheet paper tray.

Envelopes are loaded incorrectly in the
paper tray.

Load the envelopes in the paper tray short-edge feed with the flaps
closed. For details, see Envelopes in Printing on Special Paper on
page 58.

Jams in the Document Feeder

Probable Causes

Solutions

Using paper of the wrong size, thickness,
or type.

Use only Xerox® approved paper. For details, see Supported Paper
on page 44.

Making 2-sided copies using hole
punched paper.

Make 1-sided copies when using hole punched paper in the
document feeder. Use the document glass.

Using wrinkled or folded paper.

Use the document glass.

The documents loaded in the document
feeder exceed the maximum
capacity allowed.

Place fewer documents in the document feeder.

The document feeder width guides are not
adjusted to fit the width of the document.

Adjust the paper guides so that they fit against the originals.

Paper Jam Message Stays On

Probable Causes

Solutions

Some paper remains jammed in the printer.

Recheck the media path and make sure that you have removed all of
the jammed paper.

One of the printer doors is open.

Check the doors on the printer. Close any door that is open.

2-Sided Printing Jams

Probable Causes

Solutions

Using paper of the wrong size, thickness,
or type.

e Useonly Xerox® approved paper. For details, see Supported
Paper on page 44.

e Do not use envelopes, labels, reloaded paper, or paper heavier
than 122 g/m? for automatic 2-sided printing.
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Probable Causes Solutions

Paper type is set incorrectly in the print driver. | The following types of paper can be used for automatic
2-sided printing:

e Plain
e Recycled
e Bond

e Letterhead
e Pre-Printed

Ensure that the paper type is set correctly in the driver and the paper
is loaded in the correct tray. For details, see Supported Paper Sizes
and Weights for Automatic 2-Sided Printing on page 48.

Paper is loaded in the wrong tray. The paper must be loaded in the correct tray. For details, see
Supported Paper on page 44.

Tray is loaded with mixed paper. Load the tray with only one type and size of paper.
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Clearing Staple Jams

This section includes:
o  C(Clearing Staple Jams in the CONVENIENCE SLAPLET ...t ssssssessssssssssssssssssssessssenns 213
e  Clearing Staple Jams in the 650-Sheet FINISNEr ... ...t ee e 213

Clearing Staple Jams in the Convenience Stapler

If the convenience stapler jams, replace the staple cartridge. For details, see Replacing Staples in the
Convenience Stapler on page 176.

Clearing Staple Jams in the 650-Sheet Finisher

1. Open the finisher stapler door at the rear of the finisher as shown.

2. Grip the staple cartridge by the orange handle and pull it firmly toward you to remove it.

i,

=
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Note: A staple cartridge has two parts: the orange handle cartridge and the staple refill in a case.
Both parts are customer replaceable. For details see Replacing Staples in the 650-Sheet Finisher on
page 177.

3. Pullthe staple cartridge clamp firmly in the direction shown to open it.

4. Remove the jammed staples (1), then push the clamp in the direction shown until it snaps into the
locked position (2).

_,ri\_ WARNING: The points of the jammed staples are sharp. Remove the jammed staples carefully.

N 45

5. Grip the staple cartridge by the orange handle and insert it into the stapler assembly. Push it in until
it clicks.

i,

=
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6. Close the door.
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Print-Quality Problems

This section includes:

®  CoNtrolling Print QUALILY ...cceeveereeeeeeteesesiestessestessee st sess s s sasssassssssssssassesssasssessasssssasssssssssssssssssassssssassssssansssnsenns 216

o  Troubleshooting Print-QUality PrODIEMS ...ttt sssesssssssssssssssssssssssssssssssessssanns 218

& CAUTION: The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee does
not cover damage caused by using unsupported paper or special media. The Xerox® Total Satisfaction

Guarantee is available in the United States and Canada. Coverage could vary outside these areas.
Contact your Xerox representative for details.

Controlling Print Quality

Various factors can affect the quality of the output of your printer. For consistent and optimum print
quality, use paper designed for your printer, and correctly set the Print-Quality Mode and Color
Adjustments. Follow the guidelines in this section to maintain optimum print quality from your printer.

Paper and Media

Your printer is designed to use various paper and other media types. Follow the guidelines in this section
for the best print quality and to avoid jams:

e Use only Xerox® approved paper. For details, see Supported Paper on page 44.
e  Use only dry, undamaged paper.

e  Some paper and other media types can cause poor output quality, increased paper jams, or damage
your printer. For details, see Paper That Can Damage Your Printer on page 45.

e  Ensure the paper type selected in your print driver matches the paper type on which you are printing.

e If you have the same size paper loaded in more than one tray, ensure that the proper tray is selected
in the print driver.

e  Store your paper and other media properly for optimum print quality. For details, see Paper Storage
Guidelines on page 45.

Print-Quality Modes

Select the correct print-quality setting for your print job from the print driver. For instructions on setting
the print quality, see Selecting Printing Options on page 69. To control the print quality:

e  Use the print-quality settings in the print driver to control print quality. If the print quality is not
suitable, adjust the print-quality setting to an higher level.

e Use only Xerox® approved paper. For details, see Supported Paper on page 44.
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Color Corrections and Color Adjustments

Automatic Color is set at the factory for best printing results of mixed text, graphics, and images on a
range of supported paper. For instructions on setting the Color Options, see Using Color Options on
page 75.
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Troubleshooting Print-Quality Problems

This section includes:

e  Printing the Troubleshooting Print-QUALlity PAGES ........c.corvreenrirriererriseesissesscseissssisenssssssssssssssssssessssenns 218
e Eliminating the Paper or Media as the Problem.......... s ssssesssssenns 218
e Isolating the Problem to the Printer or to the APPlICAtioN ...t 219
e  Troubleshooting Print-Quality Problems in the Application, Print Driver, or Print Server ................... 219
e  Troubleshooting Print-Quality Problems in the Printer ...t isssesssssenns 220

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems,
use the information in this section to troubleshoot the problem.

If the problem persists, go to:
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700support
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900support

[\  CAUTION: The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee does
not cover damage caused by using unsupported paper or special media. The Xerox® Total Satisfaction
Guarantee is available in the United States and Canada. Coverage could vary outside these areas.
Contact your Xerox representative for details.

Printing the Troubleshooting Print-Quality Pages

1. At the printer control panel, press the Machine Status button, then touch the Tools tab.
2. Touch Troubleshooting > Support Pages.

3. Touch Troubleshooting Print Quality Page, then touch Print.

4. Compare your print-quality problems to the examples on the pages.

Eliminating the Paper or Media as the Problem

Damaged or unsupported paper or media can cause print-quality problems even when the printer,
application, and print driver are working perfectly. Use the following guidelines to eliminate the paper as
the source of the print-quality problem:

e Make sure that the printer supports the paper or media.

e Make sure that the printer is loaded with undamaged, dry paper.

o If the condition of the paper or media is in doubt, replace it with new paper or media.

e  Make sure that you have the proper tray selected in the print driver and from the control panel.

e  Make sure that you have the correct paper type selected in the print driver and in the control panel of
the printer.
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Isolating the Problem to the Printer or to the Application

When you are sure that the paper is supported and in good condition, use the following steps to isolate
the problem:

1.

From the control panel of the printer, print the pages for Diagnosing Print Quality. For details, see
Printing the Troubleshooting Print Quality Pages on page 218.

e If the pages printed properly, the printer is working properly and the print-quality problem is an
application, print driver, or print server problem.

e If the pages still have print-quality problems, the problem is in the printer.
If the pages printed properly, see Troubleshooting Print-Quality Problems in the Application, Print
Driver, or Print Server on page 219.

If the pages still had print-quality issues, or did not print, see Troubleshooting Print-Quality Problems
in the Printer on page 220.

Troubleshooting Print-Quality Problems in the Application, Print Driver, or
Print Server

If the printer is printing properly from the control panel but you still have print-quality problems, the
application, print driver, or print server could be the cause.

To isolate the problem:

1.

win&WwhN

Print a similar document from another application and look for the same print-quality problems.

e If the document has the same print-quality problem, it is probably a print driver or print server
problem. If the problem persists, go to step 2.

e If the document printed without a print-quality problem, the application is probably the cause.
Restart your printer, restart the application, then print the document again. If the problem
persists, go to step 5. For more information, see Restarting the Printer on page 190.

Check the print driver used for the print job.

Click Start > Settings > Printers and Faxes.

Right-click on the name of the printer.

Select Properties from the drop-down list.

e  Ensure that the model name in the middle of the driver matches the model nhame of the printer.
e If the names do not match, install the proper print driver for the printer.

If the print driver is correct, see Selecting Printing Options on page 69 to set the Print-Quality mode
and Color Options.

e  Set the Print-Quality mode to Standard or Enhanced.

e Set the Color Options to Automatic Color.

If the problem persists, delete then reinstall the print driver.

If the problem still persists, ensure that you are not printing through a print server.
Try printing directly to the printer.

If the problem persists, go to:

ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700support
ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900support
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Troubleshooting Print-Quality Problems in the Printer

If you have print-quality problems when printing a Demo Page or the Configuration Report from the
control panel, the problem is in the printer.

To isolate the problem:

1. At the control panel, print the Troubleshooting Print-Quality Pages. For details, see Printing the
Troubleshooting Print Quality Pages on page 218.

2. If the prints are too light to see print details, ensure that the printer is loaded with undamaged, dry,
supported paper.

3. Compare the print-quality problems in your document to each of the examples in the
Troubleshooting Print-Quality Pages.

If you find a match in the Troubleshooting Print-Quality Pages, look in the Solutions column for the
action to take to resolve the problem.

If the problem persists, go to:
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700support
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900support
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Copy and Scan Problems

Symptoms Solutions

Print-quality problems when making a copy Determine if the problem is the document glass, CVT glass, or the
or scan. printer, by making a copy using the document glass and the
document feeder.

o If you observe the print-quality problem in the copies made from
both sources, go to Troubleshooting Print-Quality Problems in the
Printer on page 220.

o If you observe the print-quality problem in one copy, the problem
is with the document glass or the document feeder CVT glass.
Use one of the following solutions to resolve the problem.

Lines or streaks present in copies only made | There is debris on the CVT glass. When scanning, the paper from the
from the document feeder. document feeder passes over the debris on the CVT glass, resulting
in lines and streaks. Clean all glass surfaces with a lint-free cloth.

Spots present in copies taken from the There is debris on the document glass. When scanning, the debris
document glass. creates a spot on the image. Clean all glass surfaces with a
lint-free cloth.

The reverse side of the original is showing on | Turn on Background Suppression.
the copy or scan.

Image is too light or too dark. e If copying, use the Image-Quality settings to lighten, darken, or
adjust contrast.

e If scanning, use the Advanced Settings tab to lighten, darken, or
adjust contrast.

Colors are inaccurate. e If copying, use the Image-Quality settings to adjust
color balance.

e If scanning, confirm that the correct Original Type is set.

If the problem persists, go to:
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700support
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900support
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Fax Problems

This section includes:

®  ProblEmMS SENAING FOXES....cueiieeeeeicesesieses st ssss s s sssssasssssssss st sssssssssass s sass s sass s sssssassssssasssssansbsnsenns 222

e  Problems Receiving Faxes

Note: If you cannot send and receive faxes, ensure that you are connected to an approved analog
telephone line. The fax cannot send or receive when connected directly to a digital telephone line
without the use of an analog filter. It can also require you to set the fax starting rate to Forced
(4800 bps). For details, see Selecting the Starting Rate on page 141.

Problems Sending Faxes

Symptoms

The document is not feeding
properly through the
document feeder.

Probable Causes

The document is too thick, too thin, or
too small.

Solutions

Use the document glass.

The document is scanned at
an angle.

The document feeder width guides
are not adjusted to fit the width of
the document.

Adjust the document feeder width
guides so that they fit against
the document.

The fax received by the recipient
is blurry.

The document is positioned incorrectly.

Position the document correctly.

The document glass is dirty.

Clean the document glass.

The text in the document is too light.

Adjust the resolution. Adjust
the contrast.

There is a problem with the
telephone connection.

Verify that the telephone line is working,
then send the fax again.

There is a problem with one of the
fax machines.

Make a copy to verify that the printer
can make clean copies and prints. If the
copy prints correctly, have the recipient
verify that their fax machine is
operating correctly.

The fax received by the recipient
is blank.

The document was loaded incorrectly.

e If using the document feeder, place
the original document face up.

e If using the document glass, place
the original document face down.

Fax was not transmitted.

The fax number is wrong.

Verify the fax number.
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Symptoms

Probable Causes

The telephone line is connected

incorrectly.

Troubleshooting

Solutions

Verify the telephone line connection. If
the telephone line is disconnected,
connect it.

There is a problem with the fax
machine of the recipient.

Contact the recipient.

The fax feature is not installed or is
not enabled.

Ensure that the fax feature is installed
and enabled.

Server Fax is enabled.

Ensure that Server Fax is disabled.

An access number is required to
connect to an outside line.

If the printer is connected to a PBX
system, it could be necessary to enter a
number to access the outside
telephone line.

The fax number needs a pause
between the prefix for an outside line
and the telephone number.

To insert a pause, press the Dial Pause
button. A comma (,) appears in the
corresponding location.

If the problem persists, go to:

e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700support
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900support

Problems Receiving Faxes

Symptoms

The fax received by the recipient
is blank.

Probable Causes

There is a problem with the telephone
connection or with the fax machine of
the sender.

Solutions

Verify that the printer can make clean
copies. If it can, have the sender fax the
document again.

The sender loaded the pages
incorrectly.

Contact the sender.

The printer answers the call but
does not print the fax.

The memory is full.

To increase available memory, delete
stored jobs and wait for the existing
jobs to complete.

The received fax size is reduced
in size.

The paper supply in the printer does
not match the document size sent.

Confirm the original size of the
documents, then load the appropriate
paper size in the printer.

Faxes are not received
automatically.

The printer is set to receive faxes
manually.

Set the printer to receive faxes
automatically.

The memory is full.

If the printer is out of paper, faxes and
print jobs can deplete the printer of
memory. Load paper and print the jobs
stored in the memory.

The telephone line is connected
incorrectly.

Verify the telephone line connection. If
the telephone line is disconnected,
connect it.
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Troubleshooting

Probable Causes Solutions
There is a problem with the fax Make a copy to verify that the printer
machine of the sender. can make clean copies and prints. If the

copy prints correctly, have the recipient
verify that their fax machine is
operating correctly.

If the problem persists, go to:
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700support
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900support
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Troubleshooting

Getting Help

This section includes:
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Xerox provides several automatic diagnostic utilities to help you maintain productivity and print quality.

Control Panel Messages

The printer control panel provides information and troubleshooting help. When a fault or warning
condition occurs, the control panel displays a message informing you of the problem. In many cases,
the control panel also displays an animated graphic showing the location of the problem, such as the
location of a paper jam. For many status and warning messages, the control panel Help provides
additional information.

Control Panel Help

To view additional information about items and selections that appear on the control panel, press Help.
The Help button is labeled with a question mark symbol (?).

The control panel menu items also have associated help text that describes the menu item.
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Troubleshooting

Scan and Fax Alerts

Alerts provide messages and instructions that help you solve problems when printing, faxing, or scanning.
Alerts appear on the control panel touch screen, or you can view them through CentreWare
Internet Services.

Note: Fax errors do not prevent scanning, copying, or printing.

Viewing Job Status on the Control Panel

To see the status of a list of active jobs or completed jobs, press the Job Status button.
e Touch the Active Jobs tab to see the status of the active jobs that are printing.
e  Touch the Completed Jobs tab to see the status of the last 20 jobs that were completed.

Viewing Error Messages on the Control Panel

1. Press the Machine Status button, then touch the Faults tab.
2. Touch one of the buttons to view a list of alerts:
e  Current Faults: Current faults that affect the operation of the printer, such as a paper jam.
e  Current Messages: Alert messages regarding the current job status of the printer, such as an
empty paper tray.
e  Fault History: The last 20 fault alerts.
e  Fault Code: The fault code for the error that affected printer operation.
e Date: The date when the error occurred.
e Time: The time of the day when the error occurred.
e Image Count: The image count on the printer when the error occurred.
e  Paper: The paper that was used when the error occurred.

Viewing Alerts in CentreWare Internet Services

See Accessing CentreWare Internet Services on page 28 to access the embedded Web server in
the printer.

1. In CentreWare Internet Services, click Status > Description & Alerts.
The Description and Alerts page appears.
2. Click Refresh to update the page.

Maintenance Assistant

Your printer includes a built-in diagnostic capability allowing you to send diagnostic information directly
to Xerox. Maintenance Assistant is a remote diagnostic tool that offers a fast way to resolve potential
issues, receive assistance, and automate the troubleshooting or repair process.

Use Maintenance Assistant only when requested to do so by a Xerox representative.
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Troubleshooting

Online Support Assistant

Online Support Assistant is a knowledge base that provides instructions and troubleshooting help to solve
printer problems. You can find solutions for print-quality problems, paper jams, software installation
problems, and more. Online Support Assistant offers the latest technical solutions and illustrated
step-by-step operational tips.

To access the Online Support Assistant, go to:

e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700support

o  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900support

More Information

Resource Location

Installation Guide Packaged with the printer.
Quick Use Guide Packaged with the printer.
System Administrator Guide e ColorQube 8700 Color Multifunction Printer:

www.xerox.com/office/CQ8700docs

e ColorQube 8900 Color Multifunction Printer:
www.xerox.com/office/CQ8900docs

Recommended Media List United States:

e ColorQube 8700 Color Multifunction Printer:
www.xerox.com/paper

e ColorQube 8900 Color Multifunction Printer:
www.xerox.com/paper

European Union:

e ColorQube 8700 Color Multifunction Printer:
www.xerox.com/europaper

e ColorQube 8900 Color Multifunction Printer:
www.xerox.com/europaper

Technical support information for your printer; e ColorQube 8700 Color Multifunction Printer:

including online technical support, Online Support www.xerox.com/office/CQ8700support

Assistant, and driver downloads. e ColorQube 8900 Color Multifunction Printer:
www.xerox.com/office/CQ8900support

Information Pages Print from the control panel.

Information about menus or error messages Press the control panel Help (?) button.

Order supplies for your printer e ColorQube 8700 Color Multifunction Printer:

www.xerox.com/office/CQ8700supplies

e ColorQube 8900 Color Multifunction Printer:
www.xerox.com/office/CQ8900supplies

A resource for tools and information, including www.xerox.com/office/businessresourcecenter
interactive tutorials, printing templates, helpful
tips, and customized features to meet your
individual needs.

Local sales and support center e ColorQube 8700 Color Multifunction Printer:
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Troubleshooting

Resource Location

www.xerox.com/office/worldcontacts

e ColorQube 8900 Color Multifunction Printer:
www.xerox.com/office/worldcontacts

Printer registration e ColorQube 8700 Color Multifunction Printer:
www.xerox.com/office/register

e ColorQube 8900 Color Multifunction Printer:
www.xerox.com/office/register

® N: . .
Xerox~ Direct online store www.direct.xerox.com/
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Specifications

This appendix includes:
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Specifications

Printer Configurations and Options

Standard Features

The ColorQube 8700/8900 Color Multifunction Printer provides the following features:
e  Copy, print, and scan

e  Automatic 2-sided printing and copying

e  Maximum copy speed of up to 44 pages per minute (ppm) for color or black and white
e  50-Sheet Document Feeder

e  Color touch screen display on control panel

e Tray 1 with 100-sheet capacity

e Tray 2 with 525-sheet capacity

e Convenience Stapler

e Scan to USB and Print from USB mass storage devices

e  PANTONE certified

e  1.33 GHz processor

e 1 GBRAM

e Internal 160 GB hard drive

e  Secure Print

e Ethernet 10/100/1000Base-TX

e  Universal Serial Bus (USB 2.0)

e  PostScript and PCL fonts

e Embedded PDL support for PCL 5, PCL 6, Adobe PS3, PDF, and XPS
e Job Based Accounting

e Data Security

Available Configurations

Model Includes

ColorQube 8700S Multifunction Printer Standard Features
ColorQube 8700X Multifunction Printer e Standard Features
e Fax

e Optical Character Recognition (OCR) Enabled Scan

ColorQube 8900X Multifunction Printer o Standard Features
. PagePack® Metered Ink
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Specifications

Model Includes

ColorQube 8700XF Multifunction Printer e Standard Features

e Fax

e OCR Enabled Scan

e 650-Sheet Finisher

e 1800-Sheet High-Capacity Feeder
e Two additional 525-Sheet Feeders

Options and Upgrades

e  650-Sheet Finisher

e  525-Sheet Feeder; up to 3 additional, or 2 additional with an 1800-Sheet High-Capacity Feeder
e  1800-Sheet High-Capacity Feeder

e Storage Cart

e  Foreign Device Interface

e  Network Accounting

o  Wireless Network Adapter

e  Xerox Secure Access Unified ID System

e  FreeFlow SMARTsend

e Xerox® Common Access Card Enablement Kit

e Xerox® Copier Assistant

e  Unicode Print

e Single Line Fax Kit (Not available in North America)

e  Scanning software solutions. For details, go to www.xerox.com/office/software-solutions.
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Specifications

Physical Specifications

Standard Configurations

Configuration with Finisher, 1800-Sheet High-Capacity Feeder, and Two
Optional 525-Sheet Feeders

869 kg
191.3 Ib.

\

59.5cm / 119cm/

234in 46.9in
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Specifications

Clearance Requirements

Standard Configurations

89.0cm
35.0in
12.7cm
50in
T
940 cm =t
37.0in

107.0cm
420in

Configuration with Finisher, 1800-Sheet High-Capacity Feeder, and Two Optional
525-Sheet Feeders

152.4 cm
60.0in
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Specifications

Environmental Specifications

Temperature

10-32°C (50-90°F)

Relative Humidity

Operating: 15% to 85 % (non-condensing)

Elevation

For optimum performance, use the printer at elevations below 3200 m (10,500 ft.).
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Specifications

Electrical Specifications

Power Supply Voltage Frequency Current Required
90-140 VAC 47-63 Hz 12A
180-264 VAC 47-63 Hz 6A

ENERGY STAR Qualified Product

The ColorQube 8700 Color Multifunction Printer and ColorQube 8900 Color
Multifunction Printer are ENERGY STAR® qualified under the ENERGY STAR Program
Requirements for Imaging Equipment.

ENERGY STAR The ENERGY STAR and ENERGY STAR mark are registered United States trademarks.

The ENERGY STAR Imaging Equipment Program is a team effort between United States,
European Union, and Japanese governments and the office equipment industry to
promote energy-efficient copiers, printers, fax, multifunction printers, personal
computers, and monitors. Reducing product energy consumption helps combat smog,
acid rain, and long-term changes to the climate by decreasing the emissions that result
from generating electricity.

Xerox® ENERGY STAR equipment is preset at the factory to switch to Energy Saver Mode 1 after two
minutes, and to Energy Saver Mode 2 after thirty minutes from the last copy or print. For details, see
Setting Energy Saver Mode on page 35.
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Specifications

Performance Specifications

Printing Resolution

Maximum Resolution: 2400 FinePoint™

Print Speed

Print Mode Print Speed in ppm (1-sided / 2-sided)
Fast Color 44/31

Standard 30/25

Enhanced 19/18

High Resolution/Photo 6/6

PCL 400 x 600 Mode 20/18

PCL 600 x 600 Mode 11/11
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Regulatory Information

This appendix includes:
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Regulatory Information

Basic Regulations

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are
designed to mitigate interference caused or received by this printer in a typical office environment.

United States FCC Reqgulations

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference when the equipment is operated in a commercial environment. This equipment generates,
uses, and can radiate radio frequency energy. If it is not installed and used in accordance with these
instructions, it may cause harmful interference to radio communications. Operation of this equipment in
a residential area is likely to cause harmful interference in which case the user will be required to correct
the interference at his/her own expense.

If this equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the interference
by one or more of the following measures:

e Reorient or relocate the receiving antenna.
e Increase the separation between the equipment and receiver.
e  Connect the equipment into an outlet on a circuit different from that to which the receiver

is connected.
e  Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to
operate this equipment.

Note: To ensure compliance with Part 15 of the FCC rules, use shielded interface cables.

Canada
This Class A digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe A est conforme a la norme NMB-003 du Canada.
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Regulatory Information

European Union Radio Interference

/1 CAUTION: This is a Class A product. In a domestic environment, this product can cause radio
interference in which case the user could be required to take adequate measures.

The CE mark applied to this product symbolizes a declaration of conformity by Xerox with
c € the following applicable Directives of the European Union as of the dates indicated:

e December 12, 2006: Low Voltage Directive 2006/95/EC
e  December 15, 2004: Electromagnetic Compatibility Directive 2004/108/EC

e  March 9, 1999: Radio Equipment & Telecommunications Terminal Equipment
Directive 1999/5/EC

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or for
the environment.

To ensure compliance with European Union regulations, use shielded interface cables.

A signed copy of the Declaration of Conformity for this printer can be obtained from Xerox.

European Union Lot 4 Imaging Equipment Agreement Environmental
Information

Environmental Information Providing Environmental Solutions and Reducing Cost
Introduction

The following information has been developed to assist users and has been issued in relation to the
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging
Equipment. This requires manufacturers to improve environmental performance of in scope products and
supports the EU action plan on energy efficiency.

In scope products are Household and Office equipment that meet the following criteria.
e Standard monochrome format products with a maximum speed less than 66 A4 images per minute
e Standard color format products with a maximum speed less than 51 A4 images per minute

Environmental Benefits of Duplex Printing

Most Xerox® products have duplex printing, also known as 2-sided printing, capability. This enables you to
print on both sides of the paper automatically, and therefore helps to reduce the use of valuable
resources by reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires that
on models greater than or equal to 40 ppm color or greater than or equal to 45 ppm monochrome the
duplex function has been auto enabled, during the setup and driver installation. Some Xerox® models
below these speed bands may also be enabled with 2-sided printing settings defaulted on at the time of
install. Continuing to use the duplex function will reduce the environmental impact of your work.
However, should you require simplex/1-sided printing, you may change the print settings in the

print driver.
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Regulatory Information

Paper Types

This product can be used to print on both recycled and virgin paper, approved to an environmental
stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper
(60 g/m?), which contains less raw material and thus save resources per print, may be used in certain
applications. We encourage you to check if this is suitable for your printing needs.

ENERGY STAR

The ENERGY STAR program is a voluntary scheme to promote the development and purchase of energy
efficient models, which help to reduce environmental impact. Details on the ENERGY STAR program and
models qualified to ENERGY STAR can be found at the following website:
www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGroup&pgw_code=IEQ.

Power Consumption and Activation Time

The amount of electricity a product consumes depends on the way the device is used. This product is
designed and configured to enable you to reduce your electricity costs. After the last print it switches to
Ready Mode. In this mode it can print again immediately if required. If the product is not used for a
period of time, the device switches to a Power Saver Mode. In these modes, only essential functions
remain active in order to enable reduced product power consumption.

Upon exiting from Power Saver Mode, the first print will take slightly longer than in Ready Mode. This
delay is the result of the system "waking up” from Power Saver mode and is typical of most imaging
products on the market.

If you wish to set a longer Activation Time or would like to completely deactivate the Power Save Mode,
please consider that this device may then only switch to a lower energy level after a longer period of time
or not at all.

To learn more about Xerox participation in sustainability initiatives, please visit our website at:
www.xerox.com/about-xerox/environment/enus.html.

Germany

Blendschutz

Das Gerdt ist nicht fur die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz
vorgesehen. Um storende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht
im unmittelbaren Gesichtsfeld platziert werden.

Larmemission

Maschinenldrminformations-Verordnung 3. GPSGV: Der hochste Schalldruckpegel betrdgt 70 dB(A) oder
weniger gemdf EN ISO 7779.
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Regulatory Information

Importeur

Deutschland
Xerox GmbH
Hellersbergstrae 2-4
41460 Neuss

Turkey RoHS Regulation
In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.”

“EEE y6netmeligine uygundur.”
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Regulatory Information

Copy Regulations

United States

Congress, by statute, has forbidden the reproduction of the following subjects under certain
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such
reproductions.

1. Obligations or Securities of the United States Government, such as:

242

Certificates of Indebtedness.
National Bank Currency.
Coupons from Bonds.
Federal Reserve Bank Notes.
Silver Certificates.

Gold Certificates.

United States Bonds.
Treasury Notes.

Federal Reserve Notes.
Fractional Notes.
Certificates of Deposit.
Paper Money.

Bonds and Obligations of certain agencies of the government, such as FHA and so on.

Bonds. United States Savings Bonds may be photographed only for publicity purposes in
connection with the campaign for the sale of such bonds.

Internal Revenue Stamps. If it is necessary to reproduce a legal document on which there is a
canceled revenue stamp, this may be done provided the reproduction of the document is
performed for lawful purposes.

Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps may be
photographed, provided the reproduction is in black and white and is less than 75 % or more
than 150 % of the linear dimensions of the original.

Postal Money Orders.
Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States.

Stamps and other representatives of value, of whatever denomination, which have been or may
be issued under any Act of Congress.

Adjusted Compensation Certificates for Veterans of the World Wars.
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2. Obligations or Securities of any Foreign Government, Bank, or Corporation.

3. Copyrighted materials, unless permission of the copyright owner has been obtained or the
reproduction falls within the “fair use” or library reproduction rights provisions of the copyright law.
Further information of these provisions may be obtained from the Copyright Office, Library of
Congress, Washington, D.C. 20559. Ask for Circular R21.

4. Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates may be
photographed.

Passports. Foreign Passports may be photographed.

Immigration papers.

Draft Registration Cards.

Selective Service Induction papers that bear any of the following Registrant’s information:

® N W

e  Earnings or Income.

e  Court Record.

e  Physical or mental condition.

e Dependency Status.

e  Previous military service.

e  Exception: United States military discharge certificates may be photographed.

9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of the
various Federal Departments, such as FBI, Treasure, and so on (unless photograph is ordered by the
head of such department or bureau).

Reproducing the following is also prohibited in certain states:
e Automobile Licenses.
e  Drivers’ Licenses.
e Automobile Certificates of Title.

The preceding list is not all inclusive, and no liability is assumed for its completeness or accuracy. In case
of doubt, consult your attorney.

For more information about these provisions contact the Copyright Office, Library of Congress,
Washington, D.C. 20559. Ask for Circular R21.

Canada

Parliament, by stature, has forbidden the reproduction of the following subjects under certain
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such
reproductions.

e  Current bank notes or current paper money
e Obligations or securities of a government or bank
e  Exchequer bill paper or revenue paper

e The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of a
court of law

e Proclamations, orders, regulations, or appointments, or notices thereof (with intent to falsely cause
same to purport to have been printed by the Queens Printer for Canada, or the equivalent printer for
a province)
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Marks, brands, seals, wrappers, or designs used by or on behalf of the Government of Canada or of a
province, the government of a state other than Canada or a department, board, Commission, or
agency established by the Government of Canada or of a province or of a government of a state
other than Canada

Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of a
province or by the government of a state other than Canada

Documents, registers, or records kept by public officials charged with the duty of making or issuing
certified copies thereof, where the copy falsely purports to be a certified copy thereof

Copyrighted material or trademarks of any manner or kind without the consent of the copyright or
trademark owner

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is
assumed for its completeness or accuracy. In case of doubt, consult your solicitor.

Other Countries

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be
imposed on those found guilty of making such reproductions.

Currency notes

Bank notes and checks

Bank and government bonds and securities

Passports and identification cards

Copyright material or trademarks without the consent of the owner
Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of
doubt, contact your legal counsel.
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Fax Regulations

United States

Fax Send Header Requirements

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or
other electronic device, including a fax machine, to send any message unless such message clearly
contains in a margin at the top or bottom of each transmitted page or on the first page of the
transmission, the date and time it is sent and an identification of the business or other entity, or other
individual sending the message and the telephone number of the sending machine or such business,
other entity, or individual. The telephone number provided may not be a 900 number or any other
number for which charges exceed local or long-distance transmission charges.

For instructions on programming the Fax Send Header information, refer to the section of the System
Administrator Guide on Setting Transmission Defaults.

Data Coupler Information

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the
Administrative Council for Terminal Attachments (ACTA). On the cover of this equipment is a label that
contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If requested,
this number must be provided to the Telephone Company.

A plug and jack used to connect this equipment to the premises wiring and telephone network must
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant
telephone cord and modular plug is provided with this product. It connects to a compatible modular jack
that is also compliant. See installation instructions for details.

You can safely connect the printer to the following standard USOC RJ-11C modular jack using the
compliant telephone line cord (with modular plugs) provided with the installation kit. See installation
instructions for details.

The Ringer Equivalence Number (REN) is used to determine the number of devices that can be connected
to a telephone line. Excessive RENs on a telephone line could result in the devices not ringing in response
to an incoming call. In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain
of the number of devices that can be connected to a line, as determined by the RENSs, contact the local
Telephone Company. For products approved after July 23, 2001, the REN is part of the product identifier
that has the format US:AAAEQ##TXXXX. The digits represented by ## are the REN without a decimal
point (for example, 03 is a REN of 0.3). For earlier products, the REN is separately shown on the label.

To order the correct service from the local Telephone Company, you could also have to quote the codes in
the following list:

e  Facility Interface Code (FIC) = 02LS2
e  Service Order Code (SOC) = 9.0Y
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/1 CAUTION: Ask your local Telephone Company for the modular jack type installed on your line.
Connecting this machine to an unauthorized jack can damage telephone company equipment. You,
not Xerox, assume all responsibility and/or liability for any damage caused by the connection of this
machine to an unauthorized jack.

If this Xerox® equipment causes harm to the telephone network, the Telephone Company could
temporarily discontinue service to the telephone line to which it is connected. If advance notice is not
practical, the Telephone Company notifies you of the disconnection as soon as possible. If the Telephone
Company interrupts your service, they can advise you of your right to file a complaint with the FCC if you
believe that it is necessary.

The Telephone Company could change its facilities, equipment, operations, or procedures which could
affect the operation of the equipment. If the Telephone Company changes something that affects the
operation of the equipment, they should notify you in order for you to make necessary modifications to
maintain uninterrupted service.

If you experience trouble with this Xerox® equipment, please contact the appropriate service center for
repair or warranty information. Contact information is contained in the Machine Status menu on the
printer and in the back of the Troubleshooting section of the User Guide. If the equipment is causing
harm to the telephone network, the Telephone Company may request you to disconnect the equipment
until the problem is resolved.

Only a Xerox service representative or an authorized Xerox Service provider are authorized to make
repairs to the printer. This applies at any time during or after the service warranty period. If unauthorized
repair is performed, the remainder of the warranty period is null and void.

This equipment must not be used on party lines. Connection to party line service is subject to state tariffs.
Contact the state public utility commission, public service commission, or corporation commission for
information.

Your office could have specially wired alarm equipment connected to the telephone line. Make sure that
the installation of this Xerox® equipment does not disable your alarm equipment.

If you have questions about what could disable alarm equipment, consult your Telephone Company or a
qualified installer.

Canada
This product meets the applicable Industry Canada technical specifications.

A representative designated by the supplier should coordinate repairs to certified equipment. Repairs or
alterations made by the user to this device, or device malfunctions, could cause the telecommunications
company to request you to disconnect the equipment.
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For user protection, make sure that the printer is properly grounded. The electrical ground connections of
the power utility, telephone lines, and internal metallic water pipe systems, if present, must be connected
together. This precaution could be vital in rural areas.

‘,i\_ WARNING: Do not attempt to make such connections yourself. Contact the appropriate electric
inspection authority, or electrician, to make the ground connection.

The REN assigned to each terminal device provides an indication of the maximum number of terminals
allowed to be connected to a telephone interface. The termination on an interface could consist of any
combination of devices. The only limitation to the number of devices is the requirement that the sum of
the RENSs of the devices does not exceed 5. For the Canadian REN value, please see the label on the
equipment.

European Union

Radio Equipment and Telecommunications Terminal Equipment Directive

The Facsimile has been approved in accordance with the Council Decision 1999/5/EC for pan-European
single terminal connection to the public switched telephone network (PSTN). However, due to differences
between the individual PSTNs provided in different countries, the approval does not give an
unconditional assurance of successful operation on every PSTN network terminal point.

In the event of a problem you should contact your authorized local dealer.

This product has been tested to and is compliant with ES 203 021-1, -2, -3, a specification for terminal
equipment for use on analog-switched telephone networks in the European Economic Area. This product
provides a user-adjustable setting of the country code. The country code should be set prior to connecting
this product to the network. Refer to the customer documentation for the procedure for setting the
country code.

Note: Although this product can use either loop disconnect (pulse) or DTMF (tone) signaling, we
recommend that you set it to use DTMF signaling for more reliable and faster call setup. Modification
of this product, connection to external control software, or connection to an external control
apparatus not authorized by Xerox will invalidate its certification.

New Zealand

1. The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has
accepted that the item complies with minimum conditions for connection to its network. It indicates
no endorsement of the product by Telecom, it does not provide any sort of warranty, and it does not
imply that any Telepermitted product is compatible with all Telecom network services. Above all, it
provides no assurance that any item will work correctly in all respects with another item of
Telepermitted equipment of a different make or model.

The equipment may not be capable of correct operation at the higher data speeds designated.
33.6 kbps and 56 kbps connections are likely to be restricted to lower bit rates when connected to
some PSTN implementations. Telecom will accept no responsibility for difficulties that arise in

such circumstances.
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Immediately disconnect this equipment should it become physically damaged, then arrange for its
disposal or repair.

This modem shall not be used in any manner which could constitute a nuisance to other
Telecom customers.

This device is equipped with pulse dialing, while the Telecom standard is DTMF tone dialing. There is
no guarantee that Telecom lines will always continue to support pulse dialing.

Use of pulse dialing, when this equipment is connected to the same line as other equipment, may
give rise to 'bell tinkle' or noise and cause a false answer condition. If you encounter such problems,
do not contact the Telecom Faults Service.

DTMF tones dialing is the preferred method because it is faster than pulse (decadic) dialing and is
readily available on almost all New Zealand telephone exchanges.

WARNING: No 111" or other calls can be made from this device during a mains power failure.

This equipment may not provide for the effective hand-over of a call to another device connected to
the same line.

Some parameters required for compliance with Telecom Telepermit requirements are dependent on
the equipment (computer) associated with this device. The associated equipment shall be set to
operate within the following limits for compliance with Telecom Specifications:

For repeat calls to the same number:

e There shall be no more than 10 call attempts to the same number within any 30 minute period
for any single manual call initiation, and

e  The equipment shall go on-hook for a period of not less than 30 seconds between the end of
one attempt and the beginning of the next attempt.

For automatic calls to different numbers:

The equipment shall be set to ensure that automatic calls to different numbers are spaced such that
there is no less than five seconds between the end of one call attempt and the beginning of another.

For correct operation, total of the RNs of all devices connected to a single line at any time should not
exceed five.
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Material Safety Data Sheets

For Material Safety Data information for your printer, go to:

North America
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/msds
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/msds

European Union
o  ColorQube 8700 Color Multifunction Printer: www.xerox.com/environment_europe
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/environment_europe
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Recycling and Disposal

This appendix includes:
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All Countries

If you are managing the disposal of your Xerox® product, please note that the printer may contain lead,
mercury, perchlorate, and other materials whose disposal may be regulated due to environmental
considerations. The presence of these materials is fully consistent with global regulations applicable at
the time that the product was placed on the market. For recycling and disposal information, contact your
local authorities. Perchlorate Material: This product may contain one or more Perchlorate-containing
devices, such as batteries. Special handling may apply, please see
www.dtsc.ca.gov/hazardouswaste/perchlorate.
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Recycling and Disposal

North America

Xerox operates an equipment take-back and reuse/recycle program. To determine if this Xerox® product
is part of the program, contact your Xerox representative (1-800-ASK-XEROX).

For more information about Xerox® environmental programs, go to:

e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/environment

e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/environment
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Recycling and Disposal

European Union

Some equipment may be used in both a domestic/household and a professional/business application.

Domestic/Household Environment

Application of this symbol on your equipment is confirmation that you
should not dispose of the equipment in the normal household waste
stream.

In accordance with European legislation, end of life electrical and electronic equipment subject to
disposal must be segregated from household waste.

Private households within EU member states may return used electrical and electronic equipment to
designated collection facilities free of charge. Please contact your local disposal authority for
information.

In some member states, when you purchase new equipment, your local retailer may be required to take
back your old equipment free of charge. Please ask your retailer for information.

Professional/Business Environment

Application of this symbol on your equipment is confirmation that you
must dispose of this equipment in compliance with agreed national
procedures.

In accordance with European legislation, end of life electrical and electronic equipment subject to
disposal must be managed within agreed procedures.

Prior to disposal, please contact your local reseller or Xerox representative for end of life
take-back information.
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Collection and Disposal of Equipment and Batteries

These symbols on the products and/or accompanying documents mean
that used electrical and electronic products and batteries should not be
mixed with general household waste.

For proper treatment, recovery, and recycling of old products and used
batteries, please take them to applicable collection points, in
accordance with your national legislation and the Directive 2002/96/EC
and 2006/66/EC.

By disposing of these products and batteries correctly, you will help to
save valuable resources and prevent any potential negative effects on
human health and the environment which could otherwise arise from

inappropriate waste handling.

For more information about collection and recycling of old products
and batteries, please contact your local municipality, your waste
disposal service or the point of sale where you purchased the items.

Penalties may be applicable for incorrect disposal of this waste, in
accordance with national legislation.
Business Users in the European Union
If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for

further information.

Disposal Outside of the European Union

These symbols are only valid in the European Union. If you wish to discard these items, please contact
your local authorities or dealer and ask for the correct method of disposal.

Battery Symbol Note

This wheeled bin symbol may be used in combination with a chemical
symbol. This establishes compliance with the requirements set out by
the Directive.

Hg

Battery Removal

Batteries should only be replaced by a MANUFACTURER-approved service facility.
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Other Countries

Please contact your local waste management authority to request disposal guidance.
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